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Predgovor
U~ebnikot Informatika e pi{uvan kako u~ebnik po predme-

tot informatika za {esto oddelenie za osumgodi{noto obra-
zovanie i za sedmo oddelenie za devetgodi{noto obrazovanie i 
e prilagoden kon Nastavnata programa definirana od Biroto za 
razvoj na obrazovanieto i odobrena od Ministerstvoto za obra-
zovanie i nauka. 

Sledej}i ja Nastavnata programa, knigata e podelena na pet 
temi:

Vo prvata tema & Veb-dnevnici & u~enicite }e se osposobat 
za koristewe i za kreirawe veb-dnevnici. Osobeno vnimanie e 
posveteno na eti~kite principi i na bezbednosta na u~enicite 
pri koristeweto na veb-dnevnicite.

Vo vtorata tema & Ureduvawe tekst & u~enicite imaat 
mo`nost, preku prakti~ni ve`bi da gi pro{irat i prodlabo~at 
znaewata {to gi steknale vo petto oddelenie od osumgodi{noto 
obrazovanie, odnosno {esto oddelenie od devetgodi{noto ob-
razovanie. Na u~enicite im se obrnuva osobeno vnimanie na 
pravilata za pi{uvawe tekst, kako {to e koristeweto na inter-
punkciskite znaci i sli~no. Obrabotena e aplikacijata Microsoft 
Word, a kako dodatok e pretstavena aplikacijata OpenOffice.org 
Writer, koja raboti pod operativniot sistem Linux. Pra{awata, 
zada~ite i ve`bite {to se dadeni za Word mo`at da se koristat 
i za Writer.

Vo tretata tema & Multimedijalni prezentacii & u~enicite 
}e nau~at kako da izrabotat kvalitetna prezentacija. Osven sov-
laduvaweto na osnovnite tehniki, u~enicite se pottiknuvaat na 
kreativnost i na fantazija. Obrabotena e aplikacijata Micro-
soft PowerPoint, a kako dodatok e pretstavena aplikacijata Ope-
nOffice.org Impress, koja raboti pod operativniot sistem Linux. 
Pra{awata, zada~ite i ve`bite {to se dadeni za PowerPoint 
mo`at da se koristat i za Impress.

^etvrtata tema im e posvetena na programite za Tabelarni 
presmetuvawa. Preku niza primeri u~enicite }e nau~at kako da 
izrabotat i kako da uredat tabela, da koristat formuli i funk-
cii i da izrabotat soodveten grafikon. Obrabotena e aplikaci-
jata Microsoft Excel, a kako dodatok e pretstavena aplikacijata 
OpenOffice.org Calc, koja raboti pod operativniot sistem Linux. 
Pra{awata, zada~ite i ve`bite {to se dadeni za Excel mo`at 
da se koristat i za Calc.

Vo pettata tema &  Proekti & u~enicite }e najdat niza soveti 
za site fazi na izrabotkata na u~ili{ten proekt: od odbirawe 
tema, preku istra`uvawe i izrabotka, pa s¢ do prezentirawe na 
svojot trud. 
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Namesto teoretsko raska`uvawe, akcentot vo u~ebnikot e 
staven na sovladuvaweto na novite nastavni edinici preku 
ve`bi so prakti~na rabota. So pomo{ na sliki i drugi vizuelni 
pomagala u~enikot }e mo`e i samostojno da gi sovlada novite 
ve{tini. 

Na po~etokot na sekoja tema posebno se istaknati novite po-
imi so koi u~enicite }e se sretnat vo temata. 

Po sekoja nastavna edinica sleduvaat pra{awa i ve`bi za 
utvrduvawe na materijalot. Preku posebno istaknatite rubriki 
„[to treba da zapomni{“ i „Ve{tini {to treba da gi usovr{i{!“, 
na u~enicite im se uka`uva na va`nite elementi vo nastavnata 
edinica. 

Vo prira~nikot se dadeni i nekolku ve`bi za qubopitnite 
i za nadarenite u~enici, a na krajot vo knigata ima i poseben 
dodatok za nadarenite u~enici so zada~i za koi treba pove}e 
kreativnost, rabota i podobro poznavawe na aplikaciite. 

Po vtorata, po tretata i po ~etvrtata tema, se dadeni kon-
trolni testovi.

Va`nite elementi jasno se istaknati na marginite vo knigata, 
vo vid na soveti, zabele{ki i predupreduvawa. 

Na krajot na u~ebnikot se dodatocite: Za talentiranite 
u~enici, Mal informati~ki re~nik i Re{enija za kontrol-
nite testovi.

Ve`bite i primerite vo u~ebnikot se prisposobeni na vozras-
ta na u~enicite vo osnovnoto obrazovanie, no u~ebnikot mo`at 
da go upotrebuvaat site {to imaat potreba za sovladuvawe na 
osnovnite ve{tini od obrabotenite temi. 

											         
							       Avtorot
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	 Veb-dnevnici

SODR@INA:
[to e veb-dnevnik (blog)?

U~esnici i korisnici na blogovi

Izrabotka blog

Ureduvawe na sodr`inata na blogot

Komentari na postojnite blogovi
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Veb-dnevnici1
INTERNET (POTSETUVAWE)

Internet e najpoznatata i najgolemata kompjuterska mre`a vo 
koja se povrzani drugi mre`i i oddelni kompjuteri od celiot 
svet. 

Kompjuterite koristat posebni programi, nare~eni pre-
listuva~i (Browsers), kako {to se Internet Explorer, Mozilla Firefox, 
Opera i drugi & za da mo`e{ da slu{a{ ili vidi{ sliki, infor-
macii, muzika ili videozapisi na Internet. 

Za da mo`e{ da otvori{ nekoja lokacija, treba da ja znae{ 
nejzinata URL-adresa i da ja napi{e{ vo lentata za adresi. 

[TO E VEB-DNEVNIK (BLOG)? 

Novi poimi:

blog, bloger, portal, registracija, logirawe, korisni~ko 
ime, lozinka, adresa na blogot, zapis, komentar

Veb-dnevnik ili blog e lokacija na Internet vo forma na 
elektronski vesnik ili dnevnik, sostavena od sodr`ini   {to se 
prika`ani po obraten vremenski redosled: najnovite tekstovi 
se prika`ani na vrvot.

Blog e kako vesnik ili dnevnik & pi{uvani onlajn.

Veb-dnevnikot mo`e da sodr`i tekstovi vo forma na vesti, 
bele{ki ili diskusii, no i fotografii, skici, adresi kon dru-
gi lokacii na Internet itn. Tekstovite gi pi{uva avtorot na 
blogot ili gi nudat korisnicite, no mo`at da bidat i prezemeni 
od drugi veb-lokacii.

Veb-dnevnicite se odnesuvaat na edna ili na pove}e temi za 
koi posetitelite mo`at da napi{at komentar ili da postavat 
pra{awe. Sekoj mo`e na ednostaven na~in i bez posebni tehni~ki 
znaewa da go ka`e svoeto mislewe. Sodr`inite mo{ne ~esto se 
menuvaat i toa gi pravi veb-dnevnicite mnogu popularni.

Avtor na veb-dnevnik mo`e da bide koj bilo. Golem broj pozna-
ti li~nosti imaat svoi veb-dnevnici.

Avtorot na veb-dnevnik se narekuva bloger (blogger).

U~esnici i korisnici na blogovi 
Veb-dnevnikot ili blogot e namenet za po{irokata javnost. 

Naj~esto se raboti za odredena grupa koja diskutira vo vrska so 
temite {to se postaveni na blogot.

Blogovite mo`at da bidat zabavni, no i pou~ni. Vo niv mo`at 
da se najdat i mnogu obrazovni sodr`ini.

Razgovor:

Dali pi{uva{ 
dnevnik? Kak-

vi sodr`ini 
zapi{uva{ vo 

svojot dnevnik?
Dali ima{ tet-

ratka vo koja 
tvoite drugar~iwa 
mo`at da napi{at 
ne{to za sebe, da 

ti napi{at poraka 
ili da go ka`at 

svoeto mislewe?
Dali na Internet 

si videl sli~na 
stranica na koja 

korisnicite gi 
razmenuvaat 

svoite mislewa za 
odredena tema? 
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Eti~ko koristewe na veb-dnevnicite 
Komunikacijata preku Internet, pa taka i preku veb-dnevni-

cite, ne bara odnos lice v lice, no, sepak, va`no e da se odne-
suva{ na kultiviran i moralen na~in.

♦♦ Ne pi{uvaj nepotrebni sodr`ini {to ne se del od kultivi-
ranoto zboruvawe.

♦♦ ]e pro~ita{ mnogu mislewa {to mo`ebi nema da bidat vo sog-
lasnost so tvoite. Po~ituvaj gi stavovite na drugite lu|e i 
koga se sprotivni od tvoite.

♦♦ Vo komunikacijata odnesuvaj se prijatelski.

Soveti za bezbednost 
Blogovite se mo{ne popularni i sigurno }e zapoznae{ mnogu 

lu|e {to gi posetuvaat. Pred da poseti{ ili izraboti{ blog, 
pro~itaj gi slednive soveti:  

♦♦ Nikomu ne davaj informacii za tvoite li~ni podatoci, kako 
{to se: adresata, telefonskiot broj, rabotnoto mesto na 
roditelite, imeto na u~ili{teto i sli~no, bez dozvola od 
roditelite.

♦♦ Na nikogo ne gi ka`uvaj tvoite lozinki, pa duri ni na najb-
liskite prijateli.

♦♦ Na nikogo ne pra}aj tvoi sliki ili sliki od semejstvoto bez 
dozvola od roditelite.

♦♦ Vedna{ isklu~i se od Internet dokolku vidi{ ili pro~ita{ 
ne{to {to }e te voznemiri i ka`i im za toa na roditelite ili  
na nastavnicite.

♦♦ Nikoga{ ne prifa}aj sredba so nekogo {to si go zapoznal on-
lajn pred da gi izvesti{ roditelite, da gi pra{a{ i da do-
bie{ dozvola od niv. Tvoite roditeli treba da gi znaat i 
tvoite onlajn-prijateli, kako {to gi poznavaat i tvoite pri-
jateli od u~ili{teto.

 Pra{awa: 

1.	 [to e veb-dnevnik?

2.	 Kakvi sodr`ini mo`e da ima na veb-dnevnikot?

3.	 Koj gi pi{uva sodr`inite na veb-dnevnicite?

4.	 Kako se narekuva avtorot na veb-dnevnik?

5.	 Za kogo se nameneti sodr`inite na veb-dnevnicite?

6.	 Koj mo`e da bide posetitel i korisnik na veb-dnevnikot?

Zabele{ka: 

Terminite blog i 
veb-dnevnik 
}e gi upotrebu-
vame ramnopravno 
vo tekstot.

Istra`uvaj!

Preku 
prebaruva~ot 
Google najdi i 
razgledaj in-
teresni blogovi za 
muzika, za sport, 
za filmovie, za 
moda ili za druga 
tema. Pobaraj 
pomo{ od nas-
tavnikot za preba-
ruvawe blogovi.
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IZRABOTKA NA BLOG

Postojat mnogu serveri {to nudat uslugi za izrabotka na 
blog, kako: blog.com, blogger.com, a od makedonskite: blog.com.
mk i bloger.com.mk. Mnogu od niv se ednostavni za koristewe, no 
imaj predvid deka ovie serveri se otvoreni za site i mo`at da 
sodr`at blogovi so nesoodvetni sodr`ini. 

Sledi ja postapkata {to e opi{ana ponatamu vo tekstot za 
da izraboti{ blog na serverot bloger.com.mk. Dokolku ponatamu 
odlu~i{ da izraboti{ blog na drug server, ve}e }e ima{ iskust-
vo i }e znae{ kako toa da go napravi{ sam/a. 

 Stranica na portalot 

Startuvaj go svojot veb-prelistuva~ (Internet Explorer, Opera, 
Mozilla Firefox…).

Vo lentata za adresi vnesi ja adresata bloger.com.mk. ]e se 
otvori stranica kako na slikava na koja mo`e{ da gi vidi{ 
statistikata na portalot, kategoriite na blogovite, najnovite 
~lenovi i zapisi. 

 Registrirawe 

1	 Najprvin treba da se registrira{ kako ~len na portalot. 
Klikni na linkot registracija (slikata gore).

2	 Popolni ja sled-
nava forma za 
da ja zavr{i{ 
registracijata.

3	 Klikni na kop-
~eto Prodol`i.

Zabele{ka: 

Pred da po~ne{ so 
izrabotka na blog, 

bidi siguren/na 
deka ima{ adresa 

za elektronska 
po{ta.

1

2

3

Ova }e bide URL-adresa na 
tvojot blog.

Klikni na strel-
kata i odberi ka-
tegorija.

Zabele{ka:

Poliwata {to 
se obele`ani so 
yvezdi~ka (*) se 
zadol`itelni.

Va`no!

Zapi{i gi 
vo tetratka: 

korisni~koto ime, 
lozinkata i adre-

sata na blogot. 
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4	 Popolni gi baranite po-
liwa {to se nao|aat  na 
vtoriot del na strani-
cata. 

5	 Klikni na kop~eto Pro-
dol`i. 

 Odberi izgled na blogot 

Sega mo`e{ da go odbere{ izgledot na tvojot blog.

1	 Klikni na kop~eto do izgledot {to ti se dopa|a najmnogu.

2	 Klikni na kop~eto Prodol`i.

3	 ]e dobie{ izvestuvawe deka uspe{no si go izrabotil/a 
blogot. Klikni na kop~eto Prodol`i. 

4

5

1

2

3
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Na slednata stranica treba da se najavi{ (logira{) so vnesu-

vawe na korisni~koto ime i lozinkata. 

Pred da go napravi{ toa, treba da ja potvrdi{ tvojata re-
gistracija preku linkot {to ti e praten na tvojata adresa na 
e-po{tata. Dokolku sega se obide{ da se prijavi{, }e go dobie{ 
slednovo izvestuvawe:

 Potvrdi ja registracijata 

Otvori ja tvojata e-po{ta. ]e najde{ vakva poraka:

1	 Klikni na linkot za da ja otvori{ porakava.

2	 Klikni na linkot za potvrda (verifikacija) na tvojata regis-
tracija.

Povtorno }e ja dobie{ stranicata za najava (logirawe).

3	 Vnesi gi korisni~koto 
ime i lozinkata.

4	 Klikni na kop~eto Lo-
girawe.

1

2

Dokolku raboti{ na 
kompjuter {to ne go 
koristi{ samo ti, NE 
kliknuvaj na kop~eto 
Zapomni me.

3

4
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Ureduvawe na sodr`inata na blogot
Otkako }e se prijavi{, }e se otvori stranicata preku koja 

mo`e{ da go uredi{ svojot blog.

1	 Klikni na linkot so imeto na tvojot blog. ]e se otvori strani-
ca na koja mo`e{ da ureduva{ zapisi.

 Dodavawe zapisi 

1	 Zasega tvojot 
blog nema za-
pisi. Za da do-
dade{ nov za-
pis, klikni na 
linkot Dodadi 
zapis. 

2	 Popolni ja slednava 
forma. Vnesi naslov i 
sodr`ina na zapisot.

3	 Klikni na kop~eto Do-
dadi nov zapis.

Ovde mo`e{ da go 
smeni{ tvojot profil. 
Vmetni slika.

Ovde mo`e{ da 
napravi{ svoj 
fotoalbum.

Pred da go napu{ti{ por-
talot, ne zaboravaj da se 
odjavi{ (odlogira{).

1

Preku ovoj link 
mo`e{ da go 
vidi{ tvojot blog.

Preku ovoj link 
mo`e{ da gi pro-
meni{ opciite.

1

Tekstot mo`e{ da 
go uredi{ na ve}e 
poznatiot na~in.

Pred da go  
objavi{ zapisot, 
pregledaj go so 
kliknuvawe na 
kop~eto Prika`i 
go zapisot.

2

3



8	

Veb-dnevnici1

Vo nov prozorec }e se 
otvori tvojot blog. Gle-
da{ deka tvojot zapis e 
prika`an, no blogot za-
sega e bez naslov. 

 Dodavawe naslov na blogot 

Vo pregleduva~ot vrati se na stranicata bloger.com.mk. 

1	 Klikni na linkot Op-
cii.

]e ja dobie{ slednava 
forma (inaku, klikni na 
linkot Glavni podesu-
vawa):

2	 Popolni ja formata.

3	 Klikni na kop~eto 
Za~uvaj promeni. 

 Pregled na zapisite 

Preku linkot Zapisi }e dobie{ pregled na site zapisi. Na 
desnata strana se dadeni mo`nosti za pregled, za izmena ili za 
bri{ewe na zapisot.

 Ve`bi: 

1.	 Vnesi nekolku zapisi vo tvojot blog. 

2.	 Pregledaj gi site zapisi.

3.	 Izmeni nekoi od zapisite.

4.	 Izbri{i eden zapis.

Preku linkot 
Zapisi }e dobie{ 

pregled na site 
zapisi.

2
1

3
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Komentari na ve}e postojnite blogovi
Dokolu ja znae{ adresata na nekoj blog, mo`e{ da go poseti{. 

Na po~etnata stranica na portalot bloger.com.mk ima spisok od 
postojnite blogovi koi, isto taka, mo`e{ da gi poseti{. Mo`e{ 
da gi pro~ita{ napisite, no i da ostavi{ svoj komentar.

 ^itawe i pi{uvawe komentari 

1	 Za da gi vidi{ ko-
mentarite, klikni na 
linkot Comments.

2	 Za da napi{e{ nov 
komentar, klikni 
na linkot Post com-
ments. 

]e dobie{ forma kako na slednava slika.

3	 Napi{i komentar i klikni 
na kop~eto Objavi komen-
tar, koe se nao|a na dnoto 
na stranicata. Tvojot ko-
mentar }e se prika`e so 
drugite.

 Ve`bi: 

1.	 Izrabotete so drugarite od oddelenieto svoi blogovi. Iz-
berete interesni temi. 

2.	 Poseti gi blogovite na sou~enicite. Pro~itaj gi nivnite 
mislewa i daj svoi komentari.

Pred objavuvawe-
to, mo`e{ da go 
pregleda{ komen-
tarot

Dokolku se 
premisli{, 
mo`e{ da se 
otka`e{

3

2
1
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Veb-dnevnici1

Ve{tini {to treba da gi usovr{i{!

♦♦ Da se registrira{ na veb-stranica {to dava 
mo`nost za izrabotka na blog.

♦♦ Da izraboti{ blog.

♦♦ Da uredi{ sodr`ina na tvojot blog.

♦♦ Da otvori{ blog.

♦♦ Da napi{e{ komentar na blogot.

Treba da zapomni{!

Veb-dnevnik ili blog e lokacija na Internet vo 
forma na elektronski vesnik ili dnevnik, sostavena 
od sodr`ini {to se prika`ani po obraten vremenski 
redosled.

Avtorot na veb-dnevnik se narekuva bloger (blogger).
Komunikacijata preku Internet, pa taka i preku veb-

dnevnicite, ne bara odnos lice v lice, no, sepak, va`no 
e da se odnesuva{ na kultiviran i moralen na~in.



11	

	 Ureduvawe tekst 

So programata Word mo`e{ da izraboti{ 
pisma, esei, vesnici...

SODR@INA:

Voved 

MS Word  & da povtorime!

Ureduvawe na pasusot

Ureduvawe novinarski tekst

Ureduvawe na stranicata

Pronao|awe i zamena na del od tekstot

Hipertekst

Pe~atewe dokument
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PODGOTVI SE!

Otvori nov dokument i vnesi go sledniov tekst:

Uredi go naslovot na sledniov na~in:

♦♦ font MAC C Swiss, 

♦♦ golemina 14, 

♦♦ so zadebeleni bukvi i 

♦♦ poramnet vo sredina.

Ostanatiot tekst uredi go na sledniov na~in: 

♦♦ so font MAC C Swiss, 

♦♦ golemina 12 i 

♦♦ izramni go od dvete strani. 

Za~uvaj go pod imeto „Rodendenot na Jana“.

Voved
Kompjuterite naj~esto se primenuvaat za obrabotka na teks-

tovi, odnosno za pi{uvawe, za ureduvawe i za pe~atewe pisma, 
statii, knigi i drugi tekstovi. Vnesuvaweto tekst e oddeleno od 
pe~ateweto, taka {to sekoj tekst pred da se otpe~ati mo`e da 
se proveri i da se otstranat gre{kite od nego. Osven toa, sekoj 
tekst mo`e dopolnitelno da se izmeni i da mu se opredeli iz-
gledot po `elba.

Ve}e znae{ da pi{uva{ tekst, a znae{ i da go uredi{: da od-
bere{ font, golemina i boja na bukvite, da go izramni{ tekstot, 
da postavi{ prored itn. Znae{ i da vmetnuva{ sliki i drugi 
grafi~ki elementi i da raboti{ so niv, a, isto taka, znae{ da 
izraboti{ i da uredi{ tabela. Znae{ da za~uva{ dokument i da 
go otpe~ati{.

Sega }e prodol`ime za da gi prodlabo~i{ svoite znaewa i da 
gi usovr{i{ ve{tinite. ]e nau~i{ da uredi{ pasus, da postavi{ 
zaglavie i podno`je na stranicite, da vmetne{ fusnota (objas-
nuvawe na nepoznat zbor) i komentar i da go podgotvi{ tekstot 
za pe~atewe. ]e nau~i{ {to e hipertekst i kako da vmetnuva{ 
hipervrski.

Rodendenot na Jana
Jana v~era prave{e rodendenska zabava. Taa n¢ zamoli da £ pomogneme vo 

podgotovkite, pa jas i Sawa treba{e da bideme kaj nea dva ~asa porano. 
Sawa ne saka{e da dojde bidej}i se prika`uva{e TV&emisijata {to dolgo 

vreme ja ~ekala, no ne saka{e ni da ja izneveri svojata drugarka. Postojano se 
premisluva{e. De }e dojde, de }e ostane doma. Otkako re{i da dojde, zaedno 
pojdovme nakaj Jana. 

Koga stignavme, vedna{  se fativme za rabota, taka {to s¢ be{e podgotveno 
porano od o~ekuvanoto. Eden ~as podocna gostite po~naa da pristignuvaat. Doj-
doa site osven Marko, koj bil bolen. Iako ne mo`e{e da prisustvuva na zaba-
vata, toj £ isprati rodendenska ~estitka na Jana.

Zabele{ka:

Iako postoi 
ponova verzija 
na programata 
Microsoft Word, 

se odlu~ivme za 
verzijata 2003, 
poradi faktot 
{to ovaa pro-

grama e naj~esto 
koristena vo 

na{ite u~ili{ta, 
a i vo domovite.



Ureduvawe 
tekst 2

13	

MS Word  & da povtorime!
Tekstot se vnesuva vo rabotnata povr{ina na mestoto na  

kursorot. Po vnesuvaweto na sekoj znak, kursorot se pomestuva 
za edno mesto kon desno. Koga }e se popolni eden red, kursorot 
preminuva vo nov red. 

Za da po~ne{ nov pasus, pritisni go tasterot Enter. 
Font se site bukvi od azbukata ili od abecedata, kako i bro-

evite napi{ani na ist na~in. Sekoj font ima svoe ime. 

Naredbite se povikuvaat od glavnoto meni, preku lentite so 
alatki, od pomo{noto meni (so desen klik) ili preku kratenkite 
od tastaturata.

Dokument vo Word, koj e za~uvan na nadvore{na memorija, gi 
ima nastavkata .doc i ikonata  .

Dokument se za~uvuva so naredbata File → Save as…
Dokument se otvora so naredbata File → Open...
Nov dokument se otvora so naredbata File → New...
Dokument se pe~ati so naredbata File → Print...
Alatki za ureduvawe tekst:

	

Alatki za poramnuvawe tekst:

	

Alatki za otsekuvawe, kopirawe i prilepuvawe tekst:

	

Alatki za izrabotuvawe listi:

	

Alatki za vmetnuvawe grafi~ki elementi:

	

Alatki za ureduvawe na grafi~kite elementi:
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Ureduvawe na pasusot 
Izgledot na pasusot mo`e{ da go odredi{ po sopstvena ̀ elba.

Sega }e nau~i{ kako da go uredi{ prostorot pred i po pasu-
sot, kako da go uredi{ rastojanieto me|u redovite, kako da go 
vovle~e{ pasusot i kako da go vovle~e{ ili istakne{ prviot 
red vo pasusot. Pasusot se ureduva vo prozorecot Paragraph, koj 
se povikuva so naredbata Format → Paragraph:

 Prostorot pred i po pasusot 

Oddelni delovi od tekstot, kako {to se naslovi i sli~no, 
potrebno e da gi istakneme so pogolem prostor pred ili po pa-
susot.

Primer za tekst so prostor po pasusot:

»» Vo tekstot „Rodendenot na Jana“  
}e go oddeli{ naslovot od tekstot 
na toj na~in {to pred naslovot }e os-
tavi{ prostor od 6, a po naslovot & 
od 12 to~ki. Sledi gi upatstvata:

1	 postavi go kursorot 
kade bilo vo naslovot;

2	 klikni na menito For-
mat;

3	 od ponudenite naredbi 
klikni na Paragraph.

Poramnuvawe

Vovlekuvawe

Prostor pred 
i po pasus

Ureduvawe na 
prvata linija

Prored

Ovde mo`e{ da 
vidi{ kako }e 
izgleda pasusot

Zapomni! 

Pasus e del od 
tekstot me|u dva 

znaka za Enter.

Jana v~era prave{e roden-

denska zabava.

 Taa n¢ zamoli da £ pomogneme 

vo podgotovkite, pa jas i Sawa 

treba{e da bideme kaj nea dva 

~asa porano. 

1

3
2



Ureduvawe 
tekst 2

15	

 Ureduvawe prored 

Prored (Line spacing) e goleminata na prazniot prostor me|u 
dva reda vo pasusot. Vo Word proredot avtomatski e opredelen 
na edna linija. No, nekoga{ e potrebno celiot tekst ili oddelni 
pasusi da se istaknat so poinakov prored.

Za da uredi{ prored, pozicioniraj se vo pasusot i povikaj go 
prozorecot Paragraph so naredbata Format → Paragraph. Vo de-
lot Spacing:

1	 klikni na nadolnata strel-
ka vo poleto Line spacing za 
da otvori{ lista;

2	 od listata odberi edna od 
ponudenite opcii;

3	 dokolku saka{ precizno 
da go definira{ proredot, 
vnesi ja vrednosta vo pole-
to At;

4	 potvrdi na kop~eto OK. 

Rodendenot na Jana

Jana v~era prave{e rodendenska zabava. Taa n¢ zamoli da £ pomogneme vo podgoto-
vkite, pa jas i Sawa treba{e da bideme kaj nea dva ~asa porano. 

Sawa ne saka{e da dojde bidej}i se prika`uva{e TV&emisijata {to dolgo vreme ja 
~ekala, no ne saka{e ni da ja izneveri svojata drugarka. Postojano se premisluva{e. 
De }e dojde, de }e ostane doma. Otkako re{i da dojde, zaedno pojdovme nakaj Jana. 

Koga stignavme, vedna{  se fativme za rabota, taka {to s¢ be{e podgotveno po-
rano od o~ekuvanoto. Eden ~as podocna gostite po~naa da pristignuvaat. Dojdoa 
site osven Marko, koj bil bolen. Iako ne mo`e{e da prisustvuva na zabavata, toj £ 
isprati rodendenska ~estitka na Jana.

Obidi se sam/a 

Da gi uredi{ site tri pasusi, so prostor od 6 to~ki po sekoj pasus. Sega tek-
stot treba da izgleda vaka:

Zabele{ka:

Mo`e{ da gi koris-
ti{ kratenkite od 
tastaturata:

Ctrl+1 & za prored od 
edna linija;

Ctrl+2 & za prored od 
dve linii;

Ctrl+5 & za prored 
od edna i polovina 
linija.

Vo prozorecot Paragraph; vo delot Spacing:

4	 klikni na strelkata za na-
gore, desno od poleto Before, 
za da ja zgolemi{ vrednosta 
na prostorot pred pasusot;

5	 klikni na nagornata strel-
ka, desno od poleto After, za 
da ja zgolemi{ vrednosta na 
prostorot po pasusot;

6	 potvrdi na kop~eto OK.

So kliknuvawe na 
nadolnite strel-
ki }e ja namalu-
va{ vrednosta vo 
poleto.

2

1

4

3

6

5

4



Ureduvawe 
tekst2

16	

 Vovlekuvawe na pasusot 

Koga }e saka{ da istakne{ nekoj pasus vo odreden tekst ili 
da go podgotvi{ za vmetnuvawe slika (da napravi{ prostor za 
slika vo pasusot), vovle~i go toj pasus navnatre & od levo ili od 
desno, ili od dvete strani.

Pasusot }e go vovle~e{ preku prozorecot Paragraph, vo delot 
Indentation:

1	 za da go vovle~e{ pasu-
sot od levo, vo poleto 
Left (levo) vnesi ja vred-
nosta ili opredeli ja so 
pomo{ na strelkite;

2	 za da go vovle~e{ pasu-
sot od desno, vo poleto 
Right (desno) vnesi ja 
vrednosta ili opredeli 
ja so pomo{ na strelkite;

3	 potvrdi na kop~eto OK.

Rodendenot na Jana

Jana v~era prave{e rodendenska zabava. Taa n¢ zamoli da £ pomogneme vo podgotovkite, pa jas 

i Sawa treba{e da bideme kaj nea dva ~asa porano. 

Sawa ne saka{e da dojde bidej}i se prika`uva{e TV&emisijata {to dolgo vreme ja ~ekala, no 

ne saka{e ni da ja izneveri svojata drugarka. Postojano se premisluva{e. De }e dojde, de }e ostane 

doma. Otkako re{i da dojde, zaedno pojdovme nakaj Jana. 

Koga stignavme, vedna{  se fativme za rabota, taka {to s¢ be{e podgotveno porano od 

o~ekuvanoto. Eden ~as podocna gostite po~naa da pristignuvaat. Dojdoa site osven Marko, koj bil 

bolen. Iako ne mo`e{e da prisustvuva na zabavata, toj £ isprati rodendenska ~estitka na Jana.

Obidi se sam/a

Da postavi{   prored od dve linii me|u redovite vo tretiot pasus. 
Sega tekstot izgleda vaka: 

So primer }e poka`eme kako mo`e da se uredi proredot preku 
lentata za formatirawe, so alatkata Line spacing  .

»» Vo tekstot „Rodendenot na Jana“ vtoriot pasus uredi go so 
prored edna i polovina linija:

1	 pozicioniraj se kade bilo vo pasusot;

2	 klikni na strelkata za nadolu, desno 
od alatkata Line spacing (na lentata 
za formatirawe);

3	 vo listata klikni na 1,5.

1

3

2

1

3

2
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Preku primer }e poka`eme kako da vovle~e{ pasus, koristej}i 
gi grani~nicite na linijarot.

Mo`e{ da zabele`i{ deka na desnata strana na linijarot ima 
eden triagolnik & toa e desen grani~nik, a na levata strana ima 
dva triagolnika i pod niv eden pravoagolnik. Pravoagolnikot 
e lev grani~nik & za vovlekuvawe na site redovi vo odreden 
pasus. Dvata triagolnika }e gi objasnime ponatamu vo tekstot.

»» Vo tekstot „Rodendenot na Jana“ vtoriot pasus vovle~i go 
odlevo za okolu 2 cm:

4	 pozicioniraj se kade bilo vo pasu-
sot;

5	 so gluv~eto klikni na leviot 
grani~nik (pravoagolnik) i so pri-
tisnato levo kop~e od gluv~eto 
povle~i go kon levo;

6	 dodeka gi povlekuva{ grani~-
nicite, isprekinata vertikalna 
linija }e ti poka`e kolku }e bide 
vovle~en pasusot. Koga }e dojde{ 
na 2 cm, otpu{ti go kop~eto.

Obidi se sam/a 

Da go vovle~e{ vtoriot pasus od desnata strana. 

 Vovlekuvawe na prviot red 

Tekstot izgleda poubavo i pojasno se gledaat pasusite koga 
prviot red e vovle~en ili istaknat malku, vo odnos na drugite 
redovi vo pasusot. 

Primer na tekst so vovle~en prv red:

	 Jana v~era prave{e rodendenska 
zabava. Taa n¢ zamoli da £ pomogneme vo 
podgotovkite, pa jas i Sawa treba{e da 
bideme kaj nea dva ~asa porano. 

Primer na tekst so istaknat prv red:

Jana v~era prave{e rodendenska zabava.

Taa n¢  zamoli da £ pomogneme vo 
podgotovkite, pa jas i Sawa treba{e 
da bideme kaj nea dva ~asa porano. 

6

5

4

Zabele{ka:

So povlekuvawe 
na pravoagolnikot 
od levata strana 
se povlekuvaat 
i dvata triagol-
nika.

Za da gi uredi{ precizno vovlekuvaweto ili istaknuvawe-
to na prviot red, povikaj go prozorecot Paragraph, pa vo delot 
Indentation:
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1	 klikni na strelkata za na-
dolu vo poleto Special za da 
otvori{ lista;

2	 klikni na First line za 
vovle~ena ili Handing za 
istaknata prva linija;

3	 vo poleto By vnesi ja vred-
nosta;

4	 potvrdi na kop~eto OK.

Vreme e da gi objasnime dvata grani~nika (triagolnika) {to 
se nao|aat na levata strana od linijarot, koi bea spomenati pre-
thodno. Gorniot lev grani~nik e za vovlekuvawe samo na prviot 
red od pasusot, a dolniot e za vovlekuvawe na site redovi, os-
ven prviot (toga{ prviot red e istaknat).

Za da go uredi{ tekstot kako vo gorniot primer, so gluv~eto 
povle~i go gorniot lev grani~nik do sakanata pozicija (okolu 1 
cm). Polo`bata na grani~nicite  }e bide vakva .

 Pra{awa i zada~i: 

1.	 So koja naredba se povikuva prozorecot za ureduvawe pa-
sus?

2.	 Koi ureduvawa na pasusot mo`e{ da gi napravi{?

3.	 Kako }e go namesti{ prostorot pred i po pasusot?

4.	 Kako }e postavi{ rastojanie me|u redovite vo pasusot?

5.	 Kako }e go vovle~e{ pasusot?

6.	 Kako }e go vovle~e{ ili istakne{ prviot red vo pasusot?

7.	 Napi{i tekst so naslov „Mojata omilena kniga“. Tekstot 
neka ima tri pasusi:

♦♦ naslovot neka bide so golemina od 14 to~ki (14 pt), boldi-
ran i izramnet vo sredina (centriran);

♦♦ prostorot po naslovot neka iznesuva 12 to~ki;

Obidi se sam/a 

Da go vovle~e{ prviot red vo vtoriot pasus & za 1,5 cm, a vo tretiot 
pasus da go istakne{ prviot red & za 2 cm. Koga }e saka{ prviot red da 
go istakne{ pred drugite redovi vo pasusot, povle~i go dolniot lev 
grani~nik. Toga{ polo`bata na grani~nicite }e izgleda vaka .

2

1

4

3
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♦♦ uredi go drugiot tekst so golemina od 12 to~ki;

♦♦ prviot i tretiot pasus uredi gi so prored od edna i po-
lovina linija, a vtoriot so prored od 1 linija;

♦♦ uredi go prostorot pred vtoriot pasus na 6, a po nego na 
12 to~ki;

♦♦ vovle~i gi prvite redovi na prviot i na tretiot pasus za 
1 cm;

♦♦ vovle~i go vtoriot pasus od levo za 5 cm, a od desno za 
2 cm;

♦♦ za~uvaj go dokumentot vo tvojot folder.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ prostor pred i po pasusot.

♦♦ Da uredi{ prored me|u redovite vo pasusot.

♦♦ Da go vovle~e{ pasusot vo odnos na marginite.

♦♦ Da go vovle~e{ ili istakne{ prviot red vo pasusot.

Ureduvawe novinarski tekst
Za da uredi{ novinarski tekst, treba da gi znae{ pravilata 

za pi{uvawe tekst. Sega }e gi nau~i{ pravilata i }e nau~i{ 
kako da pi{uva{ tekst vo koloni, kako vo vesnicite.

Povtori i podgotvi se!

Vo tekstot „Rodendenot na Jana“  uredi gi site pasusi taka {to da 
bidat bez prored, so prostor 6 to~ki po pasus i bez vovle~ena ili 
istaknata prva linija. Osven naslovot, tekstot neka bide izramnet 
od levo.

Primer: pravilno upotrebeni znaci

Jana v~era prave{e rodendenska zabava (za 
12-tiot rodenden). Taa n¢ zamoli da £ pomog-
neme vo podgotovkite, pa jas i Sawa treba{e da 
bideme kaj nea dva ~asa porano. 

Kupivme mnogu podaroci: kniga, kukla, narak-
vica i ~okolada.

Primer: nepravilno upotrebeni znaci

Jana v~era prave{e rodendenska zabava (  
za 12-tiot rodenden ).Taa n¢ zamoli da £ pomog-
neme okolu podgotovkite, pa jas i Sawa treba{e 
da bideme kaj nea dva ~asa porano. 

K  u  p  i  v  m  e   m  n  o  g  u  
podaroci:kniga,kukla,narakvica i ~okolada.
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Zabele{ka:

Dokolku saka{, 
mo`e{ da gi 

opredeli{ {iri-
nata na kolonite 

(Width) i ras-
tojanieto me|u 

kolonite  
(Spacing).

 Pravila za pi{uvawe tekst 

Interpunkciskite znaci se sostaven del na tekstot. Va`no 
e da nau~i{ da gi koristi{ pravilno. Pravilata se isti kako 
koga pi{uva{ so raka, no ovde imaat dopolnitelno zna~ewe: so 
pravilno pi{uvawe polesno }e go uredi{ tekstot. Isto taka, 
pravilnoto koristewe na znacite pridonesuva za poubav izgled 
na tekstot.

Vo vtoriot primer mo`e{ da zabele`i{ deka zagradata ostana-
la vo prviot red i se oddelila od tekstot vo nea. Zabele`uva{ 
i deka posledniot red nema prazni mesta po interpunkciskite 
znaci. Word gi smeta site zborovi kako eden i gi prefrla vo nov 
red, ostavaj}i golemi praznini vo prethodniot red.

Po~ituvaj gi slednive pravila:

♦♦ Oddeluvaj gi zborovite so samo edno prazno mesto.

♦♦ Pi{uvaj gi interpunkciskite znaci (. , : ; ! ?) vedna{ po zborot 
po koj sleduvaat, bez da ostavi{ prazno mesto. No, zborot {to 
sleduva zadol`itelno oddeli go od znakot so edno prazno 
mesto.

♦♦ Me|u zagradite i zborot {to e vnatre ne se ostava prazno mes-
to. No, zagradite, po pravilo, se oddeluvaat od zborovite {to 
se nadvor od niv so edno prazno mesto.

 Pi{uvawe vo koloni 

Tekstot mo`e{ da go pi{uva{ vo dve ili vo pove}e koloni. Na 
toj na~in mo`e{ da go uredi{ tekstot kako vo vesnik. Mo`e{ da 
uredi{ u~ili{ten vesnik ili bilten za klasot.

»» Uredi go tekstot „Rodendenot na Jana“ vo dve koloni:

1	 prvo, selektiraj go celiot tekst (osven naslovot);

2	 klikni na menito Format;
3	 vo menito {to }e se pojavi klikni na opcijata Column.

]e se otvori sledniov prozorec:

2

1

3
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4	 klikni na ikonata so dve 
koloni ili vnesi 2 vo poleto 
Number of columns;

5	 dokolku saka{ kolonite da 
gi oddeli{ so linija, potvr-
di vo poleto Line between;

6	 koga }e bide{ zadovolen/na 
so opciite, klikni na kop-
~eto OK.

Tekstot sega izgleda vaka:

Ve{tini {to treba da gi usovr{i{!

♦♦ Pravilno da gi koristi{ interpunkciskite znaci.

♦♦ Da uredi{ tekst vo koloni (Insert → Column).

 Pra{awa i zada~i: 

1.	 Kako se upotrebuvaat interpunkciskite znaci vo tekstot? 
Koi pravila treba da gi po~ituva{?

2.	 Kako se ureduva tekst vo koloni?

3.	 Dali mo`e{ da gi uredi{ {irinata i prostorot me|u 
kolonite? Kako?

4.	 Napi{i statija za biltenot na klasot. Opi{i gi ak-
tivnostite i slu~uvawata vo klasot.

♦♦ Vnimavaj pravilno da gi upotrebi{ interpunkciskite 
znaci.

♦♦ Odberi ispravena orientacija na stranica (Portrait od na-
redbata Page Setup).

♦♦ Uredi go tekstot vo dve koloni.

Obidi se sam/a 

Da go uredi{ tekstot vo tri koloni.

4

5
6



Ureduvawe 
tekst2

22	

♦♦ Prvata kolona neka bide po{iroka od drugite.

♦♦ Postavi linii me|u kolonite.

♦♦ Otvori nov dokument i napi{i naslov: „Jas, moeto 
u~ili{te i moeto mesto“. 

♦♦ Odberi legnata orientacija na stranica (Lendscape od 
naredbata Page Setup).

♦♦ Pod naslovot uredi go tekstot vo tri koloni so ednakva 
{irina (tekstot }e go vnese{ podocna).

♦♦ Vo prvata kolona napi{i ne{to za sebe, vo vtorata za 
tvoeto u~ili{te, a vo tretata za tvoeto mesto na `ivee-
we.

♦♦ Za~uvaj go dokumentot.

5.	 So sou~enicite uredi nekolku statii za u~ili{niot ves-
nik.

Ureduvawe na stranicata
Vo ova poglavje }e nau~i{ da postavi{ zaglavie i podno`je na 

stranica, da vmetne{ fusnota i da ostavi{ komentar.

 Postavuvawe zaglavie i podno`je na stranicata 

Si videl/a vo nekoi od u~ebnicite deka naslovot na nekoja 
tema ili nekoj drug tekst e napi{an na sekoja stranica & na vr-
vot ili na dnoto. Takvite tekstovi ne se pi{uvani na sekoja 
stranica posebno, tuku edna{ se vneseni kako zaglavie (na vr-
vot) ili kako podno`je (na dnoto). 

»» Otvori nekoj tekst so pove}e stranici i vo nego postavi za-
glavie i podno`je:

1	   klikni na menito View;

2	   klikni na naredbata Header and Footer.

]e se pojavi prostor {to e ozna~en so isprekinata lini-
ja kade  {to treba da go napi{e{ tekstot. Isto taka, }e 
vidi{ i edna lenta za ureduvawe na zaglavieto i na podno`jeto 
(Header and Footer):

3	 vo zaglavieto (Header) napi{i „U~ili{ten vesnik“;

1

2

4

3
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4	 za da premine{ na podno`jeto, klikni na ikonata Switch be-
tween Header and Footer ili na tasterot so strelka nadolu;

5	 vo podno`jeto (Footer) napi{i „Ureduvaat u~enici od {esto 
oddelenie“;

6	 za da izleze{ od zaglavieto i podno`jeto i da prodol`i{ da 
raboti{ na svojot tekst, klikni na kop~eto Close & od lentata 
Header and Footer.
Zaglavieto i podno`jeto mo`e{ da gi uredi{ po tvoja `elba. 

Mo`e{ da gi uredi{: fontot, goleminata na bukvite, bojata na 
bukvite, izramnuvaweto i s¢ drugo & isto kako vo obi~en tekst. 

 Vnesuvawe fusnota ( footnote ) 

^esto vo lekciite si sretnal/a nepoznati zborovi i si 
pobaral/a objasnuvawe za niv. Fusnotite ti pomagaat polesno 
da go najde{ objasnuvaweto na zborot. Toa se onie mali znaci 
(naj~esto yvezdi~ki) ili broj~iwa do zborot, koi ti ka`uvaat 
kade da gi bara{ objasnuvawata, a tie naj~esto se nao|aat na kra-
jot od stranicata. Objasnuvaweto {to se nao|a na krajot na doku-
mentot se narekuva endnote.

»» Vo tekstot „Rodendenot na Jana“ objasni go poimot TV-emisija:

1	 prvo, postavi go kurso-
rot vedna{ po zborot 
emisija;

2	 klikni na menito In-
sert;

3	 vo ponudenite opcii 
klikni na Reference;

4	 vo novata lista klikni na Footnote.

]e se otvori prozorecot Footnote and 
Endnote, vo koj:

5	 za ozna~uvawe na fusnotite mo`e{ da 
odbere{ broevi {to }e se zgolemuvaat 
avtomatski so sekoja nova fusnota ili 
da vnese{ znak vo poleto Custom mark. 
Fusnotata }e bide ozna~ena so toj znak 
(naj~esto se koristi znakot „*“);

6	 klikni na kop~eto Insert.

1

4

2

3

5

6

5

6

Vnimavaj!

Zadol`itelno 
vrati se vo 
tekstot za da 
prodol`i{ da 
vnesuva{ tekst 
ili za da go ure-
di{. Vnimavaj da 
ne prodol`i{ da  
pi{uva{ vo de-
lot predviden za 
fusnota.

Zabele{ka:

Endnote e objasnu-
vawe {to e dadeno 
na krajot na doku-
mentot.

Od lentata  
Header and Footer 
mo`e{ da odbe-
re{ numerirawe 
na stranicite & 
kako zaglavie ili 
kako podno`je.
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Na ekranot }e ja vidi{ slednava sostojba:

♦♦ po zborot emisija se pojavil znakot „*“;

♦♦ na dnoto na stranicata gleda{ linija so „*“ pod nea. Sega 
poka`uva~ot e do znakot „*“;

7	 napi{i go objasnuvaweto na zborot emisija.

 Vnesuvawe komentari 

Koga pi{uva{ tekst (na primer: sostav ili proekt za na 
u~ili{te), korisno e da zabele`uva{ idei ili mesta kade {to 
treba da dopolni{ ili da proveri{ ne{to. Za toa }e ti pomog-
nat komentarite.

»» Vo tekstot „Rodendenot na Jana“ na zborot dva vnesi komen-
tar:

1	 prvo, postavi go kursorot na 
zborot dva;

2	 klikni na menito Insert;
3	 vo ponudenite opcii klikni na 

Comment.

]e se otvori prostor kako na slikata dolu, kade {to mo`e{ 
da go vnese{ tvojot komentar:

4	 napi{i go komentarot.

Koga komentarite ve}e nema da ti bidat potrebni, lesno }e gi 
otstrani{: 

5	 so desnoto kop~e od gluv~eto klikni na 
komentarot i 

6	 vo menito {to }e se pojavi klikni na De-
lete Comment.

1

2

3

4

6

5

7
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Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ i uredi{ zaglavie i podno`je na 
stranicitr (View → Header and Footer).

♦♦ Da postavi{ i uredi{ fusnota vo tekst (Insert → 
Footnote).

♦♦ Da vmetne{ komentar vo tekst (Insert → Comment).

Pra{awa i zada~i: 

1.	 Objasni gi poimite zaglavie i podno`je.

2.	 So koja naredba }e postavi{ zaglavie i podno`je vo odre-
den dokument?

3.	 Dali mo`e{ da gi uredi{ zaglavieto i podno`jeto po 
`elba? Kako?

4.	 Kako }e izleze{ od zaglavieto i podno`jeto i }e prodol`i{ 
da vnesuva{ ili ureduva{ tekst vo dokumentot?

5.	 [to e fusnota?

6.	 Kako }e vnese{ fusnota vo tekstot?

7.	 Kako }e vnese{ komentar vo tekst?

8.	 Dali mo`e da se izbri{e nekoj komentar koga ve}e nema da 
bide potreben?

9.	  Vnesi tekst vo koj }e pi{uva{ za bilkite. Mo`e{ da izbere{ 
i druga tema po sopstven izbor. Tekstot neka ima barem dve 
stranici.

♦♦ Postavi zaglavie vo koe }e go napi{e{ imeto na dokumen-
tot.

♦♦ Postavi podno`je i napi{i gi tvoeto ime i tvoeto prezime 
vo nego.

♦♦ Numeriraj gi stranicite (Page numbers od menito Insert).
♦♦ Vo tekot na rabotata zabele`i gi ideite so pomo{ na ko-
mentari.

♦♦ Za~uvaj go dokumentot vo tvojot folder.

10.	 Vo nov dokument napi{i ja slednava re~enica: „Kompjuter-
skiot sistem se sostoi od dve komponenti: hardver i soft-
ver.

♦♦ Postavi fusnota na zborovite hardver i softver. Koris-
ti ja opcijata Autonumber. 

♦♦ Vo predvideniot prostor napi{i objasnuvawe na dvata 
zbora.
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Pronao|awe i zamena na del od tekstot
^esto postoi potreba vo tekstot da se pronajde nekoj zbor ili 

del od tekstot so cel da se smeni ureduvaweto ili da se zameni 
so drug zbor ili tekst. Za taa cel se koristat naredbite Find 
(Najdi) i Replace (Zameni), so koi }e se zapoznae{ sega.

 Pronao|awe del od tekstot 

Koga ima{ kus tekst pred sebe, lesno mo`e{ da go najde{ 
zborot {to ti e potreben. No, koga ima{ tekst od desetina 
stranici, a treba da najde{ nekoj zbor vo nego, toga{ „{etaweto“ 
niz dokumentot ne e najsoodveten na~in. Postoi polesen na~in & 
so pomo{ na naredbata Find.

»» Pronajdi go zborot Jana vo tekstot „Rodendenot na Jana“: 

1	 klikni na menito Edit;
2	 od nadolnoto meni odberi ja naredbata Find.

]e go dobie{ prozorecot Find and Replace (najdi i zameni):

3	 vo poleto Find what 
napi{i Jana;

4	 klikni na kop~eto 
Find Next; zborot 
}e bide ozna~en vo  
tekstot.

Zna~eweto na drugite kop~iwa i opcii:

5	 postojat i mo`nosti za poprecizno barawe; za da postavi{ 
u{te parametri, klikni na kop~eto More; }e se otvori nov 
del vo prozorecot;

6	 opcijata Match case ozna~i ja toga{ koga }e saka{ Word da gi 
razlikuva golemite od malite bukvi pri prebaruvaweto;

7	 opcijata Find whole words only ozna~i ja toga{ koga }e saka{ 
da gi najde{ samo celite zborovi, a ne i delovi od drugi zbo-
rovi;

8	 kop~eto Format }e ti dade mo`nost da najde{ zborovi so 
opredeleno formatirawe (font i sli~no).

8

6
7

3

45

Zabele{ka:

Naredbata Find 
mo`e{  da ja 

povika{ so taste-
rite Ctrl+F.
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Obidi se sam/a 

Da postavi{ opcii za prebaruvawe i da najde{ nekolku 
zborovi vo nekoj podolg tekst.

 Zamena na del od tekstot 

Mo`ebi saka{ da zameni{ eden zbor so drug vo nekoj tekst i 
toa na site ili samo na odredeni mesta vo tekstot. Povikaj ja 
naredbata Replace od menito Edit.

»» Vo tekstot „Rodendenot na Jana“ zborot Jana zameni go so 
zborot Ana:

1	 vo prozorecot Find 
and Replace klikni 
na opcijata Replace.

]e se otvori prozorecot Find and Replace (najdi i zameni):

2	 vo poleto Find 
what napi{i Jana.

3	 vo poleto Replace 
with napi{i Ana.

4	 klikni na kop~eto 
Replace All.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da pronajde{ soodveten zbor ili del od tekstot 
(Edit → Find).

♦♦ Da zameni{ eden del od tekstot so drug na edno ili 
na site mesta vo koi se pojavuva (Edit → Replace).

 Pra{awa i zada~i: 

1.	 So koja naredba }e go povika{ prozorecot za nao|awe i za 
zamena na zborovite vo tekstot? Kako se narekuva toj pro-
zorec?

2.	 Kako }e gi postavi{ parametrite za poprecizno barawe?

3.	 Koj parametar }e go postavi{ za nao|awe na samo celi zbo-
rovi, a koj za razlikuvawe na malite od golemite bukvi?

1

2

3 4

Zabele{ka:

Naredbata Replace 
All }e izvr{i za-
mena na site mesta 
vo tekstot. Koga 
saka{ da izvr{i{ 
zamena na oddelni 
mesta, koristi gi 
naredbite Find 
Next i Replace.

Zabele{ka:

Naredbata Re-
place mo`e{ da 
ja povika{ i od 
glavnoto meni Edit 
ili so tasterite 
CTRL+H.
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4.	 Vnesi go sledniov tekst:

♦♦ Golemata bukva [ zameni ja so mala, no samo koga ne e na 
po~etok na re~enicata (so Find next).

♦♦ Zameni go zborot sl. so zborot slika.

♦♦ Zborot font zameni go so zborot stil, no ne i zborot fon-
tot (so Find whole words only).

♦♦ Zameni go zborot Zamena, no ne i zborot zamena & so zborot 
Izmena (so Match case).

♦♦ Sekade po znacite to~ka (.), zapirka (,) i dve to~ki (:) os-
tavi po edno prazno mesto.

Hipertekst

 [to e hipertekst? 

Vo sekoja kniga, na po~etokot ili na krajot, e dadena sodr-
`inata na knigata, koja ni pomaga, vrz osnova na brojot na strani-
cata, da najdeme nekoj del vo nea.

Kompjuterskiot tekst mo`e da se ~ita po red, no postoi i 
na~in da se ~itaat razli~ni delovi od nego, na primer, vrzani 
za opredelen poim. Takvite zborovi sodr`at vrski {to vodat do 
soodveten tekst vo drug del od dokumentot ili do drug dokument. 

Onie delovi od teks-
tot na koi mo`e da se 
klikne so gluv~eto i na 
toj na~in da se premine 
vo drug tekst obi~no se 
ozna~eni so druga boja ili 
se podvle~eni. Takvite 
mesta vo tekstot se na-
rekuvaat hipervrski ili 
vrski (angl. link).

Tekstot {to sodr`i 
vrski do drugi delovi od 
tekstot ili do drugi tek-
stovi se narekuva hip-
ertekst (angl. hypertext).

Zamena na eden font so drug se vr[i,so komandi od 
menito koe se dobiva so kliknuvawe na kop~eto For-
mat od prozorecot od Sl. 3.Prvo se kliknuva vo po-
leto Find what:za da se zadade fontot {to sakame da 
go zamenime,pa vo poleto Replace with:za da se zadade 
fontot so koj sakame da izvr[ime zamena.
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 Vnesuvawe i koristewe hipervrski 

»» Povrzi pove}e dokumenti so hipervrski. Sledi gi upatstvata:

Vnesi go sledniov tekst:

Izraboti u{te pet dokumenti vo koi }e napi{e{ po nekolku 
re~enici za sekoj del na kompjuterot i za~uvaj gi na diskot vo 
tvojata papka. Za sekoj od delovite na prvata stranica posta-
vi hipervrska {to }e go otvori dokumentot vo koj e toj opi{an. 
Najprvo postavi vrska na zborot Procesor:

1	 ozna~i go zborot Procesor;

2	 klikni na menito Insert;
3	 klikni na Hyperlink.

]e se otvori prozorecot In-
sert Hyperlink: 

4	 vo delot Link to klikni na ikonata Existing file or Web Page;

Kompjuterot e izgraden od mnogu fizi~ki delovi: 

Procesor & delot koj gi obrabotuva podatocite i vo koj se 
izvr{uvaat programskite instrukcii i operacii.

Vnatre{na (operativna) memorija & delot vo koj se ~uvaat po-
datocite i programite dodeka raboti kompjuterot.

Vlezni edinici &delovite so koi vnesuvame podatoci i davame 
naredbi (tastatura, gluv~e, skener...).

Izlezni edinici & delovite za prika`uvawe na rezultatite 
(monitor, pe~ata~...).

Nadvore{ni memorii & delovite vo koi se ~uvaat podatocite 
koga ne raboti kompjuterot (hard disk, disketi, CD...).

2

3

1

Dokolku saka{ 
da postavi{  

hipervrska do 
opredeleno 

mesto vo eden 
ist dokument, 

klikni na iko-
nata Place in 

This Document.

4

7

5
6

8

Zabele{ka:

Naredbata Hyper-
link mo`e{ da ja 
povika{ i so tas-
terite Ctrl+K.
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5	 tekstot {to }e se prika`e mo`e{ i da go smeni{ vo lentata 
Text to display;

6	 vo poleto Look in pobaraj go folderot vo koj si go za~uval/a 
dokumentot so koj saka{ da postavi{ vrska;

7	 klikni na baraniot dokument;

8	 klikni na kop~eto OK.

Sega zborot Procesor e hipervrska, toj e podvle~en i e so 
sina boja. Za da premine{ vo dokumentot do koj toj vodi, dr`i go 
pritisnat tasterot Ctrl i klikni na vrskata.

Kompjuterot e izgraden od mnogu fizi~ki delovi: 

Procesor & delot koj gi obrabotuva podatocite i vo koj se 
izvr{uvaat programskite instrukcii i operacii.

Obidi se sam/a 

Da postavi{ hipervrski do drugite dokumenti za delovite 
na kompjuterot.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ hipervrska do drug dokument (Insert 
→ Hypertext).

♦♦ Da koristi{ hipervrska.

 Pra{awa i zada~i: 

1.	 Objasni go poimot hipertekst.

2.	 [to e hipervrska?

3.	 Kako }e go prepoznae{ tekstot vo dokumentot koj pretstavu-
va hipervrska do drug tekst?

4.	 Kako }e premine{ na tekstot do koj vodi hipervrskata?

5.	 Kako }e postavi{ hipervrska na eden tekst koja }e vodi do 
drug tekst vo istiot dokument?

6.	 Dali mo`e{ da postavi{ hipervrska do tekst vo drug doku-
ment ili do veb-lokacija na Internet? Kako?

7.	 Izraboti dokument vo koj }e gi nabroi{ planetite:

♦♦ za~uvaj go dokumentot vo tvojot folder pod imeto „Pla-
neti“;

♦♦ za sekoja od planetite izraboti dokument so kusa 
sodr`ina;

♦♦ za~uvaj gi dokumentite pod soodvetni imiwa;
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♦♦ vo dokumentot „Planeti“ postavi hipervrski do soodvet-
nite dokumenti za sekoja planeta;

♦♦ vo drugite dokumenti postavi vrska {to }e te vrati do 
dokumentot „Planeti“;

♦♦ dvi`i se me|u dokumentite koristej}i gi hipervrskite.

8.	 Na prvata stranica vo nov dokument napi{i naslov „Inter-
net termini”. Napravi spisok od nekolku termini vrzani za 
Internet. 

♦♦ Na vtorata stranica objasni go sekoj od terminite (os-
tavaj po nekolku prazni redovi me|u niv). 

♦♦ Na sekoj termin od spisokot postavi hipervrska do sood-
vetnoto objasnuvawe. 

♦♦ Po sekoe objasnuvawe napi{i go zborot Nazad, koj }e bide 
hipervrska do naslovot.

Za talentiranite u~enici

1.	 Napravi gi istite ve`bi, no namesto vo pove}e dokumenti, 
tekstot neka bide vo eden dokument. Pobaraj pomo{ od nas-
tavnikot. Neka ti objasni {to e bookmark.

Pe~atewe dokument
Krajnata cel e ureden i otpe~aten dokument. Dokolku saka{ 

da gi otpe~ati{ site stranici od dokumentot vo eden primer-
ok, dovolno e da klikne{ na alatkata Print   koja se nao|a na 
standardnata lenta, no pred toa dokumentot treba da go podgot-
vi{ za pe~atewe, odnosno treba da gi opredeli{ formatot i 
polo`bata na stranicata, kako i nejzinite margini.

 Margini i polo`ba na stranicata 

Na linijarite mo`e{ da vidi{ 
sini i beli povr{ini. Tekstot 
se vnesuva na belata povr{ina, 
a delot pod sinite povr{ini se 
narekuva margina. Vo marginite 
ne se pi{uva tekst, osven nekoi 
bele{ki i komentari.
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»» Podgotvi go za pe~atewe dokumentot „Rodendenot na Jana“:

1	 klikni na menito File;

2	 povikaj ja naredbata Page Setup.

]e se otvori prozorec kako na slednava slika: 

3	 dokolku karti~kata Margins ne e aktivna, klikni na nea;

4	 vo prviot del na Margins vnesi vrednosti za site ~etiri mar-
gini: Top & gornata, Bottom & dolnata, Left & levata i Right & 
desnata;

5	 vo vtoriot del & Orientation & klikni na ikonata Portrait za 
pi{uvawe po {irinata na listot;

6	 klikni na kop~eto OK.

 

Obidi se sam/a 

Da postavi{ margini i polo`ba na stranici na nekolku 
postojni dokumenti. 

 Izbor na stranici za pe~atewe 

Postojat razli~ni formati na hartija. Verojatno si slu{nal/a 
za formatite A3, A4 itn. Formatite imaat razli~ni dimenzii na 
stranica. Razli~ni pe~ata~i rabotat so razni formati na har-
tija. 

Format na hartija mo`e{ da odbere{, isto taka, vo prozore-
cot Page Setup od karti~kata Paper: 

3

6

5

4

Odberi ja iko-
nata Landscape 
koga }e saka{ 
da pi{uva{ po 
dol`inata na 
stranicata.
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1	 vo prozorecot Page Setup 
klikni na karti~kata Paper;

2	 vo delot Paper size odberi go 
formatot A4;

3	 klikni na kop~eto OK.

 Pregled pred pe~ateweto 

Pred pe~ateweto pogledni kako bi izgledal dokumentot 
otpe~aten. Dokolku si zadovolen/na so izgledot, otpe~ati go 
dokumentot. Vo sprotivno vrati se, uredi go podobro, pa toga{ 
otpe~ati go.

»» Pogledni kako }e izgleda tvojot tekst koga }e bide otpe~aten:

1	 klikni na menito File.

2	 klikni na Print Preview.

Dokumentot }e se poka`e so poinakov pregled. ]e se pojavi i 
lentata Print Preview (vedna{ pod glavnoto meni), a poka`uva~ot 
}e dobie oblik na lupa.

Proveri dali ti se dopa|a izgledot na dokumentot. Mali iz-
meni mo`e{ da napravi{ ako klikne{ na ikonata Magnifier  ; 
poka`uva~ot }e dobie oblik na kursor i mo`e{ da pi{uva{ vo 
tekstot.

Koga }e bide{ zadovolen/na, klikni na kop~eto Close za da go 
zatvori{ pregledot Print Preview so klik na.

 Pe~atewe na dokumentot 

Koga }e bide{ podgotven/a za pe~atewe:

1	 klikni na menito File.

2	 klikni na Print.
]e se optvori prozorecot Print:

3

2

1
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3	 Vo delot Printer, vo lentata Name odberi soodveten pe~ata~ 
(dokolku se instalirani pove}e pe~ata~i).

4	 Vo delot Page range napi{i gi broevite na stranicite {to 
saka{ da gi otpe~ati{. So zapirka oddeli gi broevite, a 
stranicite {to se ednopodrugo zapi{i gi so crti~ka (na pri-
mer: 2, 5&8 zna~i deka }e se otpe~atat vtorata i site strani-
ci od pettata do osmata). Dokolku saka{ da gi otpe~ati{ site 
stranici, odberi All.

5	 Vo delot Copies opredeli go brojot na kopiite.

6	 Klikni na kop~eto OK.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ margini, format i orientacija na 
stranicite (File → Page Setup).

♦♦ Da koristi{ pregled pred pe~ateweto (File → Print 
Preview).

♦♦ Da zmae{ da otpe~ati{ dokument (File → Print) i da 
postavi{ parametri za pe~atewe (pe~ata~, broj na 
kopii, stranici za pe~atewe).

 Pra{awa i zada~i: 

1.	 Koi podgotovki treba da se napravat pred da se otpe~ati 
dokumentot?

2.	 [to se margini?

3.	 Kako }e gi namesti{ marginite na dokumentot?

4.	 Kako }e ja odbere{ polo`bata na stranicite vo dokumentot 
{to saka{ da go otpe~ati{?

3

54

6

Zabele{ka:

Naredbata Print 
mo`e{  da ja 

povika{ so taste-
rite Ctrl+P.
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5.	 So koja naredba mo`e{ da vidi{ kako }e izgleda dokumen-
tot koga }e bide otpe~aten?

6.	 Koja e naredbata za pe~atewe dokument?

7.	 Kako }e gi odredi{ broevite na stranicite {to saka{ da gi 
otpe~ati{?

8.	 Izberi eden dokument so pove}e stranici. Uredi gi mar-
ginite na sledniov na~in:

♦♦ levata neka bide 1,5 cm; desnata 1 cm; gornata i dolnata 
po 2 cm;

♦♦ postavi gi stranicite za pe~atewe vo legnata polo`ba 
(Landscape);

♦♦ za format na hartija odberi A4;

♦♦ pogledni go dokumentot vo Print Preview;

♦♦ uredi go dokumentot po tvoja`elba;

♦♦ otpe~ati po dve kopii od site stranici.
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Proveri {to si nau~il/a!

1.	 Pasus }e uredi{ so naredbata:

	 a. File → Paragraph

	 b. File → Page Setup

	 v. Format → Paragraph

2.	 Rastojanieto me|u redovite }e go op-
redeli{ vo prozorecot Paragraph vo 
poleto:

	 a. Line spacing

	 b. Before

	 v. After

3.	 Grani~nicite se upotrebuvaat za:

	 a. postavuvawe margini

	 b. vovlekuvawe edna linija od pasusot

	 v. vovlekuvawe cel pasus

4.	 Prviot red vo pasusot:

	 a. mora da e vo ista linija so drugite re-
dovi

	 b. mo`e da bide samo vovle~en vo odnos na 
drugite redovi

	 v. mo`e da bide vovle~en ili istaknat vo 
odnos na drugite redovi

5.	 Prostorot me|u kolonite vo tekstot:

	 a. mo`e da se opredeli

	 b. ne mo`e da se opredeli

6.	 Zaglavie i podno`je se ureduvaat so 
naredbata:

	 a. Insert → Header and Footer

	 b. View → Header and Footer

	 v. Format → Header and Footer

7.	 Fusnotite vo dokumentot se:

	 a. pod zborot {to se objasnuva

	 b. na krajot na stranicata

	 v. na krajot na dokumentot

8.	 Vnesenite komentari vo tekstot:

	 a. mo`at da se izbri{at

	 b. ne mo`at da se izbri{at

9.	 Hipertekst e:

	 a. tekst od pove}e stranici

	 b. tekst {to sodr`i vrski kon drugi 
delovi od tekstot ili kon drugi doku-
menti

	 v. tekst {to sodr`i sliki i drugi 
grafi~ki objekti

10.	 Margini se:

	 a. objasnuvawa na nepoznati zborovi

	 b. prazni mesta vo tekstot

	 v. prazninite od ~etirite strani na 
stranicata

11.	 Vo Print Preview:

	 a. mo`e da se ureduva tekst

	 b. ne mo`e da se ureduva tekst

12.	 Pri pe~ateweto na dokumentot:

	 a. mora da se otpe~atat site stranici

	 b. mo`eme da opredelime koi stranici 
sakame da gi otpe~atime
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	 OpenOffice.org Writer 

SODR@INA:

OpenOffice Writer & da povtorime!

Ureduvawe na pasusot

Ureduvawe novinarski tekst

Ureduvawe na stranicata

Pronao|awe i zamena na del od tekstot

Hipertekst

Pe~atewe dokument

Dodatok:
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OpenOffice Writer & da povtorime! 
OpenOffice Writer (ili skrateno Writer) e del od paketot Ope-

nOffice koj e besplaten i mo`e{ da go prezeme{ od slednava ad-
resa: http://www.openoffice.org.

Dokument vo OpenOffice Writer, koj e za~uvan na nadvore{na 
memorija, gi ima nastavkata .odt i ikonata  .

Dokument se za~uvuva so naredbata Datoteka → Za~uvaj kako...

Dokument se otvora so naredbata  Datoteka → Otvori...

Nov dokument se otvora so naredbata  Datoteka → Nov

Alatki za ureduvawe tekst:

Alatki za poramnuvawe tekst: 

Alatki za otsekuvawe, kopirawe i prilepuvawe tekst:

Alatki za kreirawe listi: 

Alatki za vmetnuvawe grafi~ki elementi:

Ureduvawe na pasusot
Pasusot se ureduva vo prozorecot Pasus, koj se povikuva so na-

redbata Formatiraj → Pasus... Sega }e nau~i{ kako da go uredi{ 
prostorot pred i po pasusot, kako da go uredi{ rastojanieto me|u 
redovite, kako da go vovle~e{ pasusot i kako da go vovle~e{ 
ili istakne{ prviot red vo pasusot. S¢  ova }e go napravi{ vo 
karti~kata Vovlekuvawe i rastojanie, vo prozorecot Pasus.

 Prostorot pred i po pasuso t

♦♦ Postavi go kursorot kade bilo vo pasusot; 

♦♦ klikni na menito Formatiraj; 

♦♦ od ponudenite naredbi odberi Pasus. ]e se otvori prozore-
cot Pasus;
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♦♦ klikni na nagornata strelka desno od poleto Nad pasus, vo 
delot Rastojanie & za da ja zgolemi{ vrednosta na proredot 
pred pasusot;

♦♦ klikni na nagornata strelka desno od poleto Pod pasus, vo 
delot Rastojanie & za da ja zgolemi{ vrednosta na proredot 
po pasusot;

♦♦ potvrdi na kop~eto Vo red.

 Ureduvawe prored 

♦♦ Pozicioniraj se vo pasusot i povikaj go prozorecot Pasus. Vo 
delot Prored:

♦♦ klikni na nadolnata strelka;

♦♦ od listata odberi edna od ponudenite opcii;

♦♦ klikni na kop~eto Vo red.
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 Vovlekuvawe na pasusot i na prvata linija 

Pasusot i prvata linija }e gi vovle~e{ preku prozorecot  
Pasus, vo delot Vovlekuvawe:

♦♦ za da vovle~e{ pasus od levo, vo poleto Pred tekst vnesi ja 
vrednosta ili opredeli ja so pomo{ na strelkite;

♦♦ za da vovle~e{ pasus od desno, vo poleto Po tekst vnesi ja 
vrednosta ili opredeli ja so pomo{ na strelkite;

♦♦ za da ja vovle~e{ ili istakne{ prvata linija, vo poleto Prva 
linija vnesi ja vrednosta ili opredeli ja so pomo{ na strel-
kite. 

Pasusot i prvata linija od pasusot mo`e{ da gi vovle~e{ i so 
pomo{ na grani~nicite na linijarot. 

Ureduvawe novinarski tekst
 Pi{uvawe vo koloni 

♦♦ Prvo, selektiraj go tekstot;

♦♦ klikni na menito Formatiraj;

♦♦ vo nadolnoto meni klikni na opcijata Koloni.

]e se otvori sledniov prozorec:
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♦♦ klikni na ikonata so opredelen broj koloni ili vnesi broj vo 
poleto Koloni;

♦♦ opredeli [irina (dozvoleno e samo ako e isklu~ena opcijata 
Avtomatska {irina) na kolonite i Rastojanie me|u kolonite; 

♦♦ dokolku saka{, odberi linija za razdeluvawe na kolonite;

♦♦ koga }e bide{ zadovolen/na so opciite, klikni na kop~eto Vo 
red.

Ureduvawe na stranicata
 Postavuvawe zaglavie i podno`je na stranica 

Za da vmetne{ zaglavie:

♦♦ klikni na menito Vmetnuvawe;

♦♦ odberi ja opcijata Standardno od naredbata Zaglavie.

]e se pojavi prostor {to e ograni~en so linija, kade {to treba 
da go napi{e{ tekstot.

Za da vmetne{ podno`je:

♦♦ klikni na menito Vmetnuvawe;

♦♦ odberi ja opcijata Standardno od naredbata Podno`je.

]e se pojavi prostor {to e ograni~en so linija, kade {to treba  
da go napi{e{ tekstot.

Zaglavieto i podno`jeto mo`e{ da gi uredi{ po tvoja `elba. 
Mo`e{ da gi uredi{: fontot, goleminata na bukvite, bojata na 
bukvite, poramnuvaweto i s¢  drugo, isto kako vo obi~en tekst. 

 Vnesuvawe fusnota 

Za da vnese{ fusnota:

♦♦ prvo, postavi go kursorot vedna{ po zborot {to go objasnuva{;

♦♦ klikni na menito Vmetnuvawe;

♦♦ klikni na naredbata Fusnota. 

]e se otvori prozorecot Vmetnuvawe fusnota, vo koj:

♦♦ za ozna~uvawe na fusnotite mo`e{ da odbere{ broevi {to }e 
se zgolemuvaat avtomatski so sekoja nova fusnota ili mo`e{ 
da vnese{ znak vo poleto za znak. Vnesi „*“ i fusnotata }e 
bide ozna~ena so „*“;

♦♦ klikni na kop~eto Vo red.
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 Vnesuvawe komentari 

Za da vnese{ komentar:

♦♦ prvo, postavi go kursorot na zborot za koj }e napi{e{ komen-
tar;

♦♦ klikni na menito Vmetnuvawe;

♦♦ klikni na naredbata Bele{ka.

]e se otvori prozorec kade {to mo`e{ da vnese{ bele{ka: 

♦♦ napi{i ja bele{kata vo prostorot za tekst;

♦♦ klikni na kop~eto Vo red.

Pronao|awe i zamena na del od tekstot
 Pronao|awe del od tekstot 

Za da najde{ opredelen del od tekstot ili zbor:

♦♦ klikni na menito Ureduvawe;

♦♦ od nadolnoto meni odberi ja naredbata Najdi i zameni.

]e se otvori prozorecot Nao|awe i zamena:
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♦♦ vo poleto Prebaraj za napi{i go tekstot {to go bara{;

♦♦ klikni na kop~eto Najdi za da go najde{ tekstot na slednoto 
mesto, ili Najdi gi site & za da go najde{ tekstot na site 
mesta vo tekstot.

Zna~eweto na drugite kop~iwa i opcii:

♦♦ opcijata Razlikuvaj golemi i mali bukvi ozna~i ja toga{ 
koga }e saka{ Writer da gi razlikuva golemite od malite bukvi 
pri prebaruvaweto;

♦♦ opcijata Samo celi zborovi ozna~i ja toga{ koga }e saka{ da 
gi najde{ samo celite zborovi, a ne i delovi od drugi zborovi.

 Zamena na del od tekstot 

♦♦ Vo poleto Prebaraj za napi{i go zborot {to saka{ da go za-
meni{ so drug zbor;

♦♦ vo poleto Zameni so napi{i go zborot so {to saka{ da go za-
meni{ zborot vo poleto Prebaraj za;

♦♦ klikni na kop~eto Zameni ili na kop~eto Zameni gi site.



Ureduvawe 
tekst2

44	

Hipertekst
 Vnesuvawe i koristewe hipervrski 

♦♦ Ozna~i go zborot na koj saka{ da postavi{ hipervrska;

♦♦ klikni na menito Vmetnuvawe;

♦♦ odberi Hipervrska.

]e se otvori prozorecot Hipervrska: 

♦♦ klikni na ikonata Dokument;

♦♦ napi{i pateka do dokumentot; ili

♦♦ klikni na ikonata so folderot {to se nao|a desno od po-
leto Pateka za da go najde{ dokumentot do koj postavuva{
hipervrska;

♦♦ klikni na kop~eto Primeni.

Sega dadeniot zbor e hipervrska, toj e podvle~en i e so sina 
boja. Za da premine{ vo dokumentot do koj toj vodi, dr`i go pri-
tisnat tasterot Ctrl i klikni na vrskata.

Pe~atewe dokument
Krajnata cel e ureden i otpe~aten dokument. Dokolku saka{ 

da gi otpe~ati{ site stranici od dokumentot vo eden primer-
ok, dovolno e da klikne{ na alatkata  koja se nao|a na stan-
dardnata lenta, no pred toa dokumentot treba da go podgoti{ za 
pe~atewe, odnosno treba da gi opredeli{ formatot i polo`bata 
na stranicata, kako i nejzinite margini.

 Margini i polo`ba na stranicata 

Na linijarite mo`e{ da vidi{ sivi i beli povr{ini. Tekstot 
se vnesuva na belata povr{ina, a delot pod sivite povr{ini se 
narekuva margina. Vo marginite ne se pi{uva tekst, osven nekoi 
bele{ki i komentari.
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♦♦ klikni na menito Formatiraj;

♦♦ klikni na naredbata Stranica.

]e se otvori prozorec kako na slikava: 

♦♦ dokolku karti~kata Stranica ne e aktivna, klikni na nea;

♦♦ odberi Format na listot (naj~esto e toa formatot A4);

♦♦ odberi Orientacija i klikni na Portret za pi{uvawe po 
{irinata na listot, ili na Pejza` za pi{uvawe po dol`inata 
na listot;

♦♦ vo delot Margini vnesi vrednosti za site ~etiri margini: 
Leva, Desna, Gorna i Dolna;

♦♦ klikni na kop~eto Vo red.

 Pregled pred pe~ateweto 

♦♦ Povikaj ja naredbata Pregled na stranica od menito Dato-
teka. 

Dokumentot }e se prika`e so poinakov pregled. ]e se pojavi i 
nova lenta vo koja mo`e{ da menuva{ razli~ni prikazi (vedna{ 
pod glavnoto meni). Koga }e bide{ zadovolen/na, klikni na 
kop~eto Zatvori pregled za da go zatvori{ pregledot Pregled 
na stranica.

 Pe~atewe na dokumentot 

Koga }e bide{ podgotven/a za pe~atewe, povikaj ja naredbata 
Pe~ati od menito Datoteka. ]e se otvori prozorecot Pe~atewe.
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♦♦ Vo delot Pe~ata~, vo lentata Ime, odberi soodveten pe~ata~ 
(dokolku se instalirani pove}e pe~ata~i).

♦♦ Vo delot Opseg na pe~atewe napi{i gi broevite na strani-
cite {to saka{ da gi otpe~ati{. So zapirka oddeli gi bro-
evite, a stranicite {to se ednopodrugo zapi{i gi so crti~ka 
(na primer: 2, 5&8 zna~i deka }e se otpe~atat vtorata i site 
stranici od pettata do osmata). Dokolku saka{ da gi otpe- 
~ati{ site stranici, odberi ja opcijata Site stranici.

♦♦ Vo delot Kopii opredeli go brojot na kopiite.

♦♦ Klikni na kop~eto Vo red.
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	 Multimedijalni 
 prezentacii

So programata PowerPoint mo`e{ da iz-
raboti{ ubavi prezentacii

SODR@INA:

Poimot multimedijalna prezentacija

Microsoft PowerPoint

Izrabotuvawe prezentacija

Razli~ni pogledi na prezentacijata

Ureduvawe prazen slajd vo pogledot Normal

Animaciski i zvu~ni efekti

Postavuvawe hipervrska

Rabota so muzika i so videozapisi

Vremenski efekti
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Poimot multimedijalna prezentacija

Novi poimi:

multimedija, prezentacija, slajd, slajd-{ou, pregled na 
slajd, efekti na premin, animaciski efekti, zvu~ni efekti

Pod poimot prezentacija se podrazbira pretstavuvawe na 
nekoja ideja, rabota, proizvod, sostojba i sli~no & na po{irok 
krug lu|e. Naj~esto, toa se predavawa, reklami, izve{tai, pret-
stavuvawe na novi proizvodi, idei, rezultati itn.

So razvojot na informaciskite tehnologii e ovozmo`eno 
izrabotuvawe multimedijalni prezentacii, koi vo sebe so-
dr`at tekst, grafika, animacii, zvuk i videozapisi. So vmet-
nuvawe na ovie elementi tie stanuvaat atraktivni i di- 
nami~ni.

Multimedija pretstavuva prezentacija na podatoci, so 
kombinirawe na tekst, zvuk, slika, videosimulacii i 
fotografii. 

 Osnovni elementi na multimedijalnata prezentacija 

Prezentacijata se sostoi od slednive elementi:

♦♦ tekst,

♦♦ grafikon,

♦♦ slika,

♦♦ tabela,

♦♦ zvuk.

Elementite se vmetnuvaat na poedineni stranici, nare~eni 
slajdovi, koi se koristat za prika`uvawe na ekran, na yid 
ili na platno i pri prika`uvaweto se menuvaat naizmeni~no. 
Prika`uvaweto na prezentacijata se narekuva slajd-{ou (slide-
show).

 Pra{awa i zada~i: 

1.	 Objasni go poimot multimedija!

2.	 [to e prezentacija? [to e multimedijalna prezentacija?

3.	 Koi se osnovnite elementi na multimedijalnata prezen-
tacija? [to e slajd?

4.	 Kako treba da bidat organizirani elementite na slajdot za 
da bide uspe{na prezentacijata?

5.	 Kako se narekuva prika`uvaweto na prezentacijata?	

Zabele{ka:

Ponatamu vo  
tekstot paralelno  

}e gi koristime 
dvata termina: 

multimedijalna 
prezentacija i  
prezentacija.
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Microsoft PowerPoint
Microsoft PowerPoint e programa nameneta za izrabotka na mul-

timedijalni prezentacii. 

 Aktivirawe na programata PowerPoint 
Za da ja aktivira{ programata PowerPoint, klikni na Start i 

odberi Programs → Microsoft Office → PowerPoint ili dvapati 
klikni na ikonata PowerPoint .

PowerPoint }e se otvori vo normalen pogled (pogledot Normal). 
Rabotniot prostor sodr`i:

1	 Vo sredinata slajd {to treba go ureduva{.

2	 Od levata strana slajd-panel (Slide pane) vo koj se prika`ani 
slajdovite vo namalena forma. Vo slajd-panelot ima dva 
na~ina za prika`uvawe slajdovi: Slides i Outline.

3	 Panel za zada~i (Task pane) na desnata strana. Panelot za 
zada~i dobiva razli~ni imiwa i izgled vo zavisnost od 
zada~ata {to se izvr{uva vo momentot. Pri startuvaweto 
toa e panelot Getting Started od koj mo`e{ da otvori{ nekoja 
postojna prezentacija ili da kreira{ nova.

 Rabota so prezentacija 

PowerPoint e del od paketot MS Office, isto kako i Word. 
Na~inot na rabota vo dvete programi e sli~en i mnogu raboti 
{to si gi nau~il/a dosega }e mo`e{ da gi primenuva{ ponatamu.

1

3

2

Zabele{ka:

Prozorecot na 
PowerPoint gi 
soodr`i  
elementite na 
standarden  
prozorec.
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Proizvod na PowerPoint e prezentacijata, koja se za~uvuva na 
nadvore{nata memorija so nastavka .ppt i ima ikona kako na sli-
kava: 

Postapkite za otvorawe nova ili postojna prezentacija, za 
zatvorawe i za za~uvuvawe se izvr{uvaat sosema isto kako vo 
Word. Samo nakuso potseti se na naredbite:

♦♦ Otvorawe nova prezentacija	          	 File → New
♦♦ Otvorawe postojna prezentacija 		  File → Open
♦♦ Zatvorawe na prezentacijata		  File → Close
♦♦ Za~uvuvawe na prezentacijata	     	 File → Save as…

Ve{tini {to treba da gi usovr{i{!

♦♦ Da ja startuva{ aplikacijata PowerPoint.
♦♦ Da gi prepoznava{ elementite na prozorecot 

na PowerPoint (lenti, prostor za ureduvawe 
slajd, Slide pane,Task pane). 

♦♦ Da otvori{ nova i postojna prezentacija i da 
znae{ da ja za~uva{ prezentacijata.

Pra{awa i zada~i: 

1.	 Kako se startuva programata PowerPoint?
2.	 So koja nastavka se za~uvuvaat prezentaciite na nadvo-

re{nite memorii?

3.	 Koi elementi gi sodr`i rabotniot prostor na PowerPoint vo 
pogledot Normal? Objasni gi!
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Izrabotuvawe prezentacija
Sega mo`e{ da nau~i{ kako da kreira{ prezentacija. 

 Izrabotuvawe nova prezentacija 

Kako se izrabotuva prezentacija }e poka`eme preku primer. 
Sledi gi upatstvata za da ja izraboti{ tvojata prva prezent-
acija:

1	 Klikni na Create a new presentation vo pa-
nelot za zada~i Getting Started. Dokolku 
panelot ne e otvoren, povikaj go so nared-
bata File → New.

2	 Se otvori panelot New Presentation. Klik-
ni na Blank presentation za da kreira{ pre-
zentacija, po~nuvaj}i od prazna. Novite 
prezentacii dobivaat imiwa Presentation1, 
Presentation2 itn.

3	 Vo delot za panel za zada~i se otvori pane-
lot Slide Layout, koj sodr`i razli~ni pregle-
di na slajdovite. Slajdot na koj }e raboti{ 
ima pregled kako prviot slajd vo panelot. 
Pregledite }e gi objasnime podocna.

 Vnesuvawe i ureduvawe tekst 

Vo PowerPoint tekst mo`e da se vnese samo vo ramkata za tekst 
(Text Box). Nadvor od ramkata ne mo`e da se pi{uva.

Tvojot prv slajd sodr`i dve 
ramki za tekst: prvata e za naslov 
(title), a vtorata e za podnaslov 
(subtitle).

Klikni vo prvata ramka; }e 
se pojavi kursorot. Vnesi go tek-
stot „Mojata prva prezentacija“. 
Vo vtorata ramka vnesi gi tvoeto 
ime i tvoetro prezime. Koga }e go 
vnese{ tekstot, klikni nadvor od ramkata za tekst.

Mo`e{ da ja koristi{ lentata za formatirawe za da go ure-
di{ tekstot. Zabele`uva{ deka lentata e sli~na kako kaj Word.

1

2

3

Zabele{ka:

Nova prezenta-
cija mo`e{ da 
izraboti{ i preku 
{ablon, so pomo{ 
na vol{ebnikot 
ili od nekoja 
postojna prezen-
tacija.
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Ako saka{ da izbri{e{ nekoj tekst, primeni gi istite postap-
ki kako vo Word. Ozna~i go tekstot i pritisni go tasterot Delete, 
ili klikni vo tekstot i bri{i gi znacite so tasterite Delete ili 
Back Space.

Koga }e saka{ da uredi{ cel tekst vo 
edna ramka, dovolno e da ja selektira{ 
ramkata.

Odberi go fontot MAC C Swiss. Sega 
tvojot slajd izgleda vaka:

 Dodavawe slajd 

Nov slajd se dodava so naredbata Insert → New Slide, no posto-
jat i drugi na~ini: preku ikona, so desen klik od gluv~eto ili so 
tasterite Ctrl+M.

Za da dodade{ u{te eden slajd:

1	 klikni na ikonata New Slide, koja se 
nao|a vo lentata za formatirawe (po-
slednata desno) ; 

2	 noviot slajd sodr`i dve ramki za 
tekst: za naslov i za tekstot {to tre-
ba da bide ureden kako lista na znaci;

3	 vnesi naslov „Moite prijateli“, a vo 
vtorata ramka nabroj gi tvoite pri-
jateli. ]e dobie{ vakov slajd:

Vnimavaj!

Pri menuvaweto na fontot se menuva i oznakata za lista-
ta (bullet). Ozna~i go celiot tekst vo listata ili ozna~i 
ja ramkata i odberi drug simbol od prozorecot Bullets and 
Numbering, koj }e go povika{ so naredbata Format → Bullets 
and Numbering.

 Pregled na slajdot (Layout) 

Vreme e da se zapoznae{ so pregledot na slajdot. Pregledot 
pretstavuva raspored na elementite na eden slajd (tekst, slika, 
grafikon, tabela itn). Pregled mo`e{ da odbere{ od panelot 
Slide Layout, koj se povikuva so naredbata Format → Slide Layout.

2

3
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Sega, napravi tret slajd vo koj }e napi{e{ ne{to za sebe i }e 
vmetne{ svoja slika. Najprvo dodadi u{te eden slajd (so nared-
bata New Slide). Mo`e{ da zabele`i{ deka na slajdot povtorno 
ima dve ramki za tekst, no tebe ti treba i prostor za slika.

1	 Dokolku vo panelot za zada~i ne e otvoren panelot Slide Lay-
out, povikaj go so naredbata Format → Slide Layout.

2	 Pogledni gi pregledite. So kliknuvawe odberi pregled {to 
sodr`i naslov, tekst i slika (Title, Text, and Content).

3	 Tvojot slajd dobi poinakov izgled. Vnesi naslov „Ova sum jas“, 
a vo ramkata za tekst napi{i ne{to za sebe. 

4	 Vo ramkata za sliki i drugi sodr`ini vmetni tvoja slika (koja 
prethodno si ja za~uval/a na diskot). Vo ramkata klikni na 
ikonata  (Insert Picture). Ponatamu, postapkata e ista kako 
vo Word: koga }e se otvori prozorecot Insert Picture, pobaraj ja 
tvojata slika na diskot, selektiraj ja i potvrdi na kop~eto 
Insert.
Na ist na~in mo`e{ da vmetne{ tabela, grafik, Clip Art, 

grafikon i videoinsert & samo treba da ja odbere{ vistinskata 
ikona.

Za~uvaj ja prezentacijata vo tvojot folder so imeto „Mojata 
prva prezentacija“ so naredbata File → Save.

 Dizajnirawe slajd 

Tvojata prva prezentacija e izrabotena. Sega mo`e{ da ja ure-
di{ i da ja napravi{ pointeresna. Najprvin dizajniraj gi slajdo-
vite; vo PowerPoint postoi golem izbor na gotovi dizajni.

1	 Povikaj ja naredbata Format → Slide Design.

2	 Od panelot Slide Design odberi eden dizajn i klikni na nego. 

1

3

2

4

Niz panelot za 
slajdovi mo`e{ 
da se dvi`i{ so 
pomo{ na lentite 
za dvi`ewe.

Zabele{ka:

Mo`e{ da koris-
ti{ ist pregled 
za pove}e slaj-
dovi. Selektiraj 
pove}e slajdovi, 
na sakaniot 
pregled klikni na 
kop~eto so nadol-
nata strelka i vo 
listata {to }e se 
pojavi klikni na 
Apply to Selected 
Slides.
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Site slajdovi }e imaat ist dizajn.

     

Na prviot slajd }e primeni{ eden poinakov dizajn.

3	 Selektiraj go prviot slajd, odberi drug dizajn, pozicioni-
raj se so gluv~eto vrz nego i klikni na kop~eto so nadolnata 
strelka {to }e se pojavi od desnata strana. Vo listata {to  
}e se pojavi klikni na Apply to Selected Slides.

Za~uvaj ja prezentacijata pod imeto „Prva prezentacija“.

 Aktivirawe na prezentacijata 

Aktiviraj ja prezentacijata so naredbata Slide Show → View  
Slide Show. Prviot slajd }e se prika`e na celiot ekran.

Upravuvawe so prezentacijata 

Na sledniot slajd mo`e{ da premine{ na eden od slednive 
na~ini:

♦♦ pritisni go tasterot so strelka kon desno;

♦♦ pritisni go tasterot Enter; 
♦♦ pritisni go tasterot Page Down;

♦♦ klikni so gluv~eto.

Na prethodniot slajd mo`e{ da se vrati{ na eden od sled-
nive na~ini:

♦♦ pritisni go tasterot so strelka kon levo;

♦♦ pritisni go tasterot Back Space; 

♦♦ pritisni go tasterot Page Up.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da odbere{ pregled na slajdot.

♦♦ Da napi{e{ tekst i da vmetne{ slika vo slajdot.

♦♦ Da vmetne{ nov slajd (Insert → New Slide).

♦♦ Da primeni{ dizajn na slajdot od panelot Slide 
Design.

♦♦ Da znae{ da ja aktivira{ i da upravuva{ so 
prezentacijata.

32

Zabele{ka:

Prezentacijata 
mo`e{ da ja  

aktivira{ i so 
tasterot F5
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Pra{awa i zada~i: 

1.	 Objasni ja postapkata za izrabotuvawe nova prezentacija!

2.	 Kako se vnesuva tekst vo prezentacijata?

3.	 So koja naredba mo`e{ da dodade{ nov slajd?

4.	 [to pretstavuva pregled na slajdot?

5.	 Od koj panel mo`e{ da odbere{ pregled na slajdot?

6.	 Kako se aktivira prezentacijata?

7.	 Na koi na~ini mo`e{ da premine{ na sledniot, odnosno na 
prethoden slajd pri prika`uvawe na prezentacijata?

8.	 Kako }e go prekine{ prika`uvaweto na prezentacijata?

9.	  Izraboti prezentacija:

♦♦ na prviot slajd napi{i naslov;

♦♦ na vtoriot slajd napi{i ne{to za sebe;

♦♦ vmetni slika na vtoriot slajd;

♦♦ na tretiot slajd pretstavi go tvoeto u~ili{te;

♦♦ na ~etvrtiot slajd nabroj gi tvoite prijateli (od panelot 
Slide Layout odberi pregled Title and Text);

♦♦ za~uvaj ja prezentacijata pod imeto Toa sum jas;

♦♦ pogledni ja prezentacijata.

Razli~ni pogledi na prezentacijata
Vo PowerPoint postojat tri vida pogledi: Normal, Slide Sorter i 

Slide Show. Od eden na drug mo`e{ da premine{ na dva na~ina:

♦♦ preku menito View;

♦♦ preku ikonite {to se nao|aat na dnoto na panelot za slajdovi 
(dolu levo na ekranot) .

Pogledot Normal
PowerPoint se aktivira vo pogledot Normal so koj si rabotel/a 

dosega. Vo centralniot del e slajdot {to go ureduva{, a levo se 
site slajdovi vo namalena forma. Podocna }e nau~i{ kako da 
uredi{ prazen slajd.

Pogledot Slide Show
Prezentacijata se prika`uva vo pogledot Slide Show. 

Pogledot Slide Sorter
Pogledot Slide Sorter ti ovozmo`uva da gi vidi{ site slaj-

dovi so namalen oblik i da manipulira{ so niv (vmetnuvawe, 
bri{ewe, kopirawe, prenesuvawe...). Sekako deka toa mo`e{ da 
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go napravi{ i vo pogledot Normal, no toga{ koga tvojata prezen-
tacija }e ima mnogu slajdovi, polesno }e raboti{ so ovoj pogled. 

 Rabota so slajdovi 

Otvori ja prezentacijata „Prva prezentacija“ i premini na pog-
ledot Slide Sorter.

Vmetnuvawe slajd

Nov slajd se vmetnuva me|u drugite slajdovi so naredbata New 
Slide (od menito Insert).

1	 Pozicioniraj se me-
|u prviot i vtoriot 
slajd.

2	 Klikni so desnoto 
kop~e od gluv~eto 
i od menito odberi 
New Slide.

»» Noviot slajd neka bide so naslov „Moeto semejstvo“ i nabroj 
gi ~lenovite na tvoeto semejstvo.

Kopirawe i prenesuvawe slajdovi

Slajd se prenesuva so naredbite Cut i Paste, a se kopira 
so naredbite Copy i Paste (od menito Edit). Operaciite kopi-
rawe i prenesuvawe se isti kako kaj site drugi aplikacii. 
Kako i za site drugi naredbi, taka i ovde postojat pove}e 
na~ini, no najlesno e so tehnikata „povle~i i pu{ti“ (Drag and 
Drop). Sledi gi upatstvata.

Prenesuvawe slajd

1	 Klikni na posledniot slajd.

2	 So pritisnato kop~e od gluv~eto dvi`i se do mestoto me|u 
prviot i vtoriot slajd.

3	 Otpu{ti go kop~eto.

4	 Sega posledniot slajd e vtor.

2

1

Zabele{ka:

Za da uredi{ 
slajd, treba da 

se vrati{ vo 
pogledot Normal. 
Klikni dvapati  

na slajdot {to 
saka{ da go  

uredi{.



Multimedijalni 
prezentacii 3

57	

Kopirawe slajd

1	 Klikni na prviot slajd.

2	 Dr`i go pritisnat tasterot Ctrl.
3	 So pritisnato kop~e od gluv~eto dvi`i se do mestoto po pos-

ledniot slajd.

4	 Otpu{ti gi kop~eto i tasterot Ctrl.
5	 Prviot i posledniot slajd se isti.

Bri{ewe slajd

Slajd se bri{e so naredbata Delete Slide (od menito Edit).
1	 So desnoto kop~e od gluv~eto klikni na posledniot slajd. 

2	 Od menito odberi Delete Slide.

»» Za~uvaj ja prezentacijata.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da premine{ od eden vo drug pogled na slajdovi.

♦♦ Da vmetne{ slajd (Insert → New Slide).

♦♦ Da kopira{ i da prenese{ slajd (Copy, Cut, Paste).

♦♦ Da izbri{e{ slajd (Edit → Delete Slide).

Pra{awa i zada~i: 

1.	 Koi vidovi pogledi postojat vo PowerPoint? Objasni gi!

2.	 Kako }e premine{ od eden vo drug pogled?

3.	 Kako }e prenese{ i kopira{ slajdovi? Vo koj pogled }e go 
napravi{ toa najlesno? 

4.	 Kako }e izbri{e{ slajd?

Ureduvawe prazen slajd vo pogledot Normal 
Dokolku niedna od dadenite {emi ne ti odgovara za slajd, 

mo`e{ da izbere{ prazen slajd (Blank Slide) od panelot Slide 
Layout i da go uredi{ po tvoja `elba. Vo nego mo`e{ da vmetne{ 
ramka za tekst, slika, umetni~ki tekst, drug grafi~ki element.

Grafi~ki elementi se vnesuvaat vo prezentacijata na istiot 
na~in kako vo Word, preku naredbite od menito Insert ili preku 
alatkite od lentata za crtawe (Drawing). 
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Lentata so alatki za crtawe

Na dnoto na ekranot se nao|a lentata so alatki za crtawe: 

♦♦ Vo prviot del se alatkite za manipulacija so grafi~ki ele-
menti. 

♦♦ Vo vtoriot del se alatkite za vmetnuvawe grafi~ki ele-
menti: gotovi oblici, prava linija, strelka, pravoagolnik, 
elipsa, ramka za tekst, umetni~ki tekst, grafikon, sliki od 
galerijata Clip Art, sliki od nadvore{nite memorii.

♦♦ Vo tretiot del se alatkite za ureduvawe grafi~ki elementi: 
popolnuvawe so boja, boja na liniite, boja na bukvite, debe-
lina na liniite, stil na liniite, stil na strelkite, senki, 
3D-efekti.

 Crtawe ramka za tekst  (Text Box) 
Ve}e znae{ deka tekst mo`e{ da pi{uva{ samo vo ramkata za 

tekst. Sledi gi upatstvata za da nacrta{ ramka za tekst:

1	 klikni na alatkata  (Text Box);

2	 klikni so gluv~eto vo slajdot, dr`i go pritisnato levoto 
kop~e, povle~i do sakanata {irina i otpu{ti go kop~eto (vi-
sinata e sekoga{ eden red).

 Crtawe gotovi grafi~ki oblici (AutoShapes) 

1	 Klikni na nadolnata strelka desno od 
alatkata AutoShapes .

2	 Od nekoe od dopolnitelnite menija od-
beri eden od ponudenite grafi~ki oblici.

Se crta isto kako {to se crta ramka za 
tekst.

Vmetnuvawe tekst vo grafi~ki oblik

Vo nekoi od grafi~kite oblici mo`e{ da vmetne{ tekst. 

1	 Klikni na oblikot so desnoto kop~e 
od gluv~eto. 

2	 Od dobienoto meni odberi Add Text; 
vo oblikot }e se pojavi kursorot.

2

1

1
2
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 Vnesuvawe sliki od diskot 

1	 Povikaj ja naredbata Insert → Picture → From File ili klikni 
na ikonata Insert Picture ;

2	 najdi ja slikata vo tvojot folder i selektiraj ja slikata;

3	 klikni na kop~eto Insert; slikata }e se pojavi vo slajdot.

 Vnesuvawe sliki od galerijata Clip Art 
1	 Povikaj ja naredbata Insert → Picture → Clip Art ili klikni na 

ikonata Insert Clip Art  .

2	 Vo panelot Clip Art klikni na Go.

3	 Odberi edna od sliki~kite i klikni 
na nea. Na toj na~in }e ja vnese{ vo 
prezentacijata. 

 Ureduvawe grafi~ki objekti 

Klikni na objektot. Okolu nego }e se pojavat 
alatkite za menuvawe na dimenzijata (belite 
kruk~iwa) i za rotirawe (zelenoto kruk~e).

3

2

2

3

Zabele{ka: 

Dokolku znae{ 
kakva slika bara{, 
vnesi go opisot vo 
poleto Search for i 
klikni na kop~eto 
Go.
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Pomestuvawe

Klikni na objektot, dr`i go levoto 
kop~e od gluv~eto i povle~i go objek-
tot do novoto mesto.

Promena na dimenziite

Klikni na edno od osumte kruk~iwa, 
dr`i go levoto kop~e od gluv~eto i 
povle~i do potrebnata golemina.

Rotirawe

Klikni na zelenata ra~ka i zarotiraj 
go objektot.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da nacrta{ ramka za tekst i da vnese{ tekst vo nea.

♦♦ Da odbere{ i da nacrta{ nekoj od gotovite grafi~ki 
elementi.

♦♦ Da vmetne{ tekst vo grafi~ki objekt (Add Text).

♦♦ Da vmetne{ slika od disk i od galerijata Clip Art (In-
sert → Picture).

♦♦ Da uredi{ grafi~ki element (da go pomesti{, da go 
rotira{, da mu gi smeni{ dimenziite).

Pra{awa i zada~i: 

1.	 Koi vidovi pogledi postojat vo PowerPoint? Objasni gi.

2.	 Kako }e premine{ od eden vo drug pogled?

3.	 Kako }e prenese{ i kopira{ slajdovi? Vo koj pogled }e go 
napravi{ toa najlesno? 

4.	 Kako }e izbri{e{ slajd?

5.	 So pomo{ na koja lenta najlesno }e vmetne{ grafi~ki ob-
jekti (ramka za tekst, slika i sli~no) vo nekoj slajd?

6.	 Kako najlesno }e uredi{ grafi~ki objekt?

7.	  Otvori ja prezentacijata od prethodnata ve`ba i:

♦♦ na krajot dodaj u{te eden slajd vo koj }e napi{e{ koi se 
tvoite interesi;

♦♦ dizajniraj go slajdot po `elba i vmetni tekst, slika i 
umetni~ki tekst (Word Art);

♦♦ premini vo pogledot Slide Sorter;
♦♦ stavi go noviot slajd po vtoriot;
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♦♦ prika`i ja prezentacijata;

♦♦ dvi`i se niz slajdovite napred i nazad;

♦♦ vrati se vo pogledot Normal;
♦♦ za~uvaj ja prezentacijata.

8.	  Izraboti prezentacija kako vo primerot:

♦♦ Vmetni pove}e slajdovi.

♦♦ Za~uvaj ja prezentacijata pod imeto Pod moreto.

Za nadarenite u~enici

1.	 Kreiraj gi slednive slajdovi:

Pobaraj pomo{ od nastavnikot. Grafikonot mora da soodvet-
stvuva so tabelata. 
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Animaciski i zvu~ni efekti
Tvojata prva prezentacija e izrabotena, no tekstot e stati~en, 

slikite ne se pomestuvaat, nema zvuk... Ne mo`eme da ja nare~eme 
multimedijalna. ]e ja napravi{ dinami~na so postavuvawe 
efekti za preminuvawe od eden slajd na drug (tranzicija) i so 
animacii na objektite. ]e ti poka`eme i }e ti objasnime kako da 
go napravi{ toa, no ovoj pat kreativnosta ti ja prepu{tame na 
tebe. Eksperimentiraj i izberi go ona {to ti se dopa|a najmnogu.

 Preminuvawe od eden na drug slajd 

Koga prika`uva{ nekoja prezentacija vo Slide Show, preminu-
va{ od eden slajd na drug. Mo`e{ da postavi{ razli~ni efekti 
na preminuvawe: so trepkawe, so vleguvawe od razli~ni strani, 
so pojavuvawe preku oblici i sli~no.

1	 Otvori go panelot Slide Transition so nared-
bata Slide Show → Slide Transition. 

2	 Klikni na eden od preminite vo listata.  
Vedna{ }e go zabele`i{ efektot.

3	 Opredeli ja brzinata (Speed): bavno (Slow), 
sredno (Medium) ili brzo (Fast).

4	 Od listata Sound odberi eden od mnogute 
zvu~ni efekti.

 Animirawe objekti vo slajdovite 

Za u{te pogolema dinami~nost mo`e{ da animira{ i objek-
ti. Objektite se animiraat eden po eden zaradi podobra orga-
nizacija i za da bide prezentacijata pointeresna.

1	 Ozna~i go objektot na koj saka{ da primeni{ animacija.

2	 Otvori go panelot Custom Animation so naredbata Slide Show 
→ Custom Animation.

3	 Klikni na kop~eto Add Effect.
4	 Od listata odberi edna od opciite: 

&& Entrance za da se pojavi objektot; 

&& Emphasis za istaknuvawe na objektot; 

&& Exit za da is~ezne objektot; 

&& So Motion Paths se opredeluva nasokata na dvi`ewe.

5	 Odberi edna od animaciite.

6	 ]e se pojavi broj~e do objektot.

7	 Klikni na kop~eto Play za da go vidi{ efektot.

2

1

3
4
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Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ efekti na preminuvawe (Slide Show → 
Slide Transition).

♦♦ Da postavi{ animacii na objektite (Slide Show → 
Custom Animation).

Pra{awa i zada~i: 

1.	 Dali mo`e{ da vmetne{ efekti na animacija vo prezen-
tacijata? Koi?

2.	 Objasni ja postapkata za postavuvawe na efektot na tran-
zicija (preminuvawe od eden do drug slajd).

3.	 Dali animaciskite efekti mo`at da bidat pridru`eni so 
zvu~ni efekti? Kako }e postavi{ zvu~ni efekti?

4.	 Dali mo`e{ da ja odbere{ brzinata na animaciskite efek-
ti? Kako?

5.	  Otvori ja prezentacijata Toa sum jas:

♦♦ otvori go panelot Slide Transition;

♦♦ pred da go izbere{ na~inot na preminuvawe, razgledaj gi 
ponudenite na~ini i proveri dali e potvrdena opcijata 

5

1

7

2

4

6

3
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AutoPreview; ako ne e & potvrdi ja. Odberi eden od premi-
nite;

♦♦ od lentata Speed odberi edna od brzinite: Slow (bavno), 
Medium (sredno) ili Fast (brzo);

♦♦ primeni efekt na animacija na nekolku objekti; neka bi-
dat toa razli~ni vidovi animacii;

♦♦ opredeli gi patot i brzinata na animacijata i proveri so 
kop~eto Play;

♦♦ prika`i ja prezentacijata i vrati se vo pogledot Normal;
♦♦ za~uvaj ja prezentacijata.

6.	 Vo prezentacijata Pod moreto postavi efekti taka {to 
`ivotnite vo moreto da se dvi`at.

7.	 Sega mo`e{ da pravi{ interesni prezentacii. Napra-
vi prezentacija za proslavata na patronatot vo tvoeto 
u~ili{te, za nekoja realizirana ekskurzija, za nekoe tvoe 
patuvawe i sli~no. 

Postavuvawe hipervrska
I vo prezentacijata mo`e{ da vmetne{ hipervrski do 

drugi dokumenti ili do drugi slajdovi. Na toj na~in }e do-
bie{ podobra kontrola vrz tekot na prezentacijata. Ve}e si 
nau~il/a vo Word kako da vmetne{ vrska do drug objekt. Sega 
}e nau~i{ kako da vmetne{ vrska do drug slajd vo ista prezen-
tacija.

 Postavuvawe vrska do slajd vo ista prezentacija 

»» Izraboti prezentacija na sledniov na~in: na prviot slajd 
navedi gi site planeti, a na drugite slajdovi vmetni po edna 
slika za sekoja planeta. Potoa:

1	 ozna~i go objektot (vo primerot toa 
e tekst) {to }e pretstavuva hipervr-
ska;

2	 povikaj ja naredbata Insert → Hyper-
link;

3	 vo sledniot prozorec klik-
ni na ikonata Place in This 
Document (mesto vo ovoj do-
kument);

4	 klikni na soodveten slajd;

5	 klikni na kop~eto OK. 

2
1

3
4

5
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Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ hipervrska do odreden slajd (Insert → 
Hyperlink).

Pra{awa i zada~i: 

1.	 Dali mo`e{ da postavi{ hipervrska vo prezentacijata? 
Kako?

2.	 Osven tekstot, dali i nekoi drugi elementi na prezentaci-
jata mo`at da pretstavuvaat hipervska?

3.	  Izraboti nova prezentacija za Son~eviot sistem:

♦♦ na prviot slajd nabroj gi site planeti; 

♦♦ na slednite slajdovi: vmetni sliki od planetite (po eden 
slajd za sekoja planeta) i po edna re~enica za sekoja od 
planetite;

♦♦ na prviot slajd: postavi hipervrski za site planeti do 
soodvetnite slajdovi;

♦♦  ne zaboravaj na drugite slajdovi da postavi{ hipervrska 
za vra}awe kon po~etniot slajd; 

♦♦ na prviot slajd: postavi muzika po tvoja `elba {to }e se 
pu{ta avtomatski;

♦♦ uredi ja prezentacijata po `elba i za~uvaj ja.

4.	 Na sli~en na~in napravi prezentacii za: 

♦♦ rimskata mitologija; 

♦♦ za vidovite ~etiriagolnici; 

♦♦ za glavnite likovi vo nekoja od lektirite; 

♦♦ za muzi~kite instrumenti; 

♦♦ za vidovite bilki i za vidovite `ivotni itn. 

Za talentiranite u~enici

1.	 Obidi se da napravi{ test za nekoja lekcija. Eden od po-
nudenite odgovori treba da bide to~en i toj treba da e vr-
ska do slajdot so slednoto pra{awe. Neto~nite odgovori 
treba da bidat vrska do slajdot so istoto pra{awe. Mo`e{ 
i da vmetne{ slajdovi na koi }e pi{uva dali odgovorot e 
to~en ili ne & po sekoe pra{awe. Zamoli go nastavnikot da 
ti pomogne.
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Rabota so muzika i so videozapisi
Vo tvojata prezentacija ve}e si rabotel/a so zvu~ni efekti 

pri sreduvaweto na preminuvaweto i na animacijata. No, mo`e{ 
da postavi{ i zvuk (muzika, pesna, govor...) ili videozapisi po 
tvoj izbor, od diskot ili od galerijata na PowerPoint (Clip Orga-
nizer). ]e objasnime kako se postavuva zvuk (Sound) od diskot, a 
na istiot na~in se postavuva i videozapis (Movie). So galerijata 
na zvuci i videozapisi se raboti na istiot na~in kako so galeri-
jata na sliki.

 Postavuvawe zvuk od diskot 

1	 Povikaj ja naredbata In-
sert → Movies and Sounds.

2	 Od dopolnitelnata lista 
odberi Sound from File.

3	 Vo prozorecot Insert So-
und ozna~i ja sakanata 
pesna.

4	 Klikni na kop~eto OK. 

5	 Vo sledniot prozorec odberi edna od opciite:

Automatically dokolku saka{ muzikata 
da se vklu~i vedna{ po aktiviraweto na 
prezentacijata;

When Clicked dokolku saka{ muzikata da se vklu~i koga }e 
klikne{ na ikonata  & koja }e se pojavi  vo slajdot.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da postavi{ zvuk vo prezentacijata (Insert → Movies and 
Sounds).

Pra{awa i zada~i: 

1.	 So koja naredba mo`e{ da vmetne{ zvu~ni zapisi vo prezen-
tacijata?

2.	 Dali mo`e{ da vmetne{ i videozapis vo prezentacijata? 
Kako?

3.	 Napravi prezentacija za ubavinite na Makedonija. Kako 
muzi~ki zapis vmetni nekoja od starite makedonski pesni, 
po tvoj izbor. Obidi se na Internet da najde{ i soodveten 
videozapis, pa i nego vmetni go vo prezentacijata.

3

4

5

Vnimavaj! 

Dokolku vo  
prezentacijata 
ima{ zvuk ili 

videozapis, koga 
}e ja prenesuva{ 

prezentacijata na 
drug kompjuter, }e 

mora{ da gi  
prenese{ i zvukot 
ili videozapisot. 

Tie ne se vmetnati 
vo prezentacijata, 

tuku se posebni 
datoteki na diskot 

do koi e  posta- 
vena  hipervrska-
ta. Najdobro e da 

gi za~uva{ vo ista  
papka so prezenta-

cijata.
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Vremenski efekti
Obi~no, prezentacijata se upravuva so gluv~eto ili so tas-

taturata, no poiskusnite prezenteri svojata prezentacija vre-
menski ja usoglasuvaat so svoeto izlagawe. Dosega u~e{e kako 
da ja opredeli{ brzinata na animacijata pri preminuvaweto od 
eden na drug slajd i brzinata na animacijata za sekoj objekt vo 
prezentacijata. Sega }e nau~i{ kako da go opredeli{ vremeto na 
premin me|u slajdovite (kolku }e se prika`uva eden slajd pred 
da se pojavi drug slajd) i da gi opredeli{ na~inot i redosledot 
po koi }e se izvr{uvaat animaciite {to se postaveni na objek-
tite vo eden slajd.

 Vreme na premin me|u slajdovite 

Za da go opredeli{ vremeto za prika`uvawe na eden slajd 
pred da se pojavi drug:

1	 vo panelot Slide Transition, vo delot 
Advance slide, potvrdi ja opcijata Au-
tomatically after (avtomatski po);

2	 vo lentata {to se nao|a podolu napi{i go brojot na sekundite. 

Dokolku saka{ ova doteruvawe da go primeni{ za site slaj-
dovi, klikni na kop~eto Apply to All Slides, no podobro e da go 
opredeli{ vremeto za sekoj slajd posebno, vo zavisnost od nego-
vata sodr`ina.

Preporaka: izmeri go vremeto {to ti e potrebno za izlagawe 
na sodr`inata na opredelen slajd. Ostavi malku pove}e vreme 
za da ne se slu~i slajdot prebrzo da se smeni. No, vo slu~aj da si 
predvidel/a premnogu vreme, potvrdi ja i opcijata On mouse click 
(na klik od gluv~eto), taka {to }e mo`e{ da reagira{ dokolku 
slajdot se prika`uva predolgo.

 Redosled na animaciite na slajdot 

Na eden slajd ima pove}e animacii {to se postaveni na raz-
li~ni objekti. Isto taka, i na eden objekt mo`at da se postavat 
pove}e animacii. Va`no e tie da se izvr{uvaat po redosledot 
{to odgovara na izlagaweto.

 Ureduvawe na animaciite na slajdot 

Sekoja animacija e ozna~ena so broj do objektot na koj se odne-
suva; pod toj reden broj se pojavuva na listata vo panelot Custom 
Animation, zaedno so imeto na objektot. Yvezdi~kite {to stojat 
do imeto go ozna~uvaat vidot na animacijata.

1	 Prvo, ozna~i ja animacijata.

2	 Mo`e{ da ja otstrani{ so kop~eto Remove.

1
2
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3	 Ili: da ja smeni{ so kop~eto Change.

4	 So strelkite Re-Order }e go smeni{ redosledot na 
izvr{uvaweto na animaciite.

Za sekoja animacija dopolnitelno mo`e{ da go opredeli{ 
na~inot na izvr{uvawe:

5	 Od listata Start vremeto na pojavuvaweto.

6	 Od listata Direction nasokata.

7	 Od listata Speed brzinata.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da go postavi{ vremeto na premin me|u slajdovi vo 
prezentacijata (Automatically after).

♦♦ Da otstrani{ nekoja animacija (Remove). 

♦♦ Da smeni{ nekoja animacija (Change).

♦♦ Da go smeni{ redosledot na animaciite (Re-Order).
♦♦ Da go opredeli{ vremeto na pojavuvaweto (Start), na-

sokata (Direction) i brzinata (Speed) na animacija.

Pra{awa i zada~i: 

1.	 Kako }e go opredeli{ vremeto na premin me|u slajdovite?

2.	 Kako }e otstrani{ nekoja animacija?

3.	 Dali mo`e{ da go smeni{ redosledot na animaciite? Kako?

4.	 Napravi prezentacija za delovite na kompjuterot. Na eden 
slajd nacrtaj gi delovite na kompjuterot koi }e vleguvaat 

7

2

1

5
6

3

4



Multimedijalni 
prezentacii 3

69	

vo slajd so eden, a }e izleguvaat od slajd po obraten re-
dosled.

5.	 Napravi prezentacija {to }e pretstavuva ~asovnik koj gi 
odbrojuva sekundite nanazad & od 60 do 1. Na sekoj slajd 
neka pi{uva: Imate u{te x sekundi (x e broj od 60 do 1). 
Slajdovite treba da se menuvaat za 1 sekunda. Dodaj zvu~en 
efekt na ot~ukuvawe na sekundite.

6.	 Podobri gi tvoite prezentacii so vremenski efekti.
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Proveri {to si nau~il/a!

1.	 Elementite na multimedijalnata 
prezentacija se vmetnuvaat na:

	 a. grafikoni

	 b. slajdovi

	 v. dizajni

2.	 Panelot za zada~i e prika`an:

	 a. vo sredinata na ekranot

	 b. na desnata strana

	 v. na levata strana

3.	 Nov slajd mo`e{ da vmetne{ so 
naredbata:

	 a. Format → New Slide

	 b. Insert → New Slide

	 v. Insert → Slide

4.	 Pregled na slajdot pretstavuva:

	 a. ureduvawe na zadninata na slajdot

	 b. pogled na slajdot

	 v. raspored na elementite na slajdot

5.	 Pregled na slajdot }e odbere{ vo 
panelot:

	 a. Slide Design

	 b. Slide Layout

	 v. Slide Transition

6.	 Dizajn na slajdot:

	 a. mora da se primeni na site slajdovi

	 b. mo`e da se primeni na slajdovi po iz-
bor

7.	 Prezentacijata se prika`uva vo 
pogledot:

	 a. Normal

	 b. Slide Sorter

	 v. Slide-Show

8.	 Pogledot Slide Sorter e soodveten 
za:

	 a. rabota so pove}e slajdovi

	 b. ureduvawe na eden slajd

	 v. prika`uvawe na prezentacijata

9.	 Vo slajdot:

	 a. mo`e da se vmetne slika od diskot

	 b. ne mo`e da se vmetne slika od diskot

10.	 Preku panelot Slide Transition }e go 
odbere{:

	 a. na~inot na preminuvawe od eden na 
drug slajd

	 b. na~inot na dvi`ewe na objektite vo 
slajdot

	 v. dizajnot na slajdot

11.	 Brzinata na preminuvawe od eden 
na drug slajd:

	 a. mo`e da se opredeli

	 b. ne mo`e da se opredeli

12.	 Animacija na objekt vo slajdot }e 
uredi{ vo panelot:

	 a. Custom Animation

	 b. Custom Effect

	 v. Play Animation
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OpenOffice.org Impress
OpenOffice.org Impress (ili samo Impress) e programa koja e 

nameneta za izrabotka na multimedijalni prezentacii. 

 Aktivirawe na programata OpenOff ice.org Impress 

Za da ja aktivira{ programata Impress vo operativniot sistem 
Edubuntu, klikni na Aplikacii, potoa na Kancelariski i od-
beri OpenOffice.org  Impress.

Impress }e se otvori vo  pogledot Normalen. Na ekranot }e vidi{:

1.	 Vo sredinata slajd {to treba da go uredi{.

2.	 Od desnata strana slajd-panelot Slajdovi vo koj se 
prika`ani slajdovite vo namalena forma. 

3.	 Panel za zada~i na levata strana. Panelot za zada~i se 
sostoi od pove}e paneli so koi }e se zapoznae{ vo tekot na 
rabotata. Pri startuvaweto se gleda panelot Rasporedi.

Rabota so prezentacija

Impress e del od paketot OpenOffice, isto kako i Writer. Na~inot 
na rabota vo dvete programi e sli~en i mnogu raboti {to si gi 
nau~il/a dosega }e mo`e{ da gi primenuva{ ponatamu.

Proizvod na Impress e prezentacijata koja se za~uvuva na 
nadvore{nata memorija so nastavkata .odp. 

Postapkite za otvorawe nova ili postojna prezentacija, za za-
tvorawe i za za~uvuvawe & se izvr{uvaat sosema isto kako vo 
Writer. Samo nakuso potseti se na naredbite:

♦♦ Otvorawe nova prezentacija	        	 Datoteka → Nov

♦♦ Otvorawe postojna prezentacija     	 Datoteka → Otvori

1

3

2
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♦♦ Zatvorawe na prezentacijata	        	 Datoteka → Zatvori

♦♦ Za~uvuvawe na prezentacijata	      	 Datoteka → Za~uvaj

Izrabotuvawe na prezentacija
 Vnesuvawe i ureduvawe tekst 

Za da vnese{ tekst:

♦♦ klikni na alatkata Tekst;

♦♦ klikni vo slajdot na mestoto kade saka{ da vnese{ tekst;

♦♦ od lentata za formatirawe odberi font i golemina na  
fontot. Mo`e{ da ja koristi{ lentata za formatirawe za da 
go uredi{ tekstot. Zabele`uva{ deka lentata e sli~na kako 
kaj Writer;

♦♦ napi{i go tekstot.

Dodavawe slajd

Nov slajd se dodava so naredbata Vmetnuvawe → Slajd, ili 
preku ikonata Slajd.

Za da dodade{ u{te eden slajd:

♦♦ klikni na ikonata Slajd, koja se nao|a vo lentata za formati-
rawe. 
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 Pregled na slajdot 

Pregled }e odbere{ od panelot Raspored (od levata strana). 
Od panelot Raspored odberi soodveten pregled.

Slajd so listi

Vo panelot Rasporedi klikni na pregledot Naslov i tekst. 
Po vnesuvaweto na tekstot, slajdot }e ima vakov izgled:

Slajd so slika

Vo panelot Rasporedi klikni na pregledot Naslov, ilus-
tracija, tekst. Slajdot go ima ovoj izgled:

 Aktivirawe na prezentacijata 

Aktiviraj ja prezentacijata so naredbata Slajd-{ou → Slajd-
{ou, ili so tasterot F5. No, pred toa, bidi siguren/na deka 
si pozicioniran/a na prviot slajd vo prezentacijata; inaku, 
prika`uvaweto }e zapo~ne od slajdot na koj si pozicioniran/a. 
Prviot slajd }e se prika`e na celiot ekran.

 Upravuvawe so prezentacijata 

Na sledniot slajd mo`e{ da premine{ na eden od slednive 
na~ini:
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&& pritisni go tasterot so strelka kon desno;

&& pritisni go tasterot Enter;
&& pritisni go tasterot Page Down;

&& klikni so gluv~eto.

Na prethodniot slajd mo`e{ da se vrati{ na eden od sled-
nive na~ini:

&& pritisni go tasterot so strelka kon levo;

&& pritisni go tasterot Back Space;

&& pritisni go tasterot Page Up.

Prika`uvaweto na slajdovite mo`e{ da go prekine{ so tast-
erot Esc i da se vrati{ vo prethodniot pogled.

 Dizajnirawe slajd 

Vo Impress postoi izbor na gotovi dizajni.

♦♦ Vo panelot Zada~i klikni na Originali.

♦♦ Od panelot Originali odberi eden dizajn i 
klikni na nego. Site slajdovi }e bidat dizajni-
rani so ist dizajn.

Razli~ni pogledi na prezentacijata
Vo Impress postojat pove}e pogledi na prezentacijata. Ti 

}e se zapoznae{ so slednive: Normalen, Slajd-{ou i Podredu-
va~ na slajdovi. Od eden na drug mo`e{ da premine{ na dva 
na~ina:

&& preku menito Prikaz;

&& preku opciite {to se na vrvot na pogledot vo koj se nao|a{.
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Pogledot Normalen

Impres se aktivira vo pogledot Normalen so koj ve}e si 
rabotel/a. Vo centralniot del e slajdot {to go ureduva{, a levo 
gi gleda{ site slajdovi vo namalena forma. 

Pogledot Podreduva~ na slajdovi

Pogledot Podreduva~ na slajdovi ti ovozmo`uva da gi vidi{
site slajdovi vo namalena forma i da manipulira{ so niv (vmet-
nuvawe, bri{ewe, kopirawe, prenesuvawe...). Sekako deka toa 
mo`e{ da go napravi{ i vo pogledot Normalen, no toga{ koga 
tvojata prezentacija }e ima mnogu slajdovi, polesno }e raboti{ 
so ovoj pogled. 

Rabota so slajdovi

 Vmetnuvawe slajd 

Nov slajd se vmetnuva me|u drugi slajdovi so naredbata Slajd 
(od menito Vmetnuvawe) ili so desen klik.

 Kopirawe i prenesuvawe slajdovi 

Slajd se prenesuva so naredbite Ise~i → Vmetni, a se kopira 
so naredbite Kopiraj → Vmetni (od menito Ureduvawe). Kako 
i za site drugi naredbi taka i ovde postojat pove}e na~ini, no 
najlesno e so tehnikata „povle~i i pu{ti“.

Prenesuvawe slajd

♦♦ Klikni na slajdot koj{to saka{ da go prenese{.

♦♦ So pritisnato kop~e od gluv~eto dvi`i se do mestoto kade 
{to saka{ da go premesti{ slajdot.

♦♦ Otpu{ti go kop~eto.

Kopirawe slajd

♦♦ Klikni na slajdot {to saka{ da go kopira{.
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♦♦ Dr`i go pritisnat tasterot Ctrl.
♦♦ So pritisnato kop~e od gluv~eto dvi`i se do mestoto kade 

{to saka{ da ima{ kopija od slajdot.

♦♦ Otpu{ti gi kop~eto i tasterot Ctrl.

 Bri{ewe slajd 

Slajd se bri{e so naredbata Izbri{i slajd (od menito Ure-
duvawe ili od pomo{noto meni, so desen klik).

♦♦  So desnoto kop~e od gluv~eto klikni na slajdot {to saka{ da 
go izbri{e{.

♦♦ Od menito odberi Izbri{i slajd.

Ureduvawe prazen slajd 
Dokolku nieden od dadenite pregledi ne ti odgovara za slajd,  

mo`e{ da izbere{ prazen slajd od panelot Rasporedi i da 
go uredi{ po tvoja `elba. Vo nego mo`e{ da vmetne{ ramka za 
tekst, slika, umetni~ki tekst, drug grafi~ki element.

Grafi~ki elementi se vnesuvaat vo prezentacijata na istiot 
na~in kako vo Writer, preku naredbite od menito Vmetnuvawe ili 
preku alatkite od lentata za crtawe (vo pogledot Normalen). 

Lentata so alatki za crtawe

Na dnoto na ekranot se nao|a lentata so alatkite za crtawe: 

 Crtawe gotovi grafi~ki oblici 

♦♦ Klikni na nadolnata strelka desno od edna od alatkite na 
lentata za crtawe;

♦♦ od dopolnitelnoto meni odberi eden od ponudenite grafi~ki 
oblici; 

♦♦ klikni i povle~i vo slajdot za da go nacrta{ oblikot.
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 Vnesuvawe sliki od hard diskot 

♦♦ Povikaj ja naredbata Vmetnuvawe → Slika → Od datoteka ili 
klikni na ikonata Od datoteka  & od lentata za crtawe;

♦♦ najdi ja slikata vo tvojot folder i selektiraj ja;

♦♦ klikni na kop~eto Insert. Slikata }e se pojavi vo slajdot.

Postavuvawe hipervrska

 Postavuvawe vrska do slajd vo ista prezentacija 

♦♦ Ozna~i go objektot {to }e pretstavuva hipervrska;

♦♦ povikaj ja naredbata Vmetnuvawe → Hipervrska;

♦♦ vo dobieniot prozorec Hipervrska klikni na ikonata Doku-
ment;

♦♦ klikni na ikonata Cel vo dokumentot ;

♦♦ }e se otvori prozorecot Cel vo dokumentot. Klikni na sood-
vetniot slajd;

♦♦ Klikni na kop~eto Primeni; 

♦♦ Vo prozorecot Hipervrska klikni na kop~eto Primeni.
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Animaciski i zvu~ni efekti
Preminuvawe od eden na drug slajd

♦♦ Otvori go panelot Preod na slajdovi vo panelot Zada~i;

♦♦ klikni na eden od preminite vo listata. Vedna{ }e go 
zabele`i{ efektot;

♦♦ opredeli ja brzinata: bavno, sredno ili brzo;

♦♦ od listata Zvuk odberi eden od zvu~nite efekti;

♦♦ klikni na kop~eto Primeni na site slajdovi.

Animirawe objekti vo slajdovite
♦♦ Ozna~i go objektot na koj saka{ da primeni{ animacija;

♦♦ otvori go panelot Sopstvena animacija, koj se nao|a vo pa-
nelot Zada~i;

♦♦ klikni na kop~eto Dodaj;

♦♦ od listata odberi edna od opciite: 

&& Vlez za da se pojavi objektot; 

&& Naglasok za istaknuvawe na objektot; 

&& Izlez za da is~ezne objektot;

&& Pateka na dvi`ewe.

♦♦ kdberi edna od ponudenite animacii;

♦♦ }e go vidi{ efektot dokolku e ozna~ena opcijata Avtomatski 
pregled;

♦♦ inaku, klikni na kop~eto Pu{ti za da go vidi{ efektot.
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Rabota so muzika i so video zapisi
 Postavuvawe zvuk od diskot 

♦♦ Povikaj ja naredbata Vmetnuvawe → Film i zvuk;

♦♦ vo prozorecot Vmetnuvawe film i zvuk najdi ja i ozna~i ja 
sakanata pesna;

♦♦ klikni na kop~eto Open. 

Vo prezentacijata }e se pojavi sledniov znak: .

Na sli~en na~in se raboti i so videozapisi.
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Voved

Novi poimi:

tabela, red, kolona, }elija, tabelarno presmetuvawe, 
rabotna tetratka, raboten list, aktivna }elija, lenta za 
formuli, formula, funkcija, grafikon

Dosega mnogupati si rabotel/a so tabeli. Rasporedot na ~aso-
vite e tabela, u~ili{niot dnevnik e poln so tabeli: za ocenki, 
za li~ni podatoci, za izostanoci, za evidencija na ~asovite itn. 
Tabelite pomagaat podatocite da bidat dobro organizirani i 
pregledni. Vo nekoi tabeli se javuva potreba za presmetuvawe 
na nekoi podatoci. Taka, na primer, nastavnicite za sekoj u~enik 
presmetuvaat sredna ocenka i zbir na izostanocite. Roditelite 
vodat smetka za prihodite i za rashodite vo semejstvoto, vo 
prodavnicite se presmetuvaat dneven promet, danok i drugo. Se 
razbira, site ovie presmetki polesno se izvr{uvaat koga poda-
tocite se organizirani vo tabeli, a, osven toa, i rezultatite se 
popregledni. 

Problem nastanuva koga vo tabelite }e se smeni nekoj podatok; 
na primer, ako nekoj u~enik ja popravi ocenkata od 4 na 5, toga{ 
srednata ocenka za toj u~enik treba povtorno da se presmeta, no 
i srednata ocenka za paralelkata. E, toa ne e mala rabota. Za-
toa se koristat programi za tabelarno presmetuvawe, koi mo`at 
da za{tedat mnogu ~asovi rabota. Osven {to izvr{uvaat pres-
metki vo tabeli, tie programi ovozmo`uvaat i prika`uvawe na 
podatocite vo vid na grafikoni.

 Mo`nosti na programite za tabelarno presmetuvawe 

♦♦ Brzo i ednostavno izrabotuvawe tabeli.

♦♦ So promena na eden podatok site podatoci {to zavisat od 
nego (zbir, prosek i drugo) avtomatski }e bidat povtorno pres-
metani.

♦♦ Izrabotuvawe razni tipovi grafikoni. Koga }e se smenat po-
datocite vo tabelata, avtomatski }e se smeni i grafikonot.

	

Potseti se!

Tabelata se sos-
toi od redovi i 

koloni. Redovite 
se postaveni 

horizontalno, a 
kolonite verti-
kalno. Presekot 
na redot i kolo-

nata se narekuva  
}elija.
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Microsoft Excel &  po~etni elementi
Microsoft Excel e programa nameneta za izrabotka na tabeli i 

grafikoni i za izvr{uvawe presmetki vo tabeli.

 Aktivirawe na programata Excel 
Za da ja aktivira{ programata, klikni na Start i odberi Pro-

grams  → Microsoft Office → Excel ili dvapati klikni na ikonata 
Excel .

Datotekite koi se izraboteni vo Excel so za~uvuvawe ja dobivaat 
nastavkata .xls i ja imaat slednava ikona . 

 Raboten dokument, raboten list, tabela 

1	 Koga }e ja aktivira{ programata Excel, }e se otvori datoteka 
nare~ena raboten dokument ili rabotna tetratka (Workbook). 
Prvata rabotna tetratka {to }e se otvori }e ima ime Book1, 
s¢ dodeka ne ja za~uva{ pod drugo ime.

2	 Rabotnata tetratka se sostoi od rabotni listovi (Worksheet). 
Podatocite se vnesuvaat vo rabotniot list. Sekoja nova 
rabotna tetratka ima tri rabotni listovi, no nivniot broj 
mo`e da se zgolemuva i da se namaluva po potreba. Od eden 
vo drug raboten list se preminuva so lev klik na jazi~eto so 
ime na rabotniot list (Sheet1, Sheet2, Sheet3).

3	 Rabotniot list e povr{ina podelena na koloni i redovi. 
Pravoagolniot del od rabotniot list koj e ispolnet so poda-
toci go narekuvame tabela. 

3

2

1

Zabele{ka:

Prozorecot na 
Excel gi sodr`i 
elementite na 
standarden pro-
zorec.

Zabele{ka:

Mo`e{ da go 
smeni{ imeto na 
rabotniot list: 
dvapati klikni na 
jazi~eto i napi{i 
novo ime.
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Postapkite za otvorawe nova ili postojna rabotna tetratka, 
za zatvorawe i za za~uvuvawe & se izvr{uvaat sosema isto kako 
vo Word. Samo nakuso potseti se na naredbite:

♦♦ Otvorawe nova rabotna tetratka	          	 File → New
♦♦ Otvorawe postojna rabotna tetratka 	 File → Open
♦♦ Zatvorawe na rabotnata tetratka		  File → Close
♦♦ Za~uvuvawe na rabotnata tetratka	 File → Save as…

[to treba da nau~i{:

♦♦ Za {to e nameneta aplikacijata Excel.
♦♦ [to e rabotna tetratka.

♦♦ [to e raboten list.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da ja startuva{ aplikacijata Excel.
♦♦ Da gi prepoznava{ elementite na prozorecot 

na Excel.
♦♦ Da premine{ od eden vo drug raboten list.

♦♦ Da go smeni{ imeto na rabotniot list.

♦♦ Da otvori{ nova i postojna rabotna tetratka i 
da ja za~uva{ rabotnata tetratka.

 Pra{awa: 

1.	 Za {to e nameneta programata Microsoft Excel?
2.	 Kako se aktivira programata Microsoft Excel?
3.	 Koja nastavka ja imaat datotekite {to se izraboteni vo  

Excel?
4.	 [to e i od {to se sostoi rabotnata tetratka?

5.	 [to e raboten list, a {to e tabela?
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Osnovni elementi na rabotniot list
Rabotniot list e podelen na koloni (columns) i redovi (rows).

1	 Kolonite se postaveni 
vertikalno i se ozna~eni 
so bukvite A, B, C itn. 

2	 Redovite se postave-
ni horizontalno i se 
ozna~eni so broevite 1, 2, 
3 itn. 

3	 Presekot na redot i kolo-
nata se narekuva }elija (cell). ]elija e mestoto kade {to se 
vnesuvaat podatocite. 

 Aktivna }elija 

Pozicioniraj se vrz koja bilo }elija. Poka`uva~ot }e ja dobie 
formata . Klikni na }elijata. ]elijata vo koja si pozicioni-
ran se narekuva aktivna }elija i ima zadebelena ramka. 

1	 Oznakata za kolonata vo koja se 
nao|a aktivnata }elija e so druga 
boja.

2	 Oznakata za redot vo koj se nao|a 
aktivnata }elija e so druga boja.

3	 Oznakite za soodvetnata kolona 
i za soodvetniot red ja formiraat adresata na aktivnata }
elija. Adresata e prika`ana vo lentata {to se nao|a vedna{ 
nad oznakite za kolonite. ]elijata vo presek na kolonata C i 
redot 4 ima adresa C4.

 Ozna~uvawe na }eliite 

Za da ozna~i{ pove}e }elii, klikni na prvata i so pritisnato 
levo kop~e od gluv~eto dvi`i se niz redovite i kolonite, s¢ 
do poslednata }elija {to saka{ da ja ozna~i{. Na toj na~in }e 
napravi{ pravoagolna selekcija.

 
Na slikava se ozna~eni  

}eliite od A1 do D8. Na site 
ozna~eni }elii mo`e{ da go 
primeni{ istoto formatirawe; 
na primer: font, golemina na 
bukvite, boja na bukvite, boja na 
podlogata, granici i sli~no.

2

1

3

1

2

3 Zabele{ka:

]elija mo`e{ da 
aktivira{ kliknu-
vaj}i so gluv~eto 
vrz nea. Koga 
}e otvori{ nova 
rabotna tetratka, 
aktivna }elija }e 
bide }elijata A1.
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 Dvi`ewe niz rabotniot list 

Vo rabotniot list mo`e{ da se dvi`i{ so pomo{ na lentite 
za dvi`ewe, no i so pomo{ na tastaturata.

Tasteri	 Dvi`ewe

← Edna kolona kon levo

→ Edna kolona kon desno

← Eden red pogore

←

Eden red podolu

Ctrl+ ← Najlevata }elija

Ctrl+ → Najdesnata }elija

Page Up Eden ekran pogore

Page Down Eden ekran podolu

Home Po~etok na redot

End Kraj na redot

Ctrl+Home Po~etok na tabelata

Ctrl+End Kraj na tabelata

[to treba da nau~i{:

♦♦ Da prepoznava{ red, kolona i }elija.
♦♦ Da gi prepoznava{ oznakite za redovite i za kolonite.

♦♦ Da prepoznava{ aktivna }elija.

♦♦ Da znae{ kako se formira adresata na aktivnata }elija.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da ozna~uva{ }elii.

♦♦ Da se dvi`i{ niz rabotniot list so pomo{ na 
gluv~eto i tastaturata.

Pra{awa i zada~i: 

1.	 Kako e podelen rabotniot list?

2.	 Kako se ozna~eni redovite, a kako kolonite na rabotniot 
list?

3.	 [to e }elija? Kako }e prepoznae{ aktivna }elija?

4.	 Kako se formira adresata na aktivnata }elija?

5.	 Kako se ozna~uvaat }eliite?

6.	 Ve`baj gi dvi`ewata niz tabelata so tastaturata.
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Vnesuvawe podatoci vo tabela
Izrabotkata na tabela zapo~nuva so vnesuvawe podatoci. 

Site operacii }e gi poka`eme so primeri.

Podatocite vo tabelata se vnesuvaat vo aktivnata }elija. 

1	 Klikni na A1.

2	 Napi{i Marko. Koga }e po~ne{  da go vnesuva{ 
podatokot, }e se pojavi kursorot vo aktivnata 
}elija.

3	 Pritisni Enter. Sega aktivna }elija e A2.

4	 Za da smeni{ aktivna }elija, dvi`i se so 
TAB kon desno i so ENTER nadolu:

Lentata za formuli

Vedna{ nad oznakite za koloni se nao|a len-
tata za formuli (formula bar). Taa se sostoi od 
dva dela: levo e ispi{ana adresata na aktivnata  
}elija, a desno & nejzinata sodr`ina.

 Tipovi podatoci 

Podatocite {to gi vnesuvame vo tabelite gi rasporeduvame vo 
razli~ni tipovi. Niz primeri }e nau~i{ kako da vnese{ tekst, 
broevi, datumi i vreme.

Vnesuvawe tekst i broevi

Tekst i broevi se vnesuvaat na voobi~aen na~in.

»» Primer 1: Izraboti tabela {to }e sodr`i podatoci za ~leno-
vite na tvoeto semejstvo i za nivnata vozrast.

1	 Vnesi gi podatocite vo tabelata, kako 
na slikava. 

2	 Za~uvaj ja tabelata pod imeto Semejstvo.
xls.

Mo`e da zabele`i{ deka tekstovite se 
poramneti levo, a broevite desno.

Vnesuvawe datum i vreme

»» Primer 2: Vo tabelata od primerot 1, vo kolonite C i D vnesi 

      levo	           desno
poramneti	   poramneti

Zabele{ka: 

Latini~en vo 
kirili~en font 
(vo aktivnata  
}elija) se menuva 
preku lentata za 
formatirawe, na 
ve}e poznatiot 
na~in.
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gi datumot i vremeto na ra|awe na ~lenovite na tvoeto semej-
stvo.

Za da vnese{ datum, mora{ da ko-
risti{ crti~ka (-), kosa crta (/) ili 
to~ka (.) za razdeluvawe na denot, 
mesecot i godinata (na primer: 21-3-
1995, 21.03.1995 ili 21/3/95). Takvite 
podatoci Excel }e gi prepoznae kako datum.

Za da go vnese{ vremeto, koristi dve to~ki (:) me|u ~asot i 
minutite (na primer, 10:30).

Datumite i vremeto se izramneti desno, isto kako i broevite.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da vnesuva{ podatoci vo }eliite.

♦♦ Da gi raspoznava{ numeri~kite i tekstualnite podatoci.

♦♦ Da vnesuva{ datum i vreme.

Pra{awa i zada~i: 

1.	 Kako se vnesuvaat podatoci vo tabelata?

2.	 [to sodr`i lentata za formuli?

3.	 Kako se izramnuvaat tekstovite, a kako broevite vo tabe-
lata?

4.	 Kako se vnesuvaat datumite i vremeto vo tabelata?

5.	 Izraboti tabela vo koja }e gi vnese{ imiwata, visinata 
i te`inata na tvoite drugar~iwa. Za~uvaj ja tabelata pod 
imeto Visina_i_tezina.xls.

6.	 Izraboti tabela vo koja }e gi vnese{ temperaturite & 
posebno za sekoj den od edna sedmica. Za~uvaj ja tabelata 
pod imeto Temperatura.xls.

Sovet:

Dokolku kolonite 
ne se dovolno 

{iroki, klikni 
dvapati na lini-
jata po oznakata 

za kolonata za da 
ja pro{iri{.

Sovet:

Sekoga{ na vrvot 
na kolonite se 

vnesuvaat naslo-
vite na kolonite, 
pa taka, sekoj {to  

}e ja koristi  
tabelata }e znae 
za {to se raboti.
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7.	 Izraboti tabela vo koja }e vnese{ podatoci za omilenite 
boi na tvoite sou~enici. Za sekoja boja vnesi go brojot na  
u~enici na koi im e omilena taa. Za~uvaj ja tabelata pod 
imeto Omilena_boja.xls.

Ureduvawe na tabelata

Menuvawe i ureduvawe na  

vnesenite vrednosti vo tabelata

Pri izrabotuvaweto na tabelata mo`ebi }e zgre{i{ i }e 
mora{ vnesenite podatoci da gi popravi{, da vnese{ drug poda-
tok ili da izvr{i{ izmeni vo celata tabela: da vmetne{ ili da 
izbri{e{ nekoj red ili nekoja kolona.

Menuvawe (editirawe) na podatocite 

»» Da pretpostavime deka vo }elijata A1 si go vnesol podatokot 
Marko, a trebalo da vnese{ Marjan. Si zabele`al/a gre{ka i 
saka{ da ja ispravi{:

1	 prvo, klikni na }elijata A1 za da bide 
aktivna;

2	 odberi eden od slednive na~ini za da 
se pojavi kursorot:

a. dvapati klikni na }elijata A1;  ili

b. klikni vo lentata za formuli na sodr`inata;

3	 vo statusnata lenta }e pi{uva Edit, {to zna~i deka Excel e vo 
modot Edit, mod za vnesuvawe i za menuvawe na podatocite;

4	 izbri{i gi bukvite k i o, a napi{i jan;

5	 pritisni na tasterot Enter.
Vnesuvawe novi podatoci 

»» Sega, namesto Marjan, vo A1 vnesi Ana:

1	 pozicioniraj se vo }elijata A1;

2	 vo statusnata lenta }e pi{uva Ready;

3	 napi{i Ana;

4	 dodeka pi{uva{, vo statusnata lenta }e se pojavi Enter;
5	 pritisni na tasterot Enter.

1

2 a

3

2 b

Istra`i:

Dali za edna  
}elija mo`e{ da 
odbere{ razli~ni 
fontovi?

Zabele{ka: 

Dodeka  Excel e vo 
modot Edit, mnogu 
komandi }e bidat 
neaktivni.
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Zabele`uva{ deka koga }e po~ne{ da vnesuva{ nov podatok, 
stariot podatok se bri{e.

Bri{ewe na podatocite 

Za da izbri{e{ podatok:

1	 pozicioniraj se vo soodvetnata }elija;

2	 pritisni na tasterot Delete.

Ureduvawe na podatocite vo pove}e }elii 

Sigurno si zabele`al/a deka ureduvawata va`at samo za  
aktivnata }elija, {to zna~i deka koga }e pomine{ vo nova }e- 
lija, povtorno treba da gi izvr{i{istite ureduvawa. Za da ne ti 
se slu~i toa, najprvo selektiraj gi site }elii za koi va`i istoto 
ureduvawe, pa toga{ izvr{i go ureduvaweto. 

 Rabota so koloni i so redovi 

Kolona mo`e{ da vmetne{ vo tabela so naredbata Insert → 
Columns, a  red so naredbata Insert → Rows. Ozna~ena kolona 
ili ozna~en red }e izbri{e{ so naredbata Edit → Delete.

So redovi i so koloni polesno }e raboti{ preku pomo{noto 
meni, koe }e go dobie{ koga }e klikne{ so desnoto kop~e od 
gluv~eto  na oznakata za redot/kolonata.

Vmetnuvawe kolona

»» Vo tabelata Semejstvo.xls vmetni u{te edna kolona, so naslov 
„Reden broj“, levo od kolonata so naslov „^len“ (kolonata A):

1	 so desnoto kop~e od gluv~eto klikni na 
oznakata A;

2	 od pomo{noto meni odberi Insert;

3	 kolonata A }e se pomesti kon desno i }e ima 
oznaka B;

4	 levo }e se pojavi nova prazna kolona so ozna-
ka A;

5	 vnesi podatoci vo kolonata A i za~uvaj ja tabelata.

Vmetnuvawe red

Postapkata za vmetnuvawe red e ista kako postapkata za vmet-
nuvawe kolona. Ovoj pat, so desnoto kop~e od gluv~eto klikni 
na oznakata za redot pred koj saka{ da vmetne{ nov red i od 
pomo{noto meni odberi Insert. ]e se pojavi nov prazen red, a 
site redovi po nego }e imaat novi oznaki. 

2

1

3
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Bri{ewe kolona

»» Vo tabelata Semejstvo.xls izbri{i ja kolonata so naslov „Go-
dini“:

1	 so desnoto kop~e od gluv~eto klikni na oznakata C;
2	 od pomo{noto meni odberi Delete;

3	 kolonite po izbri{anata kolona }e se pomestat i }e dobijat 
novi oznaki; za~uvaj ja tabelata.

Bri{ewe red

Za da izbri{e{ red, postapi isto kako za bri{ewe kolona.

 Dimenzii na redovite i na kolonite 

[irinata/visinata na nekoja kolona ili na nekoj red mo`e{ 
da gi smeni{ proizvolno. So pro{iruvawe na kolonata }e mo`e{ 
da vidi{ i podolgi tekstovi. Ne gri`i se dokolku namesto vne-
senite podatoci vidi{ ~udni znaci kako na slikata podolu. 

Ednostavno, kolonata e pretesna za da mo`e da gi prika`e 
site podatoci. 

Sega }e nau~i{ kako da gi uredi{ dimenziite na redovite i na 
kolonite vo tabelata.

Menuvawe na dimenziite na kolonite

Za da pro{iri{ ili stesni{ nekoja kolona:

1	 pozicioniraj se so gluv-
~eto na linijata po oznaka-
ta za soodvetnata kolona 
(kolona C na slikava); koga 
poka`uva~ot }e go dobie 
ovoj oblik , klikni so 
levoto kop~e od gluv~eto;

2	 }e se pojavi poka`uva~ vo koj e napi{ana {irinata na kolo-
nata; so pritisnato levo kop~e od gluv~eto dvi`i se levo za 
da ja stesni{ kolonata ili desno za da ja pro{iri{ kolonata;

3	 dodeka se dvi`i{, }e zabele`i{ i isprekinata vertikalna 
linija koja ja poka`uva novata dimenzija na kolonata; koga }e 
dojde{ do sakanata dimenzija, otpu{ti go kop~eto.

Na ist na~in se menuvaat i dimenziite na redovite.

2
1

3

3

Sovet:

Pobrz na~in za  
menuvawe dimen-
ziiite na kolo-
nata/redot e so 
dvoklik na lini-
jata po oznakata za 
kolonata/redot.  
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Ve{tini {to treba da gi usovr{i{!

♦♦ Da gi smeni{ podatocite vo }eliite.

♦♦ Da vmetne{ kolona i red.

♦♦ Da izbri{e{ kolona i red.

♦♦ Da stesni{ ili pro{iri{ kolona i red.

Pra{awa i zada~i: 

1.	 Kako }e izmeni{ nekoj podatok vo }elijata?

2.	 Kako }e vnese{ nov podatok vo }elijata?

3.	 Kako }e izbri{e{ podatok?

4.	 Dali mo`e{ vo edna }elija da primeni{ razli~ni fonto-
vi?

5.	 Kako }e vmetne{ red ili kolona vo tabelata?

6.	 Kako }e izbri{e{ red ili kolona vo tabelata?

7.	 Kako }e gi smeni{ dimenziite na redovite i na kolonite?

8.	 Otvori nova rabotna kniga. Vo rabotniot list vnesi gi 
slednive podatoci:

♦♦ pred redot 1 vmetni u{te eden red; vo novata  }elija A1 
napi{i Dobiv, a vo A2 Potro{iv; 

♦♦ vmetni kolona pred kolonata A; vo novata }elija A1 
napi{i Den, a vo }eliite od B1 do B5 denovite od pone-
delnik do petok;

♦♦ pro{iri gi kolonite po potreba;

♦♦ za~uvaj ja tabelata pod imeto Dzeparlak.xls; tvojata tabela 
treba da izgleda vaka:
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Ureduvawe na podatocite vo tabelata
Vo tabelite mo`e{ da go odbere{ tipot na podatocite, da gi 

uredi{ fontot i poramnuvawata na podatocite ili da gi posta-
vi{ granicite i da ja izbere{ bojata na }eliite. Mo`e{ da ure-
di{ pove}e }elii odedna{. Najprvo, ozna~i gi site }elii {to 
saka{ da gi uredi{.

Tvojata tabela mo`e{ da ja uredi{ na dva na~ina:

&& Preku prozorecot Format Cells, koj }e go povika{ so nared-
bata Cells od glavnoto meni Format. Prozorecot Format Cells 
sodr`i pove}e stranici:

1	 za izbirawe i za ureduvawe na tip na podatocite;

2	 za poramnuvawe na podatocite;

3	 za ureduvawe na fontot;

4	 za ureduvawe na granicite na }eliite;

5	 za ureduvawe na bojata na }eliite.

&& Preku lentata za formatirawe: 

 Razdeluvawe na tekstot (Wrap text ) 

Pogledni ja kolonata A (Reden broj) vo tabelata Semejstvo.xls. 
Mo`e{ da zabele`i{ deka ovaa kolona ima dolg naslov poradi 
toa {to si ja pro{iril, no podatocite vo nea ne baraat tolkava 
{irina na kolonata. Re{enie bi bilo naslovot da se prika`e 
vo dve linii, no samo vo edna }elija; na toj na~in kolonata bi 
mo`el/a da ja stesni{.

1	 Klikni na }elijata A1.

2	 Povikaj go prozorecot Format Cells.

3	 Odberi ja karti~kata Alignment.

4 521 3
Zabele{ka: 

Pove}eto ureduva-
wa }e gi objasnime 
preku lentata za 
formatirawe, a 
prozorecot For-
mat Cells }e go 
povikame samo 
toga{ koga }e bide 
potrebno.
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4	 Potvrdi ja opcijata Wrap text.
5	 Klikni na kop~eto OK.

Sega }elijata izgleda kako na slikava:           

Dokolku dimenziite ne se smenat avtomatski, stesni ja kolo-
nata A i pro{iri go redot 1.

»» Vo }elijata C1 namesto Datum napi{i Datum na ra|awe i 
razdeli go tekstot vo dve linii. Obidi se sega na drug na~in:

1	 ozna~i ja }elijata C1;

2	 vo lentata za formuli klikni na zborot na;

3	 pritisni ja kombinacijata na tasteri Alt+Enter.

 Poramnuvawe i nasoka na sodr`inata vo }elijata 

Alatkite za poramnuvawe ti se, isto taka, poznati: .

No, sodr`inata vo edna }elija mo`e{ da ja izramni{ ne samo 
horizontalno tuku i vertikalno. Isto taka, mo`e{ da odbere{ 
proizvolna nasoka na sodr`inata.

»» Uredi go zaglavieto (}elii so naslovi na koloni) na tabelata 
Semejstvo.xls:

1	 ozna~i gi }eliite od A1 do D1;

2	 povikaj go prozorecot Format Cells i odberi ja karti~kata 
Alignment;

3	 klikni na nadolnata strelka vo poleto Horizontal i odberi 
Center;

4	 klikni na strelkata za nadolu vo poleto Vertical i odberi 
Center;

4

2

1
3

5
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5	 vo delot Orientation klikni na to~kata {to odgovara na agol 
od 90 stepeni;

6	 klikni na kop~eto OK.

Zaglavieto }e go ima sledniov izgled:

 Spojuvawe pove}e }elii vo edna 

Koga }e vnesuva{ dolgi tekstovi, }e treba pove}e }elii da 
spoi{ vo edna }elija. Toa }e go postigne{ so alatkata  (Merge 
and Center) od lentata za formatirawe.

»» Vo tabelata Semejstvo.xls vmetni red pred zaglavieto, vo koj 
}e go napi{e{ naslovot „Moeto semejstvo“, taka {to toj da se 
protega niz kolonite A, B, C i D:

1	 prvo vmetni red pred redot 
broj 1; sega zaglavieto e vo re-
dot broj 2; ozna~i gi }eliite 
A1, B1, C1 i D1;

2	 klikni na alatkata ;

3	 sega ima{ edna }elija; napi{i go tekstot Moeto semejstvo.

4

5

6

1
2

3

1

2

3
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 Boja na tekstot i na zadninata 

Bojata na tekstot se ureduva so alatkata Font Color .

Bojata na zadninata na tekstot se ureduva so alatkata Fill Co-
lor  .

»» Tabelata Semejstvo.xls uredi ja kako na slikava:

 Granici na }eliite 

Mo`e{ da zabele`i{ deka tabelata Semejstvo.xls nema gra-
nici za }eliite. Liniite {to gi gleda{ na rabotniot list, vsu-
{nost, ne se granici, tuku samo oznaki za redovite i za kolonite. 
Granicite se postavuvaat so pomo{ na alatkata Borders. 

1	 Ozna~i gi site }elii vo tabelata Semejstvo.xls;

2	 klikni na strelkata za nadolu do alatkata Bor-
ders i odberi All Borders;

3	 sega ozna~i go samo zaglavieto na tabelata;

4	 klikni na nadolnata strelka {to se nao|a do alatkata Bor-
ders i odberi ja poslednata opcija od slikata gore (Thick Box 
Borders);

5	 ista granica odberi i za naslovot na tabelata.

Sega tabelata izgleda kako na slikava:

 Broj na decimalnite mesta vo broevite 

Dokolku ima potreba, mo`e{ da vnese{ i decimalni broevi. 
Ponekoga{ e potrebno site broevi da bidat so ist broj decimal-
ni mesta, odnosno da se prika`at i nulite po posledniot deci-
mal (na primer: 2,50). Za namaluvawe i za zgolemuvawe na de-
cimalnite mesta koristi gi alatkite Increase Decimal  (dodaj 
decimali) i Decrease Decimal  (odzemi decimali).

Vnimavaj! 

Vo informati-
kata namesto 

decimalna  
zapirka ~esto 

se koristi deci-
malna to~ka. 
Za da bide{ 

siguren/na deka 
nema da zgre{i{, 
sekoga{ koristi 

ja decimal-
nata to~ka od 
numeri~kata 

tastatura.
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1	 Selektiraj gi broevite od kolonata Reden broj;

2	 nekolkupati klikni na alatkata Increase Decimal;
3	 nekolkupati klikni na alatkata Decrease Decimal.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da go razdeli{ tekstot na pove}e linii vo }eli-
jata (Wrap text).

♦♦ Da ja poramni{ sodr`inata na }elijata (Alignment).
♦♦ Da spoi{ pove}e }elii vo edna (Merge).

♦♦ Da postavi{ boja na tekstot (Font Color) i na zad-
ninata (Fill Color).

♦♦ Da gi postavi{ granicite na }eliite (Borders).

♦♦ Da postavi{ broj na decimalnite mesta vo }eli-
jata (Increase Decimal, Decrease Decimal).

Pra{awa i zada~i: 

1.	 Kako se razdeluva tekst vo ramkite na edna }elija? Objasni 
gi dvata na~ina!

2.	 Kako se ureduvaat izramnuvaweto i nasokata na tekstot vo  
}eliite?

3.	 So koja alatka }e spoi{ pove}e }elii vo edna?

4.	 So koja alatka }e gi uredi{ boite na tekstot i na zadninata 
na }eliite?

5.	 So koja alatka }e gi uredi{ granicite na }eliite?

6.	 So koi alatki }e dodade{ ili odzeme{ decimali na bro-
evite?

7.	 Tabelata Dzeparlak.xls uredi ja kako na slikava. Za~uvaj ja 
tabelata.

8.	 Uredi gi po sopstvena `elba tabelite Visina_i_tezina.xls, 
Temperatura.xls i Omilena_boja.xls.
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Formi na poka`uva~ot
Vo dosega{nata rabota verojatno si zabele`al/a deka 

poka`uva~ot od gluv~eto ima razli~ni formi, vo zavisnost od 
pozicijata na koja se nao|a. Vo tabelava se dadeni formite na 
poka`uva~ot:

Forma na 
poka`uva~ot

Zna~ewe

 ozna~uvawe kolona

 ozna~uvawe red

 menuvawe na dimenziite na kolonata

 menuvawe na dimenziite na redot

 ozna~uvawe }elija

 pomestuvawe na sodr`inata na }elija

 kopirawe na sodr`inata na }elija

 avtomatsko popolnuvawe na }eliite

Sega }e se zapoznae{ so site formi i so nivnoto zna~ewe. Vo 
nov raboten list, vo }elijata A1 vnesi kakov bilo tekst.

 Prenesuvawe sodr`ina od edna vo druga }elija 

Ozna~i ja }elijata A1; taa e sega aktivna  
}elija i okolu nea ima zadebelena ramka. So 
gluv~eto pozicioniraj se vrz ramkata. Koga 
poka`uva~ot }e dobie forma za pomestuvawe na sodr`inata 
(vidi vo tabelata), so pritisnato levo kop~e od gluv~eto 
dvi`i se kon druga }elija. Dodeka se dvi`i{, poka`uva~ot  
}e ima forma na strelka. Otpu{ti go kop~eto; sodr`inata od  
}elijata A1 sega e pomestena vo novata }elija.

 Kopirawe sodr`ina od edna vo druga }elija 

So gluv~eto, pozicioniraj se vrz ramkata. 
Poka`uva~ot }e dobie forma kako za premes-
tuvawe. Pritisni go i dr`i go tasterot Ctrl. 
Koga poka`uva~ot }e dobie forma za kopirawe na sodr`inata 
(vidi vo tabelata), so pritisnato levo kop~e od gluv~eto i so 
pritisnat taster Ctrl dvi`i se kon druga }elija. Otpu{ti gi 
kop~eto i tasterot Ctrl; sodr`inata od }elijata A1 sega e iskopi-
rana i e vo nova }elija.
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 Ozna~uvawe na kolonite i na redovite 

Za da ozna~i{ kolona/red, klikni na oznakata za kolonata/
redot (kursorot }e dobie forma za ozna~uvawe red/kolona). 

	 	

Za da ozna~i{ pove}e posledovatelni koloni/redovi, klikni 
na oznakata na prvata kolona ili na prviot red, dr`i go pri-
tisnat tasterot Shift i klikni na poslednata kolona ili na po-
sledniot red {to saka{ da ja/go ozna~i{. Mo`e{ i so gluv~eto: 
so pritisnato levo kop~e dvi`i se niz oznakite na kolonite/
redovite.

Za da ozna~i{ pove}e neposledovatelni koloni/redovi, klik-
ni na oznakata na prvata kolona ili na prviot red, dr`i go pri-
tisnat tasterot Ctrl  i kliknuvaj na oznakite na kolonite/redo-
vite {to saka{ da gi ozna~i{.

 Avtomatsko popolnuvawe 

Pogledni ja dobro ramkata okolu aktivnata }elija. ]e za-
bele`i{ kvadrat~e vo dolniot desen agol. Toa kvadrat~e se na-
rekuva ra~ka za avtomatsko popolnuvawe. 

Koga so gluv~eto }e se pozicionira{ na ra~kata, poka`uva~ot  
}e dobie oblik kako na slikava: 
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Avtomatsko popolnuvawe so tekst

Pozicioniraj se na ra~kata na aktivnata }elija vo koja e 
vnesen tekstot. Poka`uva~ot }e dobie forma kako na slikata 
gore. Klikni i so pritisnato levo kop~e od gluv~eto dvi`i se 
niz kolonite ili niz redovite do kade {to saka{ }eliite da gi 
popolni{ so istata sodr`ina. Otpu{ti go kop~eto. Site }elii  
}e bidat popolneti so istiot tekst. 

	 	

Avtomatsko popolnuvawe so nizi od broevi

Ne mora{ da gi pi{uva{ site redni broevi. Dovolno e da 
vnese{ samo dve vrednosti, a potoa selektiraj gi dvata broja i 
primeni ja prethodnata postapka za avtomatsko popolnuvawe na 
}eliite. Dodeka vle~e{ so gluv~eto, vo `oltoto kvadrat~e }e 
zabele`i{ broj do koj }e se popolnat }eliite.

	 	

Obidi se sam/a: 

Vo nov raboten list vnesi niza od parni broevi i niza 
od neparni broevi, koristej}i se so gluv~eto i so avtomats-
koto popolnuvawe so podatoci.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da gi razlikuva{ razli~nite vidovi poka`uva~i.

♦♦ Da prenese{ i da kopira{ sodr`ina od edna vo 
druga }elija.

♦♦ Da gi ozna~i{ redovite i kolonite.

♦♦ Da gi popolni{ }eliite i kolonite so tekst i so 
broevi, koristej}i go avtomatskoto popolnuvawe.

Vnimavaj! 

Va`no e da selek-
tira{ barem dve 

vrednosti od 
nizata; inaku, site 

}elii }e se  
popolnat so edna 

vrednost. 
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Pra{awa i zada~i: 

1.	 Objasni gi postapkite za prenesuvawe i za kopirawe odre-
dena sodr`ina od edna }elija vo druga!

2.	 Na koj na~in se ozna~uvaat kolonite i redovite vo rabotniot 
list?

3.	 Kako se ozna~uvaat posledovatelnite, a kako neposledo-
vatelnite koloni/redovi?

4.	 Objasni ja postapkata za avtomatsko popolnuvawe na }eliite!

5.	 Vnesi tekst vo }elijata A1 vo rabotniot list. Prenesi go 
tekstot vo }elijata E5. Iskopiraj go vo }elijata E8 istiot 
tekst.

6.	 Ozna~i gi site koloni od A do J i redovite 2, 5, 8 i 9.

7.	 So pomo{ na avtomatskoto popolnuvawe vo kolonata A vne-
si gi neparnite broevi od 1 do 49, a vo kolonata B vnesi gi 
parnite broevi od 2 do 100. 

8.	 Napravi tablica mno`ewe kako na slednata slika:

Grafikon

 Poim za grafikon i tipovi grafikoni 

Podatocite {to se organizirani vo tabela ni davaat ubav 
pregled, no u{te podobar pregled na podatocite }e imame ako 
gi pretstavime so grafikon. Grafikonot gi pretvora podato-
cite vo slika. Postojat razli~ni tipovi grafikoni. Nie }e se 
zapoznaeme so tri tipa: 

grafikon so stolp~iwa

liniski grafikon

grafikon pita 
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Izborot na tipot zavisi od vidot na podatocite. Grafikonot 
so stolp~iwa primeni go koga }e saka{ da sporedi{ vrednosti 
(na primer: visina ili te`ina); liniskiot grafikon & koga }e 
saka{ da go sledi{ dvi`eweto na podatocite (zgolemuvawe ili 
namaluvawe, na primer, na temperaturata); grafikonot pita & 
koga }e saka{ podatocite da gi sporedi{ procentualno (na pri-
mer, nacionalnata struktura na `itelite).

 Kreirawe grafikon 

Najprvo izraboti tabela vo koja }e gi 
vnese{ imiwata na tvoite drugar~iwa i 
nivnata visina i te`ina.

1	 Ozna~i gi vrednostite vo kolonite so 
imiwata i visinite zaedno so naslo-
vite na kolonite;

2	 od menito Insert odberi ja naredbata 
Chart ili klikni na alatkata  Chart 
Wizard od standardnata lenta.

]e se pojavi prozorecot Chart Wizard. Izraboti grafikon vo 
~etiri ~ekori. Vo prviot ~ekor odberi go tipot na grafikonot:

3	 od karti~kata Standard Types 
odberi go tipot Column;

4	 odberi pottip (prviot od dade-
nite);

5	 klikni na kop~eto Next.

Vo vtoriot ~ekor odberi rang 
na podatocite:

6	 vo karti~kata Data Range }e go 
vidi{ izgledot na grafikonot;

7	 vo lentata Data range treba da od-
bere{ opseg na podatocite za koi 
saka{ da napravi{ grafikon; ti 
si go napravil/a toa so ozna~uvawe 
na podatocite pred da po~ne{ so 
izrabotuvaweto na grafikonot; 
dokolku ne si, podatocite mo`e{ 
i sega da gi selektira{;

2

1

5

3
4

8

7

6
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8	 klikni na kop~eto Next.
Vo tretiot ~ekor treba da im dade{ naslovi na grafikonot i 

na oskite:

9	 vo lentata Chart title na-
pi{i Visina;

10	 vo lentata Category (X) 
axis napi{i Ime;

11	 vo lentata Value (Y) axis 
napi{i cm;

12	 klikni na kop~eto Next.

Vo posledniot ~ekor:

13	 od ponudenite opcii od-
beri ja vtorata As object in; 
so ovaa opcija grafikonot 
}e bide del od postojniot 
raboten list; so prvata op-
cija As new sheet grafiko-
not }e se prika`e vo nov 
raboten list;

14	 klikni na kop~eto Finish i so toa }e go zavr{i{ ureduvaweto 
na grafikonot.

Vo tvojot raboten list }e se pojavi ovoj grafikon:

Od grafikonot jasno se gleda deka najvisok e Jovan, a najniska 
e Ana. Se gleda i deka Jana i Marija imaat ista visina. 

 Ureduvawe na grafikonot 

Grafikonot mo`e{ da go uredi{ po tvoja `elba: da gi smeni{ 
goleminata, fontot, nasokata na tekstot, boite i sli~no.

9
10
11

12

Zabele{ka: 

So kop~eto Back 
mo`e{ da se 
vrati{ eden ~ekor 
nazad.

13 14
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Klikni dvapati na delot od grafikonot {to saka{ da go ure-
di{ (naslov, zadnina, stolp~iwa itn). ]e se pojavi prozorec 
preku koj mo`e{ da gi uredi{ fontot, bojata, granicite, izram-
nuvawata...

Pove}eto od ovie ureduvawa ti se poznati, pa kreativnosta ti  
ja prepu{tame tebe. Sigurni sme deka grafikonot {to }e go uredi{  
}e izgleda poubavo od dadeniov.

Obidi se sam/a

Kreiraj grafikon za te`inata na tvoite drugari. Vnima-
vaj: za da ozna~i{ podatoci vo nesosedni koloni, koristi go 
tasterot Ctrl.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da go odbere{ vistinskiot tip grafikon.

♦♦ Da izraboti{ grafikon.

♦♦ Da go uredi{ grafikonot.
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Pra{awa i zada~i: 

1.	 Koi tipovi grafikoni gi znae{?

2.	 Navedi primeri za primena na sekoj od tipovite grafikoni!

3.	 So koja naredba }e izraboti{ grafikon?

4.	 Objasni gi ~ekorite za izrabotuvawe grafikon.

5.	 Kako mo`e{ da go uredi{ grafikonot?

6.	 Vo tabelata Dzeparlak.xls izraboti grafikon za dobienite i 
za potro{enite pari od xeparlakot za sekoj den. 

7.	 Izraboti grafikon za tabelata Temperatura.xls. Odberi li-
niski grafikon.

8.	 Izraboti grafikon za tabelata Omilena_boja.xls. Odberi 
grafikon pita.

9.	 Uredi gi grafikonite od prethodnite tri zada~i po tvoja 
`elba. Za~uvaj gi tabelite.

Formuli
Vo Excel ima mo`nosti za vnesuvawe formuli i za izvr{uvawe 

na matemati~kite operacii so podatoci: sobirawe, odzemawe, 
mno`ewe i delewe. 

Pi{uvaweto na formulite e mnogu sli~no kako vo matemati-
kata. Treba da go zapomni{ osnovnoto pravilo:

Site formuli zapo~nuvaat so znakot „=“.

Nekoi od znacite za matemati~kite operacii se razlikuvaat 
od onie vo matematikata; znacite se dadeni vo slednava tabela:

Matemati~ki operacii Primer

Sobirawe (+) =10+5

Odzemawe (-) =10-5

Mno`ewe (*) =10*5

Delewe (/) =10/5

1	 Vo nov raboten list, vo proizvolna }elija, vnesi ja formu-
lata =10+5. Pritisni Enter za da se prika`e rezultatot.

2	 Sekoga{ koga }e ja ozna~i{ }elijata, formulata }e se prika`e 
vo lentata za formuli.

»» Vnesi gi i slednive formuli: =10-5, =10*5, =10/5.

1

2
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Mnogu ~esto, namesto samite podatoci, vo formulite se ko-
ristat adresite na }eliite vo koi se vneseni podatocite. Ova  
}e go poka`eme preku primer. 

»» Izraboti tabela vo koja }e gi prika`e{ tro{ocite za svo-
jata rodendenska zabava. Uredi ja tabelata kako na slednata 
slika. Za~uvaj ja tabelata pod imeto Rodenden.xls.

Vo `oltite }elii presmetaj ja vrednosta za sekoj proizvod. 
Vrednosta }e ja dobie{ kako proizvod na cenata i koli~inata. 
Prvo, presmetaj ja vrednosta na prviot proizvod:

1	 vo }elijata D2 vnesi ja formulata =B2*C2; fontot ne e va`en, 
kako ni toa dali koristi{ mali ili golemi bukvi;

2	 pritisni Enter za da se pojavi rezultatot; 

3	 koga }e ja ozna~i{ }elijata, formulata }e ja vidi{ vo len-
tata za formuli.

Go dobi rezultatot 650, {to e ednakvo na 1 (podatok vo }eli-
jata B2) pomno`eno so 650 (podatok vo }elijata C2).

Za da gi presmeta{ drugite vrednosti, bi trebalo da gi vnese{ 
slednive formuli: 

vo D3: =B3*C3; vo D4: =B4*C4; vo D5: =B5*C5; vo D6: =B6*C6; vo 
D7: =B7*C7;

Koga vo tabela ima mnogu redovi, ova ne e lesna rabota. 
Zabele`uva{ deka, vsu{nost, se raboti za istata formula, samo 
{to soodvetno se menuvaat oznakite za redovite. ]e nau~i{ po-
lesen na~in da gi vnese{ site formuli.

 Avtomatsko popolnuvawe na }eliite so formuli 

Se se}ava{ li na avtomatskoto popolnuvawe na }eliite so 
tekst i so nizi? Na sli~en na~in formulata od gorniot primer 
prenesi ja na drugite }elii (D3 do D7), namesto da ja pi{uva{ 
pove}epati:

21

3
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1	 Ozna~i ja }elijata D2. Pozicioniraj se na to~kata za avto-
matsko popolnuvawe. Koga poka`uva~ot }e ja dobie formata 
+, so pritisnato levo kop~e povle~i so gluv~eto do }elijata 
D7.

2	 Vo }elijata D7 otpu{ti go kop~eto od gluv~eto. ]e se pojavat 
site rezultati vo }eliite od D2 do D3.

Proveri gi site formuli vo lentata za formuli. Po red, tie 
se preneseni vaka:

Ve{tini {to treba da gi usovr{i{!

♦♦ Da vnese{ ednostavni formuli vo tabela.

♦♦ Ne zaboravaj formulite da po~ne{ da gi 
pi{uva{ so znakot „=“.

Pra{awa i zada~i: 

1.	 So koj znak zapo~nuva pi{uvaweto na formulite vo Excel?
2.	 Navedi gi znacite vo Excel za osnovnite matemati~ki 

operacii!

3.	 Dali e va`en fontot so koj se pi{uvaat formulite vo Excel?
4.	 Kade se gleda rezultatot na formulata, a kade samata for-

mula?

5.	 Dali mo`e{ da ja primeni{ postapkata za avtomatsko 
popolnuvawe na }eliite pri vnesuvawe formuli?

6.	 Vo }eliite A1 i A2 vnesi dva broja:

♦♦ Vo }elijata A3 presmetaj go nivniot zbir.

♦♦ Vo }elijata A4 presmetaj ja nivnata razlika.

♦♦ Vo }elijata A5 presmetaj go nivniot proizvod.

♦♦ Vo }elijata A6 presmetaj go nivniot koli~nik.

1

2
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♦♦ Vo }elijata A7 presmetaj ja nivnata aritmeti~ka sredina, 
so formulata =(A1+A2)/2.

7.	 Vo tabelata Dzeparlak.xls, vo kolonata C presmetaj kolku 
pari za{teduva{ sekoj den (kolonata neka ima naslov 
Za{tediv). Za~uvaj ja tabelata.

Funkcii
Vo najgolem broj tabeli ima potreba ne{to da se presmeta: 

prose~niot uspeh na nekoj u~enik, maksimalnata ili minimal-
nata temperatura, vkupnata potro{uva~ka itn. Excel raspolaga 
so golem broj funkcii od koi, preku primeri, }e se zapoznae{ so 
slednive: zbir, sredna vrednost, minimum i maksimum.

Ova se naj~esto koristeni funkcii, koi se navedeni vo lista-
ta pod alatkata AutoSum, na standardnata lenta:

	

Site funkcii zapo~nuvaat so znakot „=“ i se sostojat od imeto 
po koe vo zagradi sleduvaat argumentite na funkcijata, oddele-
ni so zapirka ili so dve to~ki.

Na primer: funkcijata =SUM(A1,A5) go presmetuva zbirot na 
podatocite vo }eliite A1 i A5, dodeka funkcijata =SUM(A1:A5) 
go presmetuva zbirot na podatocite vo site }elii od A1 do A5.

=SUM(A1,A5)

	 Ime na funkcijata    Argumenti na funkcijata

 Zbir 

»» Vo tabelata Rodenden presmetaj ja vkupnata potro{uva~ka vo 
}elijata D8:

1	 pozicioniraj se vo }elijata D8;

2	 klikni na strelkata do alatkata  
AutoSum;

3	 od listata odberi ja funkcijata Sum.

4	 vo }elijata D8 }e ja vidi{ funkcijata. 
Imeto na funkcijata e SUM; vo zagra-
da se argumentite na funkcijata, vo slu~ajov & }eliite od D2 
do D7;

Vnimavaj: 

Programata Excel 
sama }e ponudi ar-

gumenti na funk-
cijata. Sekoga{ 

proveruvaj gi argu-
mentite. Dokolku 
ne ti odgovaraat, 
selektiraj drugi 

argumenti.

2

1

3

Zbir

Sredna vrednost

Maksimum

Minimum

Va`no:

Funkcija mo`e{ 
da odbere{ od 

listata, no, pred 
toa, pozicioniraj 
se vo }elijata vo 
koja saka{ da se 
prika`e rezul-

tatot.
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5	 argumentite na funkcijata (}eliite od D2 do D7) se ozna~eni 
so isprekinata ramka; 

6	 pritisni Enter za da go vidi{ rezultatot;

7	 sekoga{ koga }e ja ozna~i{ }elijata, formulata }e ja vidi{ 
vo lentata za formuli.

 Sredna vrednost 

Funkcija za presmetuvawe sredna vrednost e Average. Se vne-
suva na istiot na~in kako i funkcijata Sum. 

»» Otvori ja tabelata Temperatura.xls. Vo }elijata B9 presmetaj 
ja srednata vrednost na temperaturite za dadenata sedmica. 
Prika`i go rezultatot so dva decimala.

Vo ovoj slu~aj funkcijata e =AVERAGE(B2:B8).

 Maksimum i minimum 

Postapkata za presmetuvawe na maksimalnata i na minimal-
nata vrednost e ista kako dosega. Funkcijata za presmetuvawe 
maksimum e Max, a za minimum e Min.

»» Vo tabelata Visina_i_tezina.xls presmetaj gi maksimalnite i mi-
nimalnite vrednosti na visinata i na te`inata na u~enicite. 
Vnimavaj na argumentite za minimalnata vrednost.

4

5

6

7

Va`no!

Isto kako i for-
mula, i funkcija 
mo`e{ da prene-
se{ so avtomatsko 
popolnuvawe na 
}eliite. Pres-
metaj gi najprvo 
maksimalnata 
i minimalnata 
vrednost za vi-
sinata, pa funkci-
ite prenesi gi i za 
te`inata.
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 Avtomatsko menuvawe na rezultatot pri promena 

na podatocite 

Da re~eme deka za rodendenot se kupeni dve namesto edna tor-
ta. Dokolku ra~no presmetuva{ na hartija, presmetkite za vred-
nost i vkupno treba povtorno da gi izvr{i{. No, koga koristi{ 
Excel, presmetkite }e se izvr{at avtomatski i ti vo }eliite }e 
gi vidi{ novite rezultati.

1	 Vo }elijata B2 vnesi 2 namesto 1; pritisni Enter;
2	 vrednosta vo }elijata D2 }e se smeni od 650 na 1 300;

3	 vkupnata vrednost vo }elijata D8 }e se smeni od 2 325 na 
2 975.

Ve{tini {to treba da gi usovr{i{!

♦♦ Da znae{ da gi presmeta{ zbirot, srednata vrednost, 
minimumot i maksimumot na podatocite vo tabela.

Pra{awa i zada~i: 

1.	 Koi se naj~esto upotrebuvanite funkcii vo Excel?
2.	 So koja alatka mo`e{ da gi vnese{ naj~esto upotrebuvanite 

funkcii?

3.	 Od koi elementi se sostojat funkciite vo Excel?
4.	 Vo tabelata Dzeparlak.xls, presmetaj kolku vkupno i kolku 

pari vo prosek dobiva{, tro{i{ i za{teduva{. Site po-
datoci za parite uredi gi so dva decimala i so oznaka za 
denar. Za~uvaj ja tabelata.

5.	 Izraboti tabela vo koja za nekolku u~enici od oddelenieto 
}e gi vnese{ ocenkite po site predmeti.

♦♦ Vnesi gi rednite broevi so avtomatsko popolnuvawe.

♦♦ Uredi ja tabelata kako na slikata dolu.

♦♦ Presmetaj ja prose~nata ocenka (sredna vrednost) za sekoj 
u~enik.

2
1

3
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♦♦ Prika`i gi prose~nite ocenki so dva decimala.

♦♦ Najdi gi maksimalniot i minimalniot prosek.
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Proveri {to si nau~il/a!
1.	 Vo nov raboten list mora{ da po~ne{ so 

pi{uvawe vo }elijata A1:

	 a. to~no

	 b. neto~no

2.	 So pritiskawe na tasterot Enter, }e se 
pomesti{:

	 a. edna }elija kon desno

	 b. edna }elija kon levo

	 v. edna }elija podolu

3.	 [to od slednovo }e se prepoznae kako 
datum:

	 a. 02-06-2008

	 b. 02,06,2008

4.	 [to zna~i koga }e se pojavat oznakite 
######:

	 a. si vnesol/la pogre{en broj

	 b. ne{to si ispu{til/a

	 v. }eliite ne se dovolno {iroki

5.	 Nova kolona se vmetnuva desno od ko-
lonata vo koja se nao|a{:

	 a. to~no

	 b. neto~no

6.	 So koja naredba }e ja uredi{ sodr`i-
nata na }eliite:

	 a. Insert → Cells

	 b. View → Cells

	 v. Format → Cells

7.	 Koja od opciive vo prozorecot For-
mat Cells treba da ja potvrdi{ za da 
go razdeli{ tekstot vo edna }elija:

	 a. Wrap text

	 b. Shrink to fit

	 v. Merge cells

8.	 [to }e napi{e{ vo prazna }elija za 
da po~ne{ so pi{uvawe formula:

	 a. *

	 b. =

	 v. f

9.	 Koj znak za matemati~ka operacija }e 
go koristi{ za da podeli{ 32 so 4?

	 a. :

	 b. *

	 v. /

10.	 So koja od navedenite formuli 
mo`e{ da presmeta{ aritmeti~ka 
sredina na vrednostite vo }elite A1 
i A2?

	 a. =A1+A2/2

	 b. =(A1+A2)/2

	 v. = A1*A2/2

11.	 Funkcija za presmetuvawe prose~na 
vrednost e:

	 a. AVRERAGE

	 b. MIN

	 v. SUM



113	

	 OpenOffice.org Calc 

SODR@INA:

OpenOffice.org Calc po~etni elementi

Osnovni elementi na rabotniot list

Vnesuvawe podatoci vo tabelata

Ureduvawe na tabelata

Ureduvawe na podatocite vo tabelata

Grafikon

Formuli

Funkciii

Dodatok:
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OpenOffice.org Calc & po~etni elementi
OpenOffice.org Calc  (ili samo Calc) e programa koja e nameneta za 

izrabotka na tabeli i grafikoni i za izvr{uvawe presmetki vo  
tabelite. 

 Aktivirawe na programata OpenOff ice.org Calc 

Za da ja aktivira{ programata Calc vo operativniot sistem 
Edubuntu, klikni na Aplikacii, potoa na Kancelariski i od-
beri OpenOffice.org  Calc.

Datotekitekoi se izraboteni vo Calc so za~uvuvawe ja dobivaat 
nastavkata .ods i ja imaat slednava ikona:  

♦♦ Koga }e ja aktivira{ programata Calc, }e se otvori datoteka-
ta nare~ena raboten dokument ili rabotna tetratka. Prvata 
rabotna tetratka {to }e se otvori }e ima ime Neimenuvano1, 
s¢  dodeka ne ja za~uva{ pod drugo ime.

♦♦ Rabotnata tetratka se sostoi od rabotni listovi. Podato-
cite se vnesuvaat vo rabotniot list. Sekoja nova rabotna 
tetratka ima tri rabotni listovi, no nivniot broj mo`e da 
se zgolemuva i da se namaluva po potreba. Od eden vo drug  
raboten list se preminuva so lev klik na jazi~eto so ime na 
rabotniot list (List1, List2, List3).

♦♦ Rabotniot list e povr{ina podelena na koloni i redovi. 
Pravoagolniot del od rabotniot list koj e ispolnet so poda-
toci go narekuvame tabela. 

Osnovni elementi na rabotniot list
Rabotniot list e podelen na koloni i redovi.

Kolonite se postaveni vertikalno i se ozna~eni so bukvite 
A, B, C itn. 

Redovite se postaveni horizontalno i se ozna~eni so  
broevite 1, 2, 3 itn. 
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Presekot na redot i kolonata se narekuva }elija. ]elija e 
mestoto kade {to se vnesuvaat podatocite. 

 Aktivna }elija 

Pozicioniraj se vrz koja bilo }elija. Klikni na }elijata.  
]elijata vo koja si pozicioniran se narekuva aktivna }elija i 
ima zadebelena ramka. 

Oznakata za kolonata vo koja se nao|a aktivnata }elija e so 
druga boja.

Oznakata za redot vo koj se nao|a aktivnata }elija e so druga 
boja.

Oznakite za soodvetnata kolona i za soodvetniot red ja 
formiraat adresata na aktivnata }elija. Adresata e prika`ana 
vo lentata {to se nao|a vedna{ nad oznakite za kolonite. ]eli-
jata vo presek na kolonata C i redot 4 ima adresa C4.

Vnesuvawe podatoci vo tabelata
Podatoci vo Calc se vnesuvaat na ist na~in kako vo Excel.

Ureduvawe na tabelata

 Menuvawe i ureduvawe na vnesenite vrednosti vo 

tabelata 

Menuvaweto (editiraweto), vnesuvaweto novi i bri{eweto 
podatoci vo Calc se vr{i na ist na~in kako vo Excel.

Ureduvawe na fontot

Fontot }e go uredi{ na ve}e poznatiot na~in & preku alatkite 
od lentata za formatirawe: 

Rabota so koloni i so redovi
Kolona mo`e{ da vmetne{ vo tabelata so naredbata Vmetnu-

vawe → Koloni, a red so naredbata Vmetnuvawe → Redovi. So 
redovi i so koloni polesno }e raboti{ preku pomo{noto meni, 
koe }e go dobie{ koga }e klikne{ so desnoto kop~e od gluv~eto 
na oznakata za  redot/kolonata.
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 Vmetnuvawe kolona/red 

♦♦ So desnoto kop~e od gluv~eto klikni na oznakata za kolonata/
redot pred koj/a saka{ da vmetne{ nov/a kolona/red.

♦♦ Od pomo{noto meni odberi Vmetni kolona/Vmetni red.

 Bri{ewe kolona/red 

♦♦ So desnoto kop~e od gluv~eto klikni na oznakata za kolonata/
redot {to saka{ da go izbri{e{.

♦♦ Od pomo{noto meni odberi Izbri{i koloni/Izbri{i redovi.

 Menuvawe na dimenziite na kolonite/redovite 

Za da pro{iri{ ili stesni{ nekoja kolona/red:

So gluv~eto pozicioniraj se na linijata po oznakata za sood-
vetnata kolona, odnosno za soodvetniot red (kolona C na slika-
ta). Koga poka`uva~ot }e go dobie ovoj oblik , klikni so le-
voto kop~e od gluv~eto.

]e se pojavi indikator vo koj e ispi{ana {irinata na kolo-
nata/redot. So pritisnato levo kop~e od gluv~eto dvi`i se levo 
za da ja stesni{ kolonata/gore za da go stesni{ redot, ili desno 
za da ja pro{iri{ kolonata/dolu za da go pro{iri{ redot. 

Ureduvawe na podatocite vo tabelata
Vo tabelite mo`e{ da go odbere{ tipot na podtocite, da gi 

uredi{ fontot i poramnuvawata na podatocite ili da gi pos-
tavi{ granicite i da ja izbere{ bojata na }eliite. Mo`e{ da 
uredi{ pove}e }elii naedna{, no najprvo treba da gi ozna~i{ 
site }elii {to saka{ da gi uredi{.

Tvojata tabela mo`e{ da ja uredi{ na dva na~ina:

&& Preku prozorecot Formatirawe }elii, koj }e go povika{ so 
naredbata Formatiraj → ]elii od glavnoto meni. Prozore-
cot Formatirawe }elii sodr`i pove}e stranici:

♦♦ za izbirawe i za ureduvawe na tipot na podatocite;

♦♦ za ureduvawe na fontot;

♦♦ za poramnuvawe na podatocite;

♦♦ za ureduvawe na granicite na }eliite;

♦♦ za ureduvawe na bojata na }eliite.
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&& Preku lentata za formatirawe: 

 Razdeluvawe na tekstot 

♦♦ Klikni na }elijata vo koja saka{ da go razdeli{ tekstot;

♦♦ povikaj go prozorecot Formatirawe }elii;

♦♦ klikni na stranicata 
Poramnuvawe;

♦♦ potvrdi ja opcijata 
Avtomatski prenesi 
tekst;

♦♦ klikni na kop~eto Vo 
red.

 Poramnuvawe i nasoka na tekstot 

♦♦ Ozna~i gi }eliite vo koi saka{ da izramni{ tekst;

♦♦ povikaj go prozorecot Formatirawe }elii;

♦♦ odberi ja stranicata Poramnuvawe;

♦♦ klikni na nadolnata 
strelka vo poleto Hori-
zontalno i  odberi edna od 
ponudenite opcii;

♦♦ klikni na nadolnata strel-
ka vo poleto Vertikalno i 
odberi  edna od ponudenite 
opcii;

♦♦ vo delot Orientacija na 
tekst klikni na to~kata {to se nao|a na vrvot na krugot;

♦♦ klikni na kop~eto Vo red.
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 Spojuvawe pove}e }elii vo edna 

Koga }e vnesuva{ dolgi tekstovi, }e treba pove}e }elii da 
spoi{ vo edna }elija. Toa }e go postigne{ so alatkata Spoj }e-
lii od lentata za formatirawe.

♦♦ Ozna~i gi }eliite {to saka{ da gi spoi{.

♦♦ Klikni na alatkata  .

 Boja na tekstot i na zadninata 

Bojata na tekstot se ureduva so alatkata Boja na fontot .         

Bojata na zadninata na tekstot se ureduva so alatkata Boja na 
podlogata .

Klikni na nadolnata strelka {to se nao|a do alatkite i od-
beri boja po tvoja `elba. 

 Granici na }eliite 

Mo`e{ da zabele`i{ deka tabelata nema granici za }eli-
ite. Liniite {to gi gleda{ na rabotniot list, vsu{nost, ne se 
granici, tuku samo oznaki za redovite i za kolonite. Granicite 
se postavuvaat so pomo{ na alatkata Rabovi  .

 Brojot na decimalnite mesta vo broevite 

Dokolku ima potreba, mo`e{ da vnese{ i decimalni broevi.  
Ponekoga{ e potrebno site broevi da bidat so ist broj deci-
malni mesta, odnosno da se prika`at i nulite po posledniot 
decimal (na primer: 2.50). Za namaluvawe i za zgolemuvawe na 
decimalnite mesta koristi gi slednive alatki:  

Grafikon
 Izrabotka na grafikon 

Grafikon se kreira so naredbata Grafikon, koja se povikuva 
od glavnoto meni Vmetnuvawe, ili preku alatkata Grafikon   

  od standardnata lenta. 

Ozna~i gi vrednostite vo kolonite so podatocite za koi{to 
kreira{ grafikon, zaedno so naslovite na kolonite.

Od menito Vmetnuvawe odberi ja naredbata Grafikon. ]e
se pojavi prozorecot Vol{ebnik za grafikoni. Izraboti 
grafikon vo ~etiri ~ekori. Vo prviot ~ekor odberi go tipot na 
grafikonot:

♦♦ od karti~kata Tip na grafikon odberi soodveten tip;
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♦♦ klikni na soodveten pottipot;

♦♦ klikni na kop~eto Sledno.

Vo vtoriot ~ekor odberi opseg na podatocite:

♦♦ Vo karti~kata Opseg na podatocite treba da odbere{ opseg 
na podatocite za koi saka{ da izraboti{ grafikon. Ti si go 
napravil/a toa so ozna~uvawe na podatocite pred da po~ne{ 
so izrabotuvaweto na grafikonot. 

♦♦ Dokolku ne si, podatocite mo`e{ i sega da gi selektira{, no 
najprvo klikni na kop~eto .

♦♦ Klikni na kop~eto Sledno.

Vo tretiot ~ekor treba da uredi{ nizi od podatoci. Vo prim-
erov ima{ samo edna serija podatoci, a toa e visina. Programata 
ve}e ti gi dava najdobrite opcii, pa prepora~uvame vo ovoj ~ekor 
ni{to da ne menuva{. So kop~eto Sledno premini na sledniot 
~ekor.

Vo posledniot ~ekor }e gi opredeli{ elementite na grafiko-
not:

♦♦ vnesi naslov (Title) na grafikonot, a dokolku saka{, vnesi i 
podnaslov (Subtitle) i opi{i gi oskite X i Y;

♦♦ klikni na kop~eto Zavr{i, so {to }e go zavr{i{ izrabotu-
vaweto na grafikonot.
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 Ureduvawe na grafikonot 

Grafikonot mo`e{ da go uredi{ po `elba: da gi smeni{ 
goleminata, fontot, nasokata na tekstot, boite i sli~no. Gle-
da{ deka tekstovite se ispi{ani so latini~en font. Najprvo 
smeni go fontot:

♦♦ klikni dvapati na grafikonot za da go ozna~i{ (okolu 
grafikonot }e se pojavi siva ramka); 

♦♦ ozna~i go naslovot i klikni na nego so desnoto kop~e od 
gluv~eto; 

♦♦ od pomo{noto meni odberi Svojstva na objektot;

♦♦ }e go dobie{ sledniov prozorec:

♦♦ od karti~kata Znaci odberi font, tip na fontot i golemina 
po izbor; od drugite karti~ki mo`e{ da gi uredi{ drugite 
elementi na naslovot, kako: rabovi, efekti, poramnuvawe i 
sli~no.

Na sli~en na~in }e gi uredi{ i drugite elementi na grafiko-
not, kako {to se zadninata i sli~no. 

Formuli
Vnesuvaweto formuli vo Calc e isto kako vo 

Excel:

Funkcii
Vo najgolem broj tabeli ima potreba ne{to da se presmeta: 

prose~niot uspeh na nekoj u~enik, maksimalnata ili minimal-
nata temperatura, vkupnata potro{uva~ka itn. Calc raspolaga 
so golem broj funkcii od koi preku primeri }e se zapoznae{ so 
slednive: suma, sredna vrednost, minimum i maksimum.

Site funkcii zapo~nuvaat so znakot „=“ i se sostojat od imeto 
po koe vo zagradi sleduvaat argumentite na funkcijata, oddele-
ni so zapirka ili so dve to~ki.
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Na primer:

funkcijata =SUMA(A1,A5) ja presmetuva sumata od podatocite 
vo  }eliite A1 i A5, dodeka funkcijata =SUMA(A1:A3) ja pres-
metuva sumata na podatocite vo site }elii od A1 do A5.

 Suma 

Suma ili zbir e naj~esto koristena funkcija i pristapot do 
nea e olesnet so alatkata  (sigma), koja se nao|a na lentata 
za formuli. 

♦♦ Pozicioniraj se vo }elijata D8.

♦♦ Klikni na alatkata  .

♦♦ Imeto na funkcijata e SUMA. Vo zagradite se argumentite na 
funkcijata.

♦♦ Pritisni go tasterot Enter ili klikni na alatkata   (Pri-
fati), koja se nao|a vedna{ do alatkata sigma.

♦♦ Vo }elijata }e se pojavi rezultatot na funkcijata.

Sekoga{ koga }e ja ozna~i{ }elijata, funkcijata }e ja vidi{ 
vo lentata za formuli.

 Sredna vrednost (prosek) 

Funkcija za presmetuvawe sredna vrednost e Prosek. 

♦♦ Pozicioniraj se vo }elijata vo koja }e bide rezultatot;

♦♦ klikni na alatkata Vol{ebnik za funkcii;

♦♦ }e se otvori prozorecot Vol{ebnik za funkcii:
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♦♦ od listata odberi ja funkcijata Prosek;

♦♦ klikni na kop~eto Sledno;

♦♦ vo sledniot prozorec treba da gi odredi{ argumentite na 
funkcijata Prosek;

♦♦ napi{i gi argumentite direktno vo lentata Broj_1 (oddeleni 
so dve to~ki);

♦♦ ili: selektiraj gi podatocite vo tabelata;

♦♦ strukturata na funkcijata }e ja vidi{ vo prozorecot Formu-
la;

♦♦ klikni na kop~eto Vo red za da go vidi{ rezultatot vo tabe-
lata;

Maksimum i minimum 

Postapkata za presmetuvawe na maksimalnata i na minimal-
nata vrednost e ista kako dosega. Funkcijata za presmetuvawe 
maksimum e Maks, a za minimum e Min.

Isto kako i formula, i funkcija mo`e{ da prenese{ so avto-
matsko popolnuvawe na }eliite. Presmetaj ja najprvo maksimal-
nata i minimalnata vrednost za visinata, pa funkciite prenesi 
gi i za te`inata.
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	 Proekti

SODR@INA:

Voved 

Osnovni elementi na proektot

Sledewe na realizacijata na proektite

Prezentacija i vrednuvawe na proektot

Informatikata i proektite



Proekti5

124	

Voved

Ako samo mi raska`e{, }e zaboravam.
Ako mi poka`e{, }e zapomnam.
No, ako i me vklu~i{, }e razberam!

Stara kineska pogovorka

Vo posledno vreme s¢ po~esto se zboruva za proekti. Sigurno 
ti si u~estvuval/a vo izrabotka na nekoj u~ili{ten proekt.

[to e toa proekt i zo{to se proektite tolku zna~ajni? 

Celta na sovremenata nastava ne e znaeweto samo po sebe, 
tuku znaeweto od koe proizleguva i razbiraweto. A toa nivo 
mo`e{ da go dostigne{ ako istra`uva{ i ako samostojno done-
suva{ zaklu~oci. U~ili{nite proekti tokmu toa i go obezbedu-
vaat & samostojno steknuvawe znaewa. Za dobro izveden proekt e 
mnogu va`no da nabquduva{, da go zabele`i{ voo~enoto, da ko-
risti{ razli~ni izvori za nao|awe informacii, da izveduva{ 
zaklu~oci, no i dobro da gi prezentira{ steknatite znaewa. 

Razvojot na informati~kite tehnologii, osobeno na Inter-
net, ti ovozmo`uva pristap do mnogu podatoci {to mo`e{ da gi 
iskoristi{ za izrabotka na proekt. Isto taka, kompjuterskite  
programi {to gi ima{ sovladano }e ti pomognat tvoite proekti 
da gi prezentira{ na najdobar na~in.

Osnovni elementi na proektot

 [to e u~ili{ten proekt? 

U~ili{niot proekt pretstavuva detalno istra`uvawe na od-
redena tema po odnapred razraboten plan. Toa e slo`ena za-
da~a {to bara od u~enicite, sami ili vo grupa, da go postavat 
problemot, da istra`uvaat, da izvedat zaklu~oci ili da go 
re{at problemot za opredeleno vreme i da donesat kone~en 
proizvod {to }e bide prezentiran javno.

[to treba da ima sekoj dobar proekt?

Dobriot u~ili{ten proekt:

♦♦ ima cel i mora da dade proizvod;

♦♦ podrazbira slo`ena zada~a ({to se razlo`uva na poednos-
tavni);

♦♦ ima opredeleno vremetraewe, odnosno rok za izrabotka;

♦♦ po pravilo, vklu~uva pove}e u~enici (rabota vo grupa);

♦♦ podrazbira sorabotka na site u~esnici.
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 [to se postignuva so izrabotkata na proektot? 

So u~estvoto vo izrabotkata na proektot }e se zdobie{ so 
mnogu sposobnosti. ]e navedeme samo nekoi od niv: 

♦♦ ]e razvie{ sposobnost za timska rabota, odnosno }e nau~i{: 

&& kako da go iska`e{ svoeto mislewe na soodveten na~in,

&& kako da go prifati{ tu|oto mislewe, 

&& kako da dade{ mislewe za tu|a rabota, i 

&& kako da prifati{ kritika za tvojata rabota. 

♦♦ ]e razvie{ sposobnost za donesuvawe odluki.

♦♦ ]e razvie{ kriti~ki odnos kon svojata i kon tu|ata rabota.

♦♦ ]e razvie{ sposobnost za prezentirawe.

 Rabota vo grupa 

So sou~enicite sostavete grupa. Podelete ja zada~ata na poma-
li i poednostavni zada~i i podelete gi ulogite za vodewe grupa, 
za istra`uvawe, za izrabotka na gotov proizvod, za prezenti-
rawe itn. 

Dobro e vo razli~ni proekti da gi menuvate ulogite za da 
mo`ete da osvoite razli~ni ve{tini.

Verojatno }e naide{ na problemi, kako {to se: nedostig na 
izvori, komunikacija, problemi so nekoi ~lenovi na grupata i 
sli~no. Edna od celite na proektite e da nau~i{ kako da gi nad-
mine{ problemite. Pobaraj pomo{ od nastavnikot, toj ima uloga 
da ja sledi izrabotkata na proektot.

Sledewe na realizacijata na proektite

 Fazite na proektot 

Izrabotka na u~ili{niot proekt se sostoi od slednive fazi:

♦♦ pronao|awe tema za proektot;

♦♦ opredeluvawe na zada~ite ili celite na proektot;

♦♦ planirawe;

♦♦ istra`uvawe;

♦♦ izrabotka na proekt. 

 Pronao|awe tema za proektot 

Dokolku temata ne ti e zadadena od nastavnikot, treba sam/a 
da ja izbere{. Mo`e da ti pomogne spisok na temi. Napravi spi-
sok i razgledaj go ubavo. Razmisli za sekoja od temite kolku ti e 
interesna, kolku predznaewe ima{ i od koi izvori }e sobere{ 
dovolno informacii.
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 Opredeluvawe na zada~ite ili celite na proektot 

Koga }e izbere{ tema za proektot, treba da postavi{ konkret-
ni zada~i i celi: dali saka{ da napi{e{ sostav, da iznese{ 
svoi stavovi i razmisluvawa ili da gi pretstavi{ rezultatite 
od istra`uvaweto.

Razmisli vo koja forma saka{ da go pretstavi{ proektot: 
tekst, dijagram, pano, slika ili multimedijalna prezentacija. 
Iskoristi  gi znaewata od informatikata za izrabotka na gotov 
proizvod.

 Planirawe 

Pred da po~ne{ so izrabotkata na proektot, najdobro e prvo 
da razmisli{ {to znae{ za temata: zabele`i s¢ {to znae{ za 
temata, napravi spisok od poimi srodni so temata, pi{uvaj za s¢ 
{to }e se seti{ vo vrska so temata. Pogledni {to si zapi{al/a, 
i razmisli {to mo`e{ od toa da iskoristi{ za svojot proekt.

Napravi spisok so pra{awa na koi saka{ da najde{ odgovor. 
Zabele`i go sekoj odgovor {to }e go najde{.

 Istra`uvawe 

Koga }e znae{ {to bara{, po~ni da istra`uva{. 

Va`en element vo fazata na istra`uvaweto se izvorite na 
informaci. Mo`e{ da koristi{ knigi, spisanija, enciklope-
dii, Internet i drugo. Vodi smetka, osobeno koga e vo pra{awe 
Internetot, kolku e toa siguren izvor na informacii (dali se 
raboti za stranica od nekoja obrazovna institucija, dali infor-
maciite se od ponov datum i sli~no). Kako sigurni izvori na In-
ternet }e ti gi prilo`ime elektronskite enciklopedii Wikipe-
dia.com i Webopedia.com.

Pravi bele{ki dodeka istra`uva{. Zapi{uvaj va`ni idei, 
izvori na informacii, citati i sli~no.

 Izrabotka na proektot 

Proektot e naj~esto vo forma na multimedijalna prezentaci-
ja, pa ovde }e najde{ nekolku soveti za toa kako da ja izraboti{ 
uspe{no. 

Prezentacijata treba da bide pregledna, a nejzinata sodr`ina 
treba da bide organizirana logi~ki i da pretstavuva celina. 
Prezentacijata e nadopolnuvawe na izlagaweto i ne treba da 
sodr`i premnogu tekst. Ne pi{uvaj dolgi re~enici i ne vmetnu-
vaj premnogu elementi na eden slajd. Ne preteruvaj nitu so ani-
maciite.

Naglasi gi klu~nite zborovi i va`nite termini. Pi{uvaj tem-
ni bukvi na svetla zadnina, ili obratno. 

Sovet:

Iako se ~ini kako 
najlesen na~in 

za izrabotka na 
proekt, nikako 

nemoj da kopira{ 
i da prilepuva{ 

tekstovi od  
Internet.

Na toj na~in ja  
skratuva{ 

mo`nosta da 
nau~i{ ne{to, no 

bidi siguren/na 
deka i  

nastavnicite  
}e sfatat {to si 

napravil/a.
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Eve nekolku primeri za dobro i za lo{o izraboteni slajdovi:

Dobro ureden slajd: nave-
deni se osnovnite elementi.

   
Lo{o ureden slajd: prem-

nogu tekst.

	

Dobro ureden slajd: teks-
tot e vo ramkata {to  e pred-
videna za tekst.

  
Lo{o ureden slajd: tekstot 

izleguva od ramkata {to e 
predvidena za tekst.

	

Dobro ureden slajd: svet-
li bukvi na temna zadnina i 
temni bukvi na svetla zad-
nina. Lesno se ~ita.

  Lo{o ureden slajd: premnogu  
i neusoglaseni boi. Te{ko se 
~ita.
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Prezentacija i vrednuvawe na proektot
Prezentacijata i vrednuvaweto na proektot se od golemo 

zna~ewe za toj da bide uspe{en.

 Prezentirawe na proektot 

Dobroto prezentirawe e isto tolku va`no kolku i dobro iz-
raboteniot proekt. Klu~ za uspeh e ve`bawe, nekolku pati glas-
no povtori go izlagaweto bidej}i taka }e go sovlada{ materi-
jalot. Dodeka ve`ba{, meri go vremeto. Prezentacijata ne treba 
da bide predolga zatoa {to treba da go zadr`i{ vnimanieto na 
publikata, a mo`ebi }e ima{ i ograni~eno vreme za prezentaci-
ja.

Pred da po~ne{ so izlagaweto, pretstavi se i pretstavi ja 
temata na proektot.

Za vreme na prezentacijata zboruvaj jasno i razbirlivo: nitu 
premnogu brzo nitu premnogu bavno. Dobli`i se do publikata, ne  
gledaj samo vo nastavnikot ili samo vo bele{kite. Dokolku ima 
pra{awa, soslu{aj gi i odgovori na niv.

 Vrednuvawe na proektot 

Vo vrednuvaweto na izrabotkata i vo prezentiraweto na 
proektot u~estvuvaat site u~enici. Na toj na~in se razvivaat 
kriti~nosta i sposobnosta za objektivno vrednuvawe na svoja-
ta i na tu|ata rabota. Razgovaraj za te{kotiite vo tekot na re-
alizacijata na proektot i za nivnoto nadminuvawe. Pobaraj od 
sou~enicite da go vrednuvaat tvojot trud i da ti gi ka`at svoite 
mislewa.

Informatikata i proektite
Znaewata od oblasta na informatikata mo`e{ da gi isko-

risti{ za proekti po site u~ili{ni predmeti. 

♦♦ Programata Word mo`e{ da ja upotrebi{ za vodewe ili za iz-
rabotka na dokumentot kako gotov produkt. Predlagame  da go 
koristi{ Word za esei ili za podolgi tekstovi; na primer, za 
istorijatot na tvoeto u~ili{te. Iskoristi gi mo`nostite na 
dijagramite. Vo Word mo`e{ da ureduva{ i u~ili{ten vesnik.

♦♦ PowerPoint e aplikacija za izrabotka na prezentacii i naj-
mnogu se koristi za prezentirawe proekti. Mo`e{ da is-
koristi{ animacii za prika`uvawe dvi`ewa, na primer, za 
kru`eweto na vodata, migraciski dvi`ewa i sli~no.

♦♦ Iskoristi go Excel za istra`uvawa i za analiza na rezul-
tatite. So grafikon mo`e{ da pretstavi{: rezultati od an-
keti, demografski podatoci, rezultati od istra`uvawa i 
sli~no.  

Sovet:

Dokolku koristi{ 
PowerPoint za 

prezentirawe 
na proektot, od 

golema pomo{ 
}e ti bidat 

bele{kite {to 
mo`e{ da gi 

napravi{ za sekoj 
slajd. Tie se 

vidlivi za tebe, 
no ne i za pub-

likata. Pra{aj 
go nastavnikot 

kako da napravi{ 
bele{ki.
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Predlog-temi i zada~i za proekti po informatika

Obidi se da napravi{ proekt od oblasta na informatikata.  
Pogledni gi na{ite predlozi. Mo`e{ da odbere{ nekoj od niv, a 
mo`ebi tie }e ti dadat ideja sam/a da si postavi{ zada~a i cel 
na proektot.

Ti gi predlagame slednive temi:

♦♦ kompjuteri,

♦♦ programirawe,

♦♦ kompjuterska grafika,

♦♦ kompjuterski virusi,

♦♦ Internet,

♦♦ Microsoft Office.

Od navedenite temi mo`e{ da si gi postavi{ slednive zada~i 
i celi:

♦♦ istra`uvawe za istorijatot na kompjuterite;

♦♦ koj i zo{to go napi{al prviot kompjuterski virus;

♦♦ re~nik za poimite povrzani so Internetot;

♦♦ kade i za koi celi mo`e{ da primeni{ grafikoni od progra-
mata Word;

♦♦ istra`uvawe dali nastavnicite od tvoeto u~ili{te gi kori-
stat kompjuterite vo nastavata. Koi kompjuterski programi gi 
koristat najmnogu i za koi celi?

Za talentiranite u~enici gi predlagame slednive zada~i:

♦♦ koja e Ada Bajron i zo{to e taa zna~ajna za programiraweto;

♦♦ napravi paralela: vektorska nasprema bitmapirana grafika.



130	

Dodatok A

Za talentiranite u~enici
Za onie {to sakaat da znaat pove}e, gi podgotvivme slednive 

zada~i:

 Obrabotka na tekst: 

Izraboti naslovna stranica za tvojot vesnik. 

 Multimedijalni prezentacii: 

Obidi se da  ja doka`e{ sli~nosta na dvata triagolnika. Pog-
ledni gi slikite.

 Tabelarni presmetuvawa: 

Vnesi komentari so koi }e gi pretstavi{ delovite na 
kompjuterot. Imeto na sekoj od delovite  }e se prika`e so 
dobli`uvawe na gluv~eto  do crvenata strelka. Pomo{: slikata 
pretstavuva  zadnina.
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Dodatok B

Mal informati~ki re~nik 

Adresa (address) Na sekoja veb-stranica na Internet se dodeluva edinstvena adresa 
preku koja stranicata mo`e da se pronajde i prika`e.

Aplikacija  
(application)

Programa ili grupa programi nameneti za odredena rabota, na primer: 
za pi{uvawe tekst, za presmetuvawe, za slu{awe muzika i sli~no.

Blog (blog) Skrateno od web-log. Veb-stranica na koja se objavuvaat li~ni stavovi 
i razmisluvawa. Naj~esto vo forma na vesnik.

Bloger (blogger) Avtorot na blog.

Veb-lokacija ili 
veb-sajt (web site)

Lokacija na www. Sekoja lokacija sodr`i doma{na stranica, a toa e 
prvata stranica koja ja gleda korisnikot koga }e ja poseti lokacijata.

Datoteka (file) Mno`estvo podatoci organizirani vo celina i za~uvani pod edno ime.

Dokument  
(document)

Datoteka kreirana vo nekoja od programite za obrabotka na tekst 
(Word, Writer). Osven tekst, dokumentot mo`e da sodr`i grafika, gra-
fikoni i drugi objekti.

Zaglavie  
(header)

Vo programite za obrabotka na tekst & edna ili pove}e linii so tekst 
{to se pojavuvaat na vrvot na sekoja stranica.  

Ikona (icon) Mala slika na ekranot koja pretstavuva objekt (dokument, slika, ta-
bela...) ili programa. 

Internet Globalna mre`a vo koja se povrzani milioni kompjuteri. Internet ne 
e isto {to i www.

Kolona (column) Vo tabela & vertikalna niza na }elii. Vo dokumenti & vertikalen pro-
stor rezerviran za tekst.

Kop~e (button) Mala povr{ina na ekran na koja mo`e da se klikne i da se izbere op-
cija ili komanda.

Korisnik (user) Poedinec {to koristi kompjuter ili Internet. 

Korisni~ko ime 
(username)

Ime so koe se najavuva pristap do kompjuterskiot sistem ili do inter-
net-uslugite. Obi~no se upotrebuva zaedno so lozinka. 

Kursor (cursor) Specijalen simbol, obi~no pravoagolnik ili dolna crta {to trepka. 
Kursorot poka`uva kade }e se prika`e sledniot znak na ekranot. Vo 
programite za obrabotka na tekst obi~no e vo oblik na vertikalna 
crta {to trepka. 

Kompjuter 
opslu`uva~ (server)

Kompjuter vo mre`ata {to sodr`i datoteki dostapni do drugi 
kompjuteri.

Lozinka (password) Skriena niza od znaci koja im ovozmo`uva na korisnicite pristap do 
datoteka, do kompjuter, do programa ili do veb-stranicata

Margina (margin) Vo programite za obrabotka na tekst & bela povr{ina na rabovite na 
hartijata. 
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Najava  
(login, log in, log on)

Prijavuvawe so cel kompjuterot ili nekoja veb-lokacija da te prepoz-
nae kako korisnik. Obi~no se prijavuva{ so korisni~koto ime i lo-
zinkata.

Naredba (command) Instrukcija do kompjuterot da izvr{i odredena zada~a.

Objekt (object) Op{to & sekoj element {to mo`e da se ozna~i i so nego da se manipu-
lira (tekst, slika, grafikon...).

Onlajn (on-line) Korisnicite se onlajn koga se povrzani na Internet preku modem. Koga 
ne se povrzani, tie se oflajn.

Oflajn (off-line) v. onlajn.

Podno`je (footer) Vo programite za obrabotka na tekst & edna ili pove}e linii so tekst 
{to se pojavuvaat na dnoto na sekoja stranica.  

Post (post) Poraka objavena onlajn.

Prebaruva~  
(search engine)

Programa {to prebaruva dokumenti na Internet (po zadadeni zborovi) 
i dava lista na stranici na koi se pronajdeni zborovite. Najpoznati 
se Google i Altavista. 

Prelistuva~ 
(browser)

Programa {to se koristi za prika`uvawe veb-stranici. Najpopularni 
se Internet Explorer i Firefox. 

Prozorec (window) Pravoagolna povr{ina na ekranot vo koja se prika`uvaat programi, 
dokumenti ili drugi prozorci. 

Tabela (table) Podatoci organizirani vo redovi i koloni.

Tabelaren pres-
metuva~ (spread-
sheet application)

Programa {to ovozmo`uva organizirawe na podatocite vo tabela i 
manipulirawe so niv. 

]elija (cell) Vo aplikaciite za tabelarni presmetki & mesto kade {to mo`e{ da 
vnese{ podatok (tekst, vrednost ili formula). 

Ureduva~ na tekst  
(word processor)

Programa za obrabotka na tekst. Ovozmo`uva izrabotuvawe, uredu-
vawe i pe~atewe na dokumenti. 

Font (font) Dizajnirano mno`estvo znaci i simboli (bukvi, cifri i drugo). 

Formula (formula) Vo aplikaciite za tabelarno presmetuvawe & izraz koj definira kako 
se odnesuva edna }elija kon drugite }elii.

Hipervrska  
(hyperlink)

Element vo eden dokument koj (so kliknuvawe na nego) vodi do drugo 
mesto vo istiot dokument ili do drug dokument.

Meni (menu) Lista naredbi ili opcii od koi se odbira. 

WWW  
(World Wide Web) 

Sistem od internet-uslugi, sostaven od dokumenti {to sodr`at vo 
sebe vrski kon drugi dokumenti.
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Dodatok V

Re{enija za testovite:
Word:

1 & b; 2 & a; 3 & v; 4 & v; 5 & a; 6 & b; 7 & b; 8 & a; 9 & b; 10 & v; 11 & a; 12 & b

PoweePoint:

1 & b; 2 & b; 3 & b; 4 & v; 5 & b; 6 & b; 7 & v; 8 & a; 9 & a; 10 & a; 11 & a; 12 & a

Excel:

1 & b; 2 & v; 3 & a; 4 & v; 5 & b; 6 & v; 7 & a; 8 & b; 9 & v; 10 & b; 11 & a

Koristena literatura:
www.wikipedia.com

www.webopedia.com

www.schoolKit.com

Thomas, J. W. : A Review of Research on Procjet-Based Learning

G. Courter, A. Marquis, K. Browning: OFFICE 2003  
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